Notice
The company reserves the right to revise this publication or to change its contents without notice. Information contained herein is for reference only and does not constitute a commitment on the part of the manufacturer or any subsequent vendor. They assume no responsibility or liability for any errors or inaccuracies that may appear in this publication nor are they in anyway responsible for any loss or damage resulting from the use (or misuse) of this publication.
This publication and any accompanying software may not, in whole or in part, be reproduced, translated, transmitted or reduced to any machine readable form without prior consent from the vendor, manufacturer or creators of this publication, except for copies kept by the user for backup purposes. Brand and product names mentioned in this publication may or may not be copyrights and/or registered trademarks of their respective companies. They are mentioned for identification purposes only and are not intended as an endorsement of that product or its manufacturer.
©September 2009

Trademarks
Intel and Intel Core are trademarks/registered trademarks of Intel Corporation.
Preface

FCC Statement
(Federal Communications Commission)
You are cautioned that changes or modifications not expressly approved by the party responsible for compliance could void the user's authority to operate the equipment.

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

• Re orient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
• Consult the service representative or an experienced radio/TV technician for help.

Operation is subject to the following two conditions:

1. This device may not cause interference.
And
2. This device must accept any interference, including interference that may cause undesired operation of the device.
FCC RF Radiation Exposure Statement:

1. This Transmitter must not be co-located or operating in conjunction with any other antenna or transmitter.

2. This equipment complies with FCC RF radiation exposure limits set forth for an uncontrolled environment. This equipment should be installed and operated with a minimum distance of 20 centimeters between the radiator and your body.

Warning

Use only shielded cables to connect I/O devices to this equipment. You are cautioned that changes or modifications not expressly approved by the manufacturer for compliance with the above standards could void your authority to operate the equipment.

If your purchase option includes both Wireless LAN and 3.75G modules, then the appropriate antennas will be installed. Note that in order to comply with FCC RF exposure compliance requirements, the antenna must not be co-located or operate in conjunction with any other antenna or transmitter.
Preface

IMPORTANT SAFETY INSTRUCTIONS
Follow basic safety precautions, including those listed below, to reduce the risk of fire, electric shock, and injury to persons when using any electrical equipment:

1. Do not use this product near water, for example near a bath tub, wash bowl, kitchen sink or laundry tub, in a wet basement or near a swimming pool.
2. Avoid using this equipment with a telephone line (other than a cordless type) during an electrical storm. There may be a remote risk of electrical shock from lightning.
3. Do not use the telephone to report a gas leak in the vicinity of the leak.
4. Use only the power cord and batteries indicated in this manual. Do not dispose of batteries in a fire. They may explode. Check with local codes for possible special disposal instructions.
5. This product is intended to be supplied by a Listed Power Unit with an AC Input of 100 - 240V, 50 - 60Hz, DC Output of 20V, 6A OR 18.5V, 6.5A minimum AC/DC Adapter.

CAUTION
Always disconnect all telephone lines from the wall outlet before servicing or disassembling this equipment.

TO REDUCE THE RISK OF FIRE, USE ONLY NO. 26 AWG OR LARGER, TELE-COMMUNICATION LINE CORD

This Computer's Optical Device is a Laser Class 1 Product
Instructions for Care and Operation

The notebook computer is quite rugged, but it can be damaged. To prevent this, follow these suggestions:

1. **Don’t drop it, or expose it to shock.** If the computer falls, the case and the components could be damaged.

   - Do not expose the computer to any shock or vibration.
   - Do not place it on an unstable surface.
   - Do not place anything heavy on the computer.

2. **Keep it dry, and don’t overheat it.** Keep the computer and power supply away from any kind of heating element. This is an electrical appliance. If water or any other liquid gets into it, the computer could be badly damaged.

   - Do not expose it to excessive heat or direct sunlight.
   - Do not leave it in a place where foreign matter or moisture may affect the system.
   - Don’t use or store the computer in a humid environment.
   - Do not place the computer on any surface that will block the Vents/Fan Intakes.
3. **Avoid interference.** Keep the computer away from high capacity transformers, electric motors, and other strong magnetic fields. These can hinder proper performance and damage your data.

4. **Follow the proper working procedures for the computer.** Shut the computer down properly and don’t forget to save your work. Remember to periodically save your data as data may be lost if the battery is depleted.

   | Do not turn off the power until you properly shut down all programs. | Do not turn off any peripheral devices when the computer is on. | Do not disassemble the computer by yourself. | Perform routine maintenance on your computer. |

5. **Take care when using peripheral devices.**

   | Use only approved brands of peripherals. | Unplug the power cord before attaching peripheral devices. |
Power Safety

The computer has specific power requirements:

- Only use a power adapter approved for use with this computer.
- Your AC/DC adapter may be designed for international travel but it still requires a steady, uninterrupted power supply. If you are unsure of your local power specifications, consult your service representative or local power company.
- The power adapter may have either a 2-prong or a 3-prong grounded plug. The third prong is an important safety feature; do not defeat its purpose. If you do not have access to a compatible outlet, have a qualified electrician install one.
- When you want to unplug the power cord, be sure to disconnect it by the plug head, not by its wire.
- Make sure the socket and any extension cord(s) you use can support the total current load of all the connected devices.
- Before cleaning the computer, make sure it is disconnected from any external power supplies (i.e. AC/DC adapter or car adapter).

<table>
<thead>
<tr>
<th>Do not plug in the power cord if you are wet.</th>
<th>Do not use the power cord if it is broken.</th>
<th>Do not place heavy objects on the power cord.</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Image 1" /></td>
<td><img src="image2.png" alt="Image 2" /></td>
<td><img src="image3.png" alt="Image 3" /></td>
</tr>
</tbody>
</table>

**Power Safety Warning**

Before you undertake any upgrade procedures, make sure that you have turned off the power, and disconnected all peripherals and cables (including telephone lines). It is advisable to also remove your battery in order to prevent accidentally turning the machine on.
Battery Precautions

- Only use batteries designed for this computer. The wrong battery type may explode, leak or damage the computer.
- Do not remove any batteries from the computer while it is powered on.
- Do not continue to use a battery that has been dropped, or that appears damaged (e.g. bent or twisted) in any way. Even if the computer continues to work with a damaged battery in place, it may cause circuit damage, which may possibly result in fire.
- If you do not use the battery for an extended period, then remove the battery from the computer for storage.
- Recharge the batteries using the notebook’s system. Incorrect recharging may make the battery explode.
- Do not try to repair a battery pack. Refer any battery pack repair or replacement to your service representative or qualified service personnel.
- Keep children away from, and promptly dispose of a damaged battery. Always dispose of batteries carefully. Batteries may explode or leak if exposed to fire, or improperly handled or discarded.
- Keep the battery away from metal appliances.
- Affix tape to the battery contacts before disposing of the battery.
- Do not touch the battery contacts with your hands or metal objects.
Cleaning
Do not apply cleaner directly to the computer; use a soft clean cloth.
Do not use volatile (petroleum distillates) or abrasive cleaners on any part of the computer.

Servicing
Do not attempt to service the computer yourself. Doing so may violate your warranty and expose you and the computer to electric shock. Refer all servicing to authorized service personnel. Unplug the computer from the power supply. Then refer servicing to qualified service personnel under any of the following conditions:

- When the power cord or AC/DC adapter is damaged or frayed.
- If the computer has been exposed to rain or other liquids.
- If the computer does not work normally when you follow the operating instructions.
- If the computer has been dropped or damaged (do not touch the poisonous liquid if the LCD panel breaks).
- If there is an unusual odor, heat or smoke coming from your computer.

Removal Warning
When removing any cover(s) and screw(s) for the purposes of device upgrade, remember to replace the cover(s) and screw(s) before turning the computer on.
Preface

Travel Considerations

Packing
As you get ready for your trip, run through this list to make sure the system is ready to go:

1. Check that the battery pack and any spares are fully charged.
2. Power off the computer and peripherals.
3. Close the display panel and make sure it’s latched.
4. Disconnect the AC/DC adapter and cables. Stow them in the carrying bag.
5. The AC/DC adapter uses voltages from 100 to 240 volts so you won’t need a second voltage adapter. However, check with your travel agent to see if you need any socket adapters.
6. Put the notebook in its carrying bag and secure it with the bag’s straps.
7. If you’re taking any peripherals (e.g. a printer, mouse or digital camera), pack them and those devices’ adapters and/or cables.
8. Anticipate customs - Some jurisdictions may have import restrictions or require proof of ownership for both hardware and software. Make sure your documents are prepared.

Power Off Before Traveling
Make sure that your notebook is completely powered off before putting it into a travel bag (or any such container). Putting a notebook which is powered on in a travel bag may cause the vent(s)/fan intake(s)/outlet(s) to be blocked. To prevent your computer from overheating make sure nothing blocks the vent(s)/fan intake(s)/outlet(s) while the computer is in use.
On the Road
In addition to the general safety and maintenance suggestions in this preface, and Chapter 8: Troubleshooting, keep these points in mind:

**Hand-carry the notebook** - For security, don’t let it out of your sight. In some areas, computer theft is very common. Don’t check it with normal luggage. Baggage handlers may not be sufficiently careful. Avoid knocking the computer against hard objects.

**Beware of Electromagnetic fields** - Devices such as metal detectors & X-ray machines can damage the computer, hard disk, floppy disks, and other media. They may also destroy any stored data - Pass your computer and disks around the devices. Ask security officials to hand-inspect them (you may be asked to turn it on). **Note:** Some airports also scan luggage with these devices.

**Fly safely** - Most airlines have regulations about the use of computers and other electronic devices in flight. These restrictions are for your safety, follow them. If you stow the notebook in an overhead compartment, make sure it’s secure. Contents may shift and/or fall out when the compartment is opened.

**Get power where you can** - If an electrical outlet is available, use the AC/DC adapter and keep your battery(ies) charged.

**Keep it dry** - If you move quickly from a cold to a warm location, water vapor can condense inside the computer. Wait a few minutes before turning it on so that any moisture can evaporate.
Preface

Developing Good Work Habits

Developing good work habits is important if you need to work in front of the computer for long periods of time. Improper work habits can result in discomfort or serious injury from repetitive strain to your hands, wrists or other joints. The following are some tips to reduce the strain:

- Adjust the height of the chair and/or desk so that the keyboard is at or slightly below the level of your elbow. Keep your forearms, wrists, and hands in a relaxed position.
- Your knees should be slightly higher than your hips. Place your feet flat on the floor or on a footrest if necessary.
- Use a chair with a back and adjust it to support your lower back comfortably.
- Sit straight so that your knees, hips and elbows form approximately 90-degree angles when you are working.
- Take periodic breaks if you are using the computer for long periods of time.

Remember to:
- Alter your posture frequently.
- Stretch and exercise your body several times a day.
- Take periodic breaks when you work at the computer for long periods of time. Frequent and short breaks are better than fewer and longer breaks.
Lighting
Proper lighting and comfortable display viewing angle can reduce eye strain and muscle fatigue in your neck and shoulders.

- Position the display to avoid glare or reflections from overhead lighting or outside sources of light.
- Keep the display screen clean and set the brightness and contrast to levels that allow you to see the screen clearly.
- Position the display directly in front of you at a comfortable viewing distance.
- Adjust the display-viewing angle to find the best position.

LCD Screen Care
To prevent image persistence on LCD monitors (caused by the continuous display of graphics on the screen for an extended period of time) take the following precautions:

- Set the Windows Power Plans to turn the screen off after a few minutes of screen idle time.
- Use a rotating, moving or blank screen saver (this prevents an image from being displayed too long).
- Rotate desktop background images every few days.
- Turn the monitor off when the system is not in use.
## Contents

### Notice ................................................................................. I
### FCC Statement .................................................................. II
### FCC RF Radiation Exposure Statement: ........................ III
### Instructions for Care and Operation .............................. V
### Power Safety ................................................................. VII
### Battery Precautions ..................................................... VIII
### Cleaning .......................................................................... IX
### Servicing ........................................................................... IX
### Travel Considerations .................................................... X

### Quick Start Guide

- **Overview** .............................................................. 1-1
- **Advanced Users** .................................................... 1-2
- **Beginners and Not-So-Advanced Users** ..................... 1-2
- **Warning Boxes** ...................................................... 1-2
- **Not Included** ........................................................ 1-3
- **System Startup** ....................................................... 1-4
- **System Software** ..................................................... 1-5
- **RAID & AHCI Setup** .............................................. 1-5
- **Model Differences** .................................................. 1-6
- **System Map: Front View - Model A** ......................... 1-7
- **System Map: Front View - Model B** ......................... 1-8
- **LED Indicators** ......................................................... 1-9
- **Hot Key Buttons & Keyboard** ................................. 1-10
- **Keyboard** ............................................................... 1-11
- **Function/Hot Key Indicators** .................................... 1-12
- **System Map: Left View** .......................................... 1-13
- **System Map: Right View** ......................................... 1-15
- **System Map: Rear View** .......................................... 1-16
- **System Map: Bottom View - Model A** ..................... 1-17
- **System Map: Bottom View - Model B** ..................... 1-18
- **Windows Vista Start Menu & Control Panel** ............... 1-19
- **Video Features** ......................................................... 1-20
- **Display Devices & Options** ..................................... 1-21
- **Power Options** ......................................................... 1-22

### Features & Components

- **Overview** .............................................................. 2-1
- **Hard Disk Drive** ...................................................... 2-2
- **Optical (CD/DVD) Device** ....................................... 2-3
- **Loading Discs** ........................................................ 2-3
- **Handling CDs or DVDs** .......................................... 2-4
- **DVD Regional Codes** ............................................. 2-5
- **7-in-1 Card Reader** .................................................. 2-6
- **ExpressCard Slot** ..................................................... 2-7
- **Inserting and Removing ExpressCards** ..................... 2-7
### Preface

- TouchPad and Buttons/Mouse ....................................... 2-8
- Gesture Configuration ............................................... 2-9
- Audio Features ......................................................... 2-10
- Adding a Printer ........................................................ 2-11
  - USB Printer ......................................................... 2-11
  - Parallel Printer .................................................... 2-11

### Power Management

- Overview ............................................................... 3-1
- The Power Sources .................................................. 3-2
- AC/DC Adapter ........................................................ 3-2
- Battery ................................................................. 3-2
- Turning on the Computer .......................................... 3-3
- Power Plans ............................................................ 3-4
- Power-Saving States ................................................ 3-6
- Sleep ........................................................................ 3-6
- Hibernate ............................................................... 3-7
- Shut Down ............................................................... 3-7
- Configuring the Power Buttons ................................... 3-8
- Resuming Operation .................................................. 3-9
- Battery Information .................................................. 3-10
- Battery Power .......................................................... 3-10
- Conserving Battery Power ........................................... 3-11
- Battery Life ............................................................. 3-12
- New Battery ............................................................. 3-12
- Recharging the Battery with the AC/DC Adapter ........... 3-12
- Proper handling of the Battery Pack ......................... 3-13
- Battery FAQ ............................................................ 3-14

### Drivers & Utilities

- RAID & AHCI Setup .................................................. 4-1
- What to Install ........................................................ 4-1
- Module Driver Installation ......................................... 4-1
- Driver Installation .................................................... 4-2
- Updating/Reinstalling Individual Drivers .................... 4-4
- User Account Control (Win Vista) ............................ 4-5
- Windows Security Message ....................................... 4-5
- New Hardware Found ................................................ 4-5
- Driver Installation Procedure .................................... 4-6
- Chipset ....................................................................... 4-6
- Video ......................................................................... 4-6
- Modem ....................................................................... 4-6
- LAN ........................................................................... 4-6
- Firewire (IEEE 1394) .................................................. 4-6
- CardReader ............................................................... 4-6
- TouchPad ................................................................. 4-6
- Hot Key ...................................................................... 4-7
- Audio ......................................................................... 4-7
- Optional Drivers ....................................................... 4-8
- PC Camera Module .................................................. 4-8
Wireless LAN Module ...................................................4-8
Fingerprint Reader Module ............................................4-8
3.75G/HSPA Module (Model A Only) ..........................4-8
TV Tuner Module (Model B Only) ...............................4-9
RAID and AHCI Configuration .....................................4-9

BIOS Utilities
Overview ........................................................................5-1
The Power-On Self Test (POST) ...................................5-2
Failing the POST ...........................................................5-3
Fatal Errors ....................................................................5-3
Non-Fatal Errors ............................................................5-3
The Setup Program ........................................................5-4
Entering Setup ...............................................................5-4
Setup Screens .................................................................5-5
Main Menu .....................................................................5-6
System Time & Date (Main Menu) ...............................5-6
SATA Port 1/2/3/4/5 (Main Menu) ...............................5-7
System/Extended Memory (Main Menu) ......................5-7
BIOS Revision/KBC/EC Firmware Revision (Main Menu) ..........5-7
VGA Card/VBIOS Revision/ VBIOS Build Date (Main Menu) ..........5-7
Advanced Menu .............................................................5-8
Advanced Chipset Control .............................................5-8
SATA Mode Selection (Advanced Menu) .....................5-9
Legacy USB Support (Advanced Menu) .......................5-9
Boot-time Diagnostic Screen (Advanced Menu) ............5-9
Legacy OS Boot (Advanced Menu) ..............................5-9
Power On Boot Beep (Advanced Menu) .......................5-9
Battery Low Alarm Beep (Advanced Menu) .................5-9
Security Menu ..............................................................5-10
Set Supervisor Password (Security Menu) ..................5-10
Set User Password (Security Menu) ............................5-10
Password on boot (Security Menu) ..............................5-11
Boot Menu .................................................................5-12
Exit Menu ...................................................................5-13

Upgrading The Computer
Overview ........................................................................6-1
When Not to Upgrade ....................................................6-2
Removing the Battery ....................................................6-3
Upgrading the Hard Disk Drive(s) .................................6-4
Upgrading the Optical (CD/DVD) Device .....................6-8
Upgrading the System Memory (RAM) ......................6-10

Modules & Options
Overview ........................................................................7-1
Bluetooth Module ..........................................................7-2
Bluetooth Configuration in Windows Vista ..................7-3
Preface

PC Camera Module .............................................................. 7-7
PC Camera Driver Installation ............................................. 7-8
Wireless LAN Module ........................................................... 7-16
Intel® Wi-Fi Link Series Driver Installation ....................... 7-17
3rd Party 802.11b/g/n Driver Installation ......................... 7-17
Connecting to a Wireless Network ...................................... 7-18
Intel® My WiFi Installation & Configuration ..................... 7-21
Intel® Wi-Fi Link Series My WiFi Driver Installation .......... 7-22
Windows Mobility Center .................................................... 7-33
Fingerprint Reader Module .................................................. 7-34
Fingerprint Reader Driver Installation ............................. 7-34
User Enrollment ................................................................. 7-35
Fingerprint Control Center Features ................................. 7-38
3.75G/HSPA Module .......................................................... 7-39
USIM Card Installation ....................................................... 7-41
HSPA Modem Interface ....................................................... 7-43
HSPA Modem Interface Installation ................................. 7-43
HSPA Modem Interface ....................................................... 7-44
Adding a Profile ................................................................. 7-46
Contacts ............................................................................ 7-48
Messages .......................................................................... 7-49
Settings .............................................................................. 7-50
Mobile Partner ................................................................. 7-52
Mobile Partner Application Installation ............................. 7-52
Mobile Partner Application ................................................. 7-53
Profile Management ............................................................. 7-53
TV Tuner Module ............................................................... 7-57
Consumer Infrared Driver ................................................... 7-58
Digital TV Broadcast Signal ................................................. 7-59
TV Recording and Power Plans ........................................... 7-59
Remote Control Unit ........................................................... 7-59
Setting Up SATA RAID or AHCI Modes ............................ 7-60
AHCI Mode ........................................................................ 7-60
RAID (Model B Only) .......................................................... 7-60
Intel® Matrix Storage Manager ........................................... 7-60
SATA RAID Setup Procedure (BIOS) ................................. 7-62
RAID Setup (Intel Matrix) .................................................... 7-63
Intel Matrix Driver Installation ............................................. 7-65
Intel® Matrix Storage Manager ............................................ 7-65
RAID Volume Data Verification and Repair ...................... 7-67
Replacing and Reverting Recovery and Master Volumes ......... 7-67
Troubleshooting
Overview ........................................................................... 8-1
Basic Hints and Tips ............................................................ 8-2
Backup and General Maintenance ..................................... 8-3
Viruses .............................................................................. 8-4
Upgrading and Adding New Hardware/Software ............ 8-5
Preface

Problems and Possible Solutions ...................................8-7
Screen Resolution Error ...............................................8-13

Interface (Ports & Jacks)
Overview .................................................................A-1

NVIDIA Video Driver Controls
NVIDIA Video Driver Installation ............................... B-1
NVIDIA Control Panel ................................................. B-2
Display Devices .......................................................... B-5
Attaching Other Displays .......................................... B-6
HDMI Audio Configuration ................................... B-11
Display Modes ............................................................ B-14
Enabling TV Display .................................................. B-17
Changing the TV Signal or HD Format ................. B-18

Specifications
Processor ....................................................................... C-2
Core Logic .................................................................... C-2
Display .......................................................................... C-2
Memory ......................................................................... C-2
Video Adapter ............................................................... C-2
BIOS ............................................................................ C-2
Storage .......................................................................... C-3
Audio ............................................................................ C-3
Keyboard & Pointing Device ...........................................C-3
Interface ........................................................................C-3
Card Reader ....................................................................C-3
Slots ..............................................................................C-3
Communication .......................................................... C-4
Communication (cont’d) .............................................. C-4
Power Management ..................................................... C-4
Power ............................................................................ C-4
Security ......................................................................... C-4
Operating System ....................................................... C-4
Environmental Spec .................................................... C-4
Dimensions & Weight .................................................. C-4
Factory Options As Per Model .................................... C-4
Factory Options for All Models .................................... C-5

Windows 7 Information
DVD Regional Codes ...................................................D-2
Windows 7 Start Menu & Control Panel ......................D-3
Function/Hot Key Indicators ........................................D-4
Hot Key Buttons & Keyboard .......................................D-5
Video Features .............................................................D-6
Screen Resolution .......................................................D-7
NVIDIA Control Panel ................................................D-8
Attaching Other Displays ..............................................B-9
The Power Sources .....................................................D-11
Chapter 1: Quick Start Guide

Overview

This Quick Start Guide is a brief introduction to the basic features of your computer, to navigating around the computer and to getting your system started. The remainder of the manual covers the following:

• Chapter 2 A guide to using some of the main features of the computer e.g. the storage devices (hard disk, optical device, 7-in-1 card reader, ExpressCard/34/54), TouchPad & Mouse, Audio & Printer.
• Chapter 3 The computer’s power saving options.
• Chapter 4 The installation of the drivers and utilities essential to the operation or improvement of some of the computer’s subsystems.
• Chapter 5 An outline of the computer’s built-in software or BIOS (Basic Input Output System).
• Chapter 6 Instructions for upgrading your computer.
• Chapter 7 A quick guide to the computer’s Bluetooth, PC Camera, Wireless LAN, Fingerprint, 3.75G/HSPA, TV Tuner and RAID modules (some of which may be optional depending on your purchase configuration).
• Chapter 8 A troubleshooting guide.
• Appendix A Definitions of the interface, ports/jacks which allow your computer to communicate with external devices.
• Appendix B Information on the NVIDIA Video driver controls.
• Appendix C The computer’s specification.
• Appendix D Information specific to the Windows 7 OS.
Quick Start Guide

Advanced Users
If you are an advanced user you may skip over most of this Quick Start Guide. However you may find it useful to refer to “What to Install” on page 4 - 1, “BIOS Utilities” on page 5 - 1 and “Upgrading The Computer” on page 6 - 1 in the reminder of the User’s Manual. You may also find the notes marked with a of interest to you.

Beginners and Not-So-Advanced Users
If you are new to computers (or do not have an advanced knowledge of them) then the information contained in the Quick Start Guide should be enough to get you up and running. Eventually you should try to look through all the documentation (more detailed descriptions of the functions, setup and system controls are covered in the remainder of the User’s Manual), but do not worry if you do not understand everything the first time. Keep this manual nearby and refer to it to learn as you go. You may find it useful to refer to the notes marked with a as indicated in the margin. For a more detailed description of any of the interface ports and jacks see “Interface (Ports & Jacks)” on page A - 1.

Warning Boxes
No matter what your level please pay careful attention to the warning and safety information indicated by the symbol. Also please note the safety and handling instructions as indicated in the Preface.
Not Included
Operating Systems (e.g. Windows Vista/Windows 7) and applications (e.g. word processing, spreadsheet and database programs) have their own manuals, so please consult the appropriate manuals.

Drivers
If you are installing new system software, or are re-configuring your computer for a different system, you will need to install the drivers listed in “Drivers & Utilities” on page 4 - 1. Drivers are programs which act as an interface between the computer and a hardware component e.g. a wireless network module. It is very important that you install the drivers in the order listed. You will be unable to use most advanced controls until the necessary drivers and utilities are properly installed. If your system hasn’t been properly configured (your service representative may have already done that for you); refer to Chapter 4 for installation instructions.

Ports and Jacks
See Appendix A for a description of the interface (ports & jacks) which allow your computer to communicate with external devices, connect to the internet etc.
Quick Start Guide

System Startup
1. Remove all packing materials.
2. Place the computer on a stable surface.
3. Securely attach any peripherals you want to use with the notebook (e.g. keyboard and mouse) to their ports.
4. Attach the AC/DC adapter to the DC-In jack at the rear of the computer, then plug the AC power cord into an outlet, and connect the AC power cord to the AC/DC adapter.
5. Use one hand to raise the lid/LCD to a comfortable viewing angle (do not exceed 120 degrees); use the other hand (as illustrated in Figure 1 - 1 below) to support the base of the computer (Note: Never lift the computer by the lid/LCD).

Shutdown
Note that you should always shut your computer down by choosing the Shut Down command from the Lock Button Menu in Windows Vista. This will help prevent hard disk or system problems.

Figure 1 - 1 - Opening the Lid/LCD
System Software

Your computer may already come with system software pre-installed. Where this is not the case, or where you are re-configuring your computer for a different system, you will find the following operating systems are supported.

<table>
<thead>
<tr>
<th>Operating System &amp; Version</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows Vista - with Service Pack 2</td>
<td>In order to run Windows Vista/Windows 7 without limitations or decreased performance, your computer requires a minimum 1GB of system memory (RAM).</td>
</tr>
<tr>
<td>Windows 7</td>
<td></td>
</tr>
</tbody>
</table>

Table 1 - 1 - Operating Systems Supported

RAID & AHCI Setup

Note that setting up a RAID, or AHCI mode, needs to be done prior to installing the Windows OS (see “Setting Up SATA RAID or AHCI Modes” on page 7 - 60).

This manual refers to the Windows Vista OS. For any information specific to Windows 7 see Appendix D. Make sure you install Windows Vista Service Pack 2 (or a Windows Vista version which includes Service Pack 2) before installing any drivers. Go to the Microsoft website for download details, or contact your service center.

TV Tuner Module Support

Note that the TV Tuner module (factory) option in Windows is supported by the Windows Media Center software which comes built-in to the Windows Vista Home Premium and Ultimate Editions only.

If your purchase includes a TV Tuner option, and you are re-configuring your system for a different system, you should install either Home Premium or Ultimate Editions of Windows Vista only. Note that Windows Media Center is not included in Starter or Home Basic versions of Windows 7.
Quick Start Guide

Model Differences

This notebook series includes two different model types that differ as indicated in the table below (see Appendix D).

<table>
<thead>
<tr>
<th>Feature</th>
<th>Model A</th>
<th>Model B</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display Type Supported</td>
<td>15.6&quot; HD (1366 * 768) / HD+ (1600 * 900) / FHD (1920 * 1080) 16:9 Wide Screen LED Panel</td>
<td>17.3&quot; FHD (1920 * 1080) / HD+ (1600 * 900) 16:9 Wide Screen LED Backlit Panel</td>
</tr>
<tr>
<td>Video Controller</td>
<td>nVIDIA® GeForce GTX 280M OR nVIDIA® GeForce GTX 260M</td>
<td>nVIDIA® GeForce GTX 280M</td>
</tr>
<tr>
<td>RAID Supported</td>
<td>Not Supported</td>
<td>RAID Level 0/1 Supported</td>
</tr>
<tr>
<td>Mini-Card Slot 2</td>
<td>for UMTS/HSPA 3.75G Module</td>
<td>for TV Tuner Card</td>
</tr>
</tbody>
</table>

Table 1 - 2 - Model Differences
System Map: Front View - Model A

Wireless Device Operation Aboard Aircraft

The use of any portable electronic transmission devices aboard aircraft is usually prohibited. Make sure the module(s) are OFF if you are using the computer aboard aircraft.

Use the key combinations to toggle power to the 3.75G/HSPA/WLAN/Bluetooth modules, and check the LED indicator icon to see if the modules are powered on or not (see Table 1 - 6, on page 1 - 12, Table 1 - 4, on page 1 - 9).

Note: The Fingerprint Reader module is optional for Model A computers.
Quick Start Guide

System Map: Front View - Model B

1. Built-In PC Camera (Optional)
2. LCD
3. LED Status Indicators
4. LED Hot Key Buttons
5. LED Power Button
6. Speakers
7. Keyboard
8. Built-In Microphone
9. Touchpad & Buttons
10. Consumer Infrared Transceiver (for Optional TV Tuner)
11. LED Power Indicators

Note: The Fingerprint Reader module is optional for Model B computers.

Wireless Device Operation Aboard Aircraft

The use of any portable electronic transmission devices aboard aircraft is usually prohibited. Make sure the module(s) are OFF if you are using the computer aboard aircraft.

Use the key combinations to toggle power to the WLAN/Bluetooth modules, and check the LED indicator icon to see if the modules are powered on or not (see Table 1 - 6, on page 1 - 12/ Table 1 - 4, on page 1 - 9).

Touchpad Buttons (valid operation area)
LED Indicators

The LED indicators on the LED strip just below the LCD panel on the computer display helpful information about the current status of the computer when illuminated.

A further two LED power indicators on the front right of the computer provide information on the computer’s power status.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
<th>Color</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="icon1.png" alt="Image" /></td>
<td>Hard Disk Activity</td>
<td>Orange</td>
<td>DC Power is Plugged In</td>
</tr>
<tr>
<td><img src="icon2.png" alt="Image" /></td>
<td>Number Lock Activated (to activate press Fn &amp; Num Lk)</td>
<td>Green</td>
<td>The Computer is On</td>
</tr>
<tr>
<td><img src="icon3.png" alt="Image" /></td>
<td>Caps Lock Activated</td>
<td>Blinking Green</td>
<td>The Computer is in Sleep Mode</td>
</tr>
<tr>
<td><img src="icon4.png" alt="Image" /></td>
<td>Scroll Lock Activated (to activate press Fn &amp; Scr Lk)</td>
<td>Orange</td>
<td>The Battery is Charging</td>
</tr>
<tr>
<td><img src="icon5.png" alt="Image" /></td>
<td>The (optional) Wireless LAN Module is Powered On</td>
<td>Green</td>
<td>The Battery is Fully Charged</td>
</tr>
<tr>
<td><img src="icon6.png" alt="Image" /></td>
<td>The (optional) Bluetooth Module is Powered On</td>
<td>Blinking Orange</td>
<td>The Battery Has Reached Critically Low Power Status</td>
</tr>
</tbody>
</table>

Table 1 - 3 - LED Status Indicators

Table 1 - 4 - LED Power Indicators
Hot Key Buttons & Keyboard

The LED hot key buttons give instant access to the default Internet browser and e-mail program, and allow you to toggle Silent Mode with one quick button press.

<table>
<thead>
<tr>
<th>Hot Key</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>[/mail]</strong></td>
<td>Activate the Default E-Mail Browser (Note that In Windows 7 without Outlook/Outlook Express installed this button has no function. If Outlook/Outlook Express are installed then the button will activate the application)</td>
</tr>
<tr>
<td><strong>[internet]</strong></td>
<td>Activate the Default Internet Program</td>
</tr>
<tr>
<td><strong>[mode]</strong></td>
<td>Toggle *Silent Mode (for power saving)</td>
</tr>
</tbody>
</table>

*When enabled, Silent Mode will reduce fan noise and save power consumption. Note this may reduce computer performance.

Other Keyboards

If your keyboard is damaged or you just want to make a change, you can use any standard USB keyboard. The system will detect and enable it automatically. However special functions/hot-keys unique to the system’s regular keyboard may not work.

NumLk & ScrLk

Hold down the Fn Key and either NumLk or ScrLk to enable number or scroll lock, and check the LED indicator for status.

Special Characters

Some software applications allow the number-keys to be used with Alt to produce special characters. These special characters can only be produced by using the numeric keypad. Regular number keys (in the upper row of the keyboard) will not work. Make sure that NumLk is on.
Keyboard

The keyboard has a numerical keypad on the right for easy numeric data input, and features function keys to allow you to change operational features instantly. See Table 1 - 6, on page 1 - 12 for full function key combination details.

Figure 1 - 4 - Keyboard
# Function/Hot Key Indicators

The **function keys** (F1 - F12 etc.) will act as **hot keys** when pressed while the **Fn** key is held down. In addition to the basic function key combinations; visual indicators are available when the hot key utility is installed.

## Table 1 - 6 - Function & Hot Key Indicators

<table>
<thead>
<tr>
<th>Fn Keys</th>
<th>Function</th>
<th>Fn Keys</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fn + ~</td>
<td>Play/Pause (in Audio/Video Programs)</td>
<td>Fn + F5/F6</td>
<td>Volume Decrease/Increase</td>
</tr>
<tr>
<td>Fn + _</td>
<td>3.75G Module Power Toggle*</td>
<td>Fn + F7</td>
<td>Display Toggle</td>
</tr>
<tr>
<td>Fn + F1</td>
<td>Touchpad Toggle</td>
<td>Fn + F8/F9</td>
<td>Brightness Decrease/Increase</td>
</tr>
<tr>
<td>Fn + F2</td>
<td>Turn LCD Backlight Off (Press a key to or use TouchPad to turn on)</td>
<td>Fn + F10</td>
<td>PC Camera Power Toggle</td>
</tr>
<tr>
<td>Fn + F3</td>
<td>Mute Toggle</td>
<td>Fn + F11</td>
<td>WLAN Module Power Toggle</td>
</tr>
<tr>
<td>Fn + F4</td>
<td>Sleep Toggle</td>
<td>Fn + F12</td>
<td>Bluetooth Module Power Toggle</td>
</tr>
<tr>
<td><img src="image" alt="Silent Mode Toggle" /></td>
<td>*Silent Mode Toggle</td>
<td><img src="image" alt="Silent Mode Toggle" /></td>
<td>*Silent Mode will reduce fan noise and save power consumption. Note this may reduce computer performance.</td>
</tr>
</tbody>
</table>

---

1 - 12 Function/Hot Key Indicators
System Map: Left View

1. RJ-11 Modem Jack
2. USB 2.0 Port
3. Mini-IEEE 1394 Port
4. 7-in-1 Card Reader
5. Optical Device Drive Bay (for DVD Device)
6. Cable (CATV) Antenna Jack*

*Enabled with Optional TV Tuner Only

**Note:**

7-in-1 Card Reader

The card reader allows you to use the most popular digital storage card formats:

- MMC (MultiMedia Card) / SD (Secure Digital) / MS (Memory Stick) / MS Pro (Memory Stick Pro) / MS Duo (requires PC adapter) / Mini SD (requires PC adapter) / RS MMC (requires PC adapter)

Mini-IEEE 1394 Port

The Mini-IEEE 1394 port only supports SELF POWERED IEEE 1394 devices. Make sure you install the Firewire IEEE 1394 driver (see page 4 - 6).
Disk Eject Warning
Don’t try to eject a CD/DVD while the system is accessing it. This may cause the system to “crash”. Stop the disk first then eject it, or press the stop button twice.

CD/DVD Emergency Eject
If you need to manually eject a CD/DVD (e.g. due to an unexpected power interruption) you may push the end of a straightened paper clip into the emergency eject hole. Do not use a sharpened pencil or any object that may break and become lodged in the hole. Don’t try to remove a floppy disk/CD/DVD while the system is accessing it. This may cause the system to “crash”.

Changing DVD Regional Codes
Go to the Control Panel and double-click Device Manager (Hardware and Sound), then click the + next to DVD/CD-ROM drives. Double-click on the DVD-ROM device to bring up the Properties dialog box, and select the DVD Region (tab) to bring up the control panel to allow you to adjust the regional code (see “DVD Regional Codes” on page 2 - 5).

DVD region detection is device dependent, not OS-dependent. You can select your module’s region code 5 times. The fifth selection is permanent. This cannot be altered even if you change your operating system or you use the module in another computer.
System Map: Right View

1. Headphone-Out Jack
2. Microphone-In Jack
3. Line-In Jack
4. S/PDIF-Out Jack
5. USB 2.0 Port
6. ExpressCard Slot (see page 2 - 7)
7. e-SATA Port
8. DVI-Out Port
9. Security Lock Slot (Model B Only)
10. Power Button (Model A Only)
**Quick Start Guide**

**System Map: Rear View**

*Figure 1 - 7
Rear View*

1. Vent/Fan Intake/Outlet
2. Security Lock Slot (*Model A* Only)
3. HDMI-Out Port
4. DC-In Jack
5. 2 * USB Ports
6. RJ-45 LAN Jack
7. Rear Cover (*Model B* Only)

---

**Overheating**

To prevent your computer from overheating make sure nothing blocks the vent(s)/fan intake(s) while the computer is in use.

---

**HDMI-Out Port**

Note that the HDMI-Out Port supports video and audio signals to attached external displays (also see "HDMI Audio Configuration" on page B - 11).
System Map: Bottom View - Model A

Battery Information
Always completely discharge, then fully charge, a new battery before using it. Completely discharge and charge the battery at least once every 30 days or after about 20 partial discharges. See “Battery Information” on page 3 - 10 for full instructions.

CPU
The CPU is not a user serviceable part.

Overheating
To prevent your computer from overheating make sure nothing blocks the Vent/Fan Intake while the computer is in use.

Note: the 3.75G/HSPA USIM Card is located under the Component Bay Cover.
1. Battery
2. Component Bay Cover
3. Vent/Fan Intake/Outlet
4. Speaker

**Battery Information**

Always completely discharge, then fully charge, a new battery before using it. Completely discharge and charge the battery at least once every 30 days or after about 20 partial discharges. See "Battery Information" on page 3 - 10 for full instructions.

**CPU**

The CPU is not a user serviceable part.

**Overheating**

To prevent your computer from overheating make sure nothing blocks the Vent/Fan Intake while the computer is in use.
Windows Vista Start Menu & Control Panel

Most of the control panels, utilities and programs within *Windows Vista* (and most other *Windows* versions) are accessed from the **Start** menu. When you install programs and utilities they will be installed on your hard disk drive, and a shortcut will usually be placed in the **Start** menu and/or the desktop. Right-click the **Start menu** icon, and then select **Properties** if you want to customize the appearance of the **Start** menu.

In many instances throughout this manual you will see an instruction to open the **Control Panel**. The **Control Panel** is accessed from the **Start** menu, and it allows you to configure the settings for most of the key features in *Windows* (e.g. power, video, network, audio etc.). *Windows Vista* provides basic controls for many of the features, however many new controls are added (or existing ones are enhanced) when you install the drivers listed in *Table 4 - 1, on page 4 - 3*. To see all controls it may be necessary to toggle to Classic View on.
Quick Start Guide

Video Features

You can configure display options, from the Display Settings control panel in Windows as long as the appropriate video driver is installed. For more detailed video information see “NVIDIA Video Driver Controls” on page B - 1. To access Display Settings in Windows:

1. Click Start, and click Control Panel (or point to Settings and click Control Panel).
2. Click Adjust screen resolution under the Appearance and Personalization menu (or double-click Personalization > Display Settings).
3. Move the slider to the preferred setting in Resolution: \(1\) \((\text{Figure 1 - 11 on page 1 - 21})\).
4. Click the arrow, and scroll to the preferred setting in Colors: \(2\) \((\text{Figure 1 - 11 on page 1 - 21})\).
5. Click Advanced Settings (button) \(3\) \((\text{Figure 1 - 11 on page 1 - 21})\).
6. Click GeForce..... (tab).
7. Click Start the NVIDIA Control Panel \(4\) \((\text{Figure 1 - 11 on page 1 - 21})\) to access the control panel.
8. The NVIDIA Control Panel can also be accessed by right-clicking the desktop, and then clicking NVIDIA Control Panel (or from the NVIDIA Control Panel in the Windows control panel).

Video Card Options

Note that card types, specifications and drivers are subject to continual updates and changes. Check with your service center for the latest details on video cards supported (see “Video Adapter Options” on page C - 2 for details).
Display Devices & Options

Besides the built-in LCD, you can also use an external VGA monitor (CRT)/external Flat Panel Display or TV (connected to the DVI-Out port/HDMI-Out port) as your display device.

![Display Settings & NVIDIA Control Panel](image)

**Figure 1 - 11 - Display Settings & NVIDIA Control Panel**

<table>
<thead>
<tr>
<th>NVIDIA Display Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Single</td>
<td>One display device is used.</td>
</tr>
<tr>
<td>Clone</td>
<td>Both connected displays output the same view</td>
</tr>
<tr>
<td>Dualview</td>
<td>Both connected displays are treated as separate devices, and act as a virtual desktop</td>
</tr>
</tbody>
</table>

**Table 1 - 7 - Display Modes Available**
Quick Start Guide

Power Options

The **Power Options** (Hardware and Sound menu) control panel icon in *Windows* (see page 1 - 18) allows you to configure power management features for your computer. You can conserve power by means of **power plans** and configure the options for the **power button**, **sleep button**, **computer lid (when closed)**, **display** and **sleep mode** from the left menu. Note that the **Power saver** plan may have an affect on computer performance.

Click to select one of the existing plans, or click **Create a power plan** in the left menu and select the options to create a new plan. Click **Change Plan Settings** and click **Change advanced power settings** to access further configuration options.

Pay attention to the instructions on battery care in “**Battery Information**” on page 3 - 10.

![Power Options](image)

**Note:** **Sleep** is the default power saving state in *Windows Vista*

*Figure 1 - 12 - Power Options*
Chapter 2: Features & Components

Overview
Read this chapter to learn more about the following main features and components of the computer:

- Hard Disk Drive
- Optical (CD/DVD) Device
- 7-in-1 Card Reader
- ExpressCard Slot
- TouchPad and Buttons/Mouse
- Gesture Configuration
- Adding a Printer
**Features & Components**

**Power Safety**
Before attempting to access any of the internal components of your computer please ensure that the machine is not connected to the AC power, and that the machine is turned off. Also ensure that all peripheral cables, including phone lines, are disconnected from the computer.

**Hard Disk Drive**
The hard disk drive is used to store your data in the computer. The hard disk can be taken out to accommodate other 2.5” serial (SATA) hard disk drives (see “Storage” on page C - 3) with a height of 9.5 mm.

The hard disk is accessible from the bottom of your computer as seen below. For further details see “Upgrading the Hard Disk Drive(s)” on page 6 - 4.

*Figure 2 - 1*
Hard Disk Location

2 - 2 Hard Disk Drive
Optical (CD/DVD) Device

There is a bay for a 5.25" optical (CD/DVD) device (12.7mm height). The actual device will depend on the module you purchased (see “Storage” on page C - 3). The optical device is usually labeled “Drive D:” and may be used as a boot device if properly set in the BIOS (see “Boot Menu” on page 5 - 12).

Loading Discs

To insert a CD/DVD, press the open button 1 and carefully place a CD/DVD onto the disc tray with label-side facing up (use just enough force for the disc to click onto the tray’s spindle). Gently push the CD/DVD tray in until its lock “clicks” and you are ready to start. The busy indicator 2 will light up while data is being accessed, or while an audio/video CD, or DVD, is playing. If power is unexpectedly interrupted, insert an object such as a straightened paper clip into the emergency eject hole 3 to open the tray.

Sound Volume Adjustment

How high the sound volume can be set depends on the setting of the volume control within Windows. Click the Volume icon on the taskbar to check the setting (see “Gesture Configuration” on page 2 - 9).
Handling CDs or DVDs
Proper handling of your CDs/DVDs will prevent them from being damaged. Please follow the advice below to make sure that the data stored on your CDs/DVDs can be accessed.

Note the following:

- Hold the CD or DVD by the edges; do not touch the surface of the disc.
- Use a clean, soft, dry cloth to remove dust or fingerprints.
- Do not write on the surface with a pen.
- Do not store or place the CD or DVD in high-temperature areas.
- Do not use benzene, thinner, or other cleaners to clean the CD or DVD.
- Do not bend the CD or DVD.
- Do not drop or subject the CD or DVD to shock.
DVD Regional Codes
To change the DVD regional codes see “Changing DVD Regional Codes” on page 1 - 14.

<table>
<thead>
<tr>
<th>Region</th>
<th>Geographical Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>USA, Canada</td>
</tr>
<tr>
<td>2</td>
<td>Western Europe, Japan, South Africa, Middle East &amp; Egypt</td>
</tr>
<tr>
<td>3</td>
<td>South-East Asia, Taiwan, South Korea, The Philippines, Indonesia, Hong Kong</td>
</tr>
<tr>
<td>4</td>
<td>South &amp; Central America, Mexico, Australia, New Zealand</td>
</tr>
<tr>
<td>5</td>
<td>N Korea, Russia, Eastern Europe, India &amp; Most of Africa</td>
</tr>
<tr>
<td>6</td>
<td>China</td>
</tr>
</tbody>
</table>

Table 2 - 1
DVD Regional Coding
7-in-1 Card Reader

The card reader allows you to use some of the latest digital storage cards. Push the card into the slot and it will appear as a removable device, and can be accessed in the same way as your hard disk(s). Make sure you install the Card Reader driver (see “CardReader” on page 4 - 6).

- MMC (MultiMedia Card)
- SD (Secure Digital)
- MS (Memory Stick)
- MS Pro (Memory Stick Pro)
- MS Duo (requires PC adapter*)
- Mini SD (requires PC adapter*)
- RS MMC (requires PC adapter*)

*Note: The PC adapters are usually supplied with these cards.

Card Reader Cover

Make sure you keep the rubber cover provided in the card reader when not in use. This will help prevent foreign objects and/or dust getting in to the card reader.

Figure 2 - 3
Left View

1. Card Reader
ExpressCard Slot

The computer is equipped with an **ExpressCard/34/54** slot that reads Express Card/34 and ExpressCard/54 formats. ExpressCards are the successors to PCMCIA (PC Cards). Make sure you install the Card Reader driver (see “CardReader” on page 4 - 6).

ExpressCard/54 is used for applications which require a larger interface slot, e.g. CompactFlash card reader. The number denotes the card width; 54mm for the Express Card/54 and 34mm for the ExpressCard/34.

Inserting and Removing ExpressCards

- Align the ExpressCard with the slot and push it in until it locks into place (as pictured in the generic figure below).
- To remove an ExpressCard, simply press the card to eject it.

ExpressCard Slot Cover

Make sure you keep the rubber cover provided in the ExpressCard slot when not in use. This will help prevent foreign objects and/or dust getting in to the Express-Card Slot.

Figure 2 - 4
Left View
1. Express Card Slot

Figure 2 - 5
Inserting & Removing Express Cards
Features & Components

TouchPad and Buttons/Mouse

The TouchPad is an alternative to the mouse; however, you can also add a mouse to your computer through one of the USB ports. The TouchPad buttons function in much the same way as a two-button mouse.

Once you have installed the TouchPad driver (see “TouchPad” on page 4 - 6) you can configure the functions by double-clicking the TouchPad driver icon on the taskbar. You may then configure the TouchPad tapping, buttons, scrolling (tap the top and bottom right of the TouchPad to scroll), pointer motion and sensitivity options to your preferences.

Figure 2 - 6
Mouse Properties
Gesture Configuration

The **Gesture Configuration** control allows you to configure specific gesture function settings on the surface of the TouchPad for various applications.

You can configure Gestures from the **Finger-sensing Pad** tab in **Mouse Properties**:

1. Click **Start**, and click **Control Panel** (or point to **Settings** and click **Control Panel**).
2. Click **Mouse (Hardware and Sound)**.
3. Click **Finger-sensing Pad** (tab) and select **Click On Pad** from **Available information and configuration items**.
4. Click **Configure** in **Gesture Configuration** to access the user configurable settings.

![Mouse Properties - Gesture Configuration](image-url)
Features & Components

Audio Features

You can configure the audio options on your computer from the Sound control panel in Windows, or from the Realtek HD Audio Manager icon in the taskbar/control panel (right-click the taskbar icon bring up an audio menu). The volume may also be adjusted by means of the Fn + F5/F6 key combination.

Figure 2 - 8
Realtek Audio Manager

Right-click the icon to access the menu above.
Adding a Printer

The most commonly used peripheral is a printer. The following conventions will help you to add a printer; however it is always best to refer to the printer manual for specific instructions and configuration options.

USB Printer
Most current printers have a USB interface connection. You may use any one of the ports to connect the printer.

Install Instructions:
1. Set up the printer according to its instructions (unpacking, paper tray, toner/ink cartridge etc.).
2. Turn ON the computer.
3. Turn ON the printer.
4. Connect the printer’s USB cable to one of the USB ports on the computer.
5. Windows will identify the printer and either load one of its own drivers or ask you to supply one. Follow the on-screen instructions.

Parallel Printer
This is still a very common type of printer. The install instructions are in the sidebar, however you will need to purchase a parallel to USB converter.

Parallel Printer
After setting up the printer attach the parallel cable to the printer.

Connect the printer’s parallel cable to the Parallel to USB converter, and then plug the converter into the USB port.

Turn ON the printer, then turn ON the computer.

Windows will identify the printer and either load one of its own drivers or ask you to supply one. Follow the on-screen instructions.
Chapter 3: Power Management

Overview

To conserve power, especially when using the battery, your computer power management conserves power by controlling individual components of the computer (the monitor and hard disk drive) or the whole system. This chapter covers:

- The Power Sources
- Turning on the Computer
- Power Plans
- Power-Saving States
- Configuring the Power Buttons
- Battery Information

The computer uses enhanced power saving techniques to give the operating system (OS) direct control over the power and thermal states of devices and processors. For example, this enables the OS to set devices into low-power states based on user settings and information from applications.

OS Note

Power management functions will vary slightly depending on your operating system. For more information it is best to refer to the user’s manual of your operating system.

(Note: All pictures used on the following pages are from the Windows Vista OS.)

Hibernate Mode In Windows Vista SP1

If you are using Windows Vista SP1 with 4GB RAM installed, see page 8 - 12 for information on Hibernate.
The Power Sources

The computer can be powered by either an AC/DC adapter or a battery pack.

AC/DC Adapter

Use only the AC/DC adapter that comes with your computer. The wrong type of AC/DC adapter will damage the computer and its components.

1. Attach the AC/DC adapter to the DC-in jack at the rear of the computer.
2. Plug the AC power cord into an outlet, and then connect the AC power cord to the AC/DC adapter.
3. Raise the lid/LCD to a comfortable viewing angle.
4. Press the power button to turn “On”.

Battery

The battery allows you to use your computer while you are on the road or when an electrical outlet is unavailable. Battery life varies depending on the applications and the configuration you're using. To increase battery life, let the battery discharge completely before recharging (see “How do I completely discharge the battery?” on page 3 - 14).

We recommend that you do not remove the battery. For more information on the battery, please refer to “Battery Information” on page 3 - 10.
Turning on the Computer

Now you are ready to begin using your computer. To turn it on simply press the power button on the front panel.

When the computer is on, you can use the power button as a Sleep/Hibernate hotkey button when it is pressed for less than 4 seconds (pressing and holding the power button for longer than this will force the computer to shut down). Use Power Options (Hardware and Sound menu) control panel in Windows Vista to configure this feature.

Forced Off

If the system “hangs”, and the Ctrl + Alt + Del key combination doesn’t work, press the power button for 4 seconds, or longer, to force the system to turn itself off.

Power Button Sleep

Sleep is the default power mode when the power button is pressed for less than 4 seconds. You may configure the options for the power button from the Power Options (Hardware and Sound menu) control panel in Windows Vista (see your OS’s documentation, or “Configuring the Power Buttons” on page 3-8 for details).
Power Management

Power Plans

The computer can be configured to conserve power by means of **power plans**. You can use (or modify) an existing **power plan**, or create a new one.

The settings may be adjusted to set the **display** to turn off after a specified time, and to send the computer into **Sleep** after a period of inactivity.

Click **Change plan settings** and then click **Change advanced power settings** to access further configuration options in **Advanced Settings**.

---

**Resuming Operation**

See **Table 3 - 1, on page 3 - 9** for information on how to resume from a power-saving state.

**Password**

It is recommended that you enable a password on system resume in order to protect your data.

---

**Figure 3 - 1**

Power Plan Advanced Settings
Each *Windows power plan* will also adjust the processor performance of your machine in order to save power. This is worth bearing in mind if you are experiencing any reduced performance (especially under DC/battery power).

Choose **High performance** for maximum performance when the computer is powered from an AC power source. Choose the **Power saver** (bear in mind that this scheme may slow down the overall performance of the computer in order to save power) for maximum power saving when the computer is battery (DC power) powered.
You can use power-saving states to stop the computer’s operation and restart where you left off. **Sleep** is the default power-saving state in *Windows Vista*.

Earlier versions of *Windows* used Stand By and Hibernate as system power-saving states. *Windows Vista* combines the features of Stand By and Hibernate into the default **Sleep** power-saving state.

**Sleep**

In **Sleep** all of your work, settings and preferences are saved to memory before the system sleeps. When you are not using your computer for a certain length of time, which you specify in the operating system, it will enter **Sleep** to save power.

The PC wakes from **Sleep within seconds** and will return you to where you last left off (what was on your desktop) without reopening the application(s) and file(s) you last used.

If your mobile PC in **Sleep** is running on battery power the system will use only a minimum amount of power. After an extended period the system will save all the information to the hard disk and shut the computer down before the battery becomes depleted.
Hibernate

Hibernate uses the least amount of power of all the power-saving states and saves all of your information on a part of the hard disk before it turns the system off. If a power failure occurs the system can restore your work from the hard disk; if a power failure occurs when work is saved only to memory, then the work will be lost. Hibernate will also return you to where you last left off within seconds. You should put your mobile PC into Hibernate if you will not use the computer for a period of time, and will not have the chance to charge the battery.

Shut Down

You should shut down the computer if you plan to install new hardware (don’t forget to remove the battery and follow all the safety instructions in Chapter 6), plan to be away from the computer for several days, or you do not need it to wake up and run a scheduled task. Returning to full operation from shut down takes longer than from Sleep or Hibernate.

Hibernate Mode In Windows Vista SP1

If you are using Windows Vista SP1 with 4GB RAM installed, see page 8 - 12 for information on Hibernate.
Configuring the Power Buttons

The power/sleep button (Fn + F4 key combo) and closed lid may be set to send the computer into a power-saving state.

**Password Protection**

It is recommended that you enable a password on wake up in order to protect your data.

However you can disable this setting from the Power Options menu by clicking *Require a password on wakeup* in the left menu, and selecting the options (click *Change settings that are currently unavailable*).

![Power Options Define Power Buttons](image)

*Figure 3-4 Power Options Define Power Buttons*
Resuming Operation
You can resume operation from power-saving states by pressing the power button, or in some cases pressing the sleep button (Fn + F4 key combo).

<table>
<thead>
<tr>
<th>Power Status</th>
<th>Icon</th>
<th>Color</th>
<th>To Resume</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power Off</td>
<td>Off</td>
<td>Press the Power Button</td>
<td></td>
</tr>
<tr>
<td>Sleep</td>
<td>Blinking Green</td>
<td>Press the Power Button</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Press the Sleep Button (Fn + F4 Key Combo)</td>
<td></td>
</tr>
<tr>
<td>Hibernate</td>
<td>Off (battery)</td>
<td>Press the Power Button</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Orange (AC/DC adapter)</td>
<td>Press the Power Button</td>
<td></td>
</tr>
<tr>
<td>Display Turned Off</td>
<td>Green</td>
<td>Press a Key or Move the Mouse/Touchpad</td>
<td></td>
</tr>
</tbody>
</table>

Power Button
When the computer is on, you can use the power button as a Sleep/Hibernate/Shut Down hot key button when it is pressed for less than **4 seconds** (pressing and holding the power button for longer than this will force the computer to shut down).
Battery Information

Please follow these simple guidelines to get the best use out of your battery.

Battery Power

Your computer’s battery power is dependent upon many factors, including the programs you are running, and peripheral devices attached. You can set actions to be taken (e.g. Shut down, Hibernate etc.), and set critical and low battery levels from power plan Advanced Settings (see Figure 3 - 1 on page 3 - 4).

Click the battery icon in the taskbar to see the current battery level and charge status.

Low Battery Warning

When the battery is critically low, immediately connect the AC/DC adapter to the computer or save your work, otherwise, the unsaved data will be lost when the power is depleted.
Conserving Battery Power

• Use a power plan that conserves power (e.g. Power saver), however note that this may have an affect on computer performance.

• Lower the brightness level of the LCD display. The system will decrease LCD brightness slightly to save power when it is not powered by the AC/DC adapter.

• Reduce the amount of time before the display is turned off.

• Close wireless, Bluetooth, modem or communication applications when they are not being used.

• Disconnect/remove any unnecessary external devices e.g. USB devices, ExpressCards etc.

Windows Mobility Center

The Windows Mobility Center control panel provides an easy point of access for information on battery status, power plans used and wireless device status etc.

Figure 3 - 6
Windows Mobility Center
Battery Life

Battery life may be shortened through improper maintenance. To optimize the life and improve its performance, fully discharge and recharge the battery at least once every 30 days.

We recommend that you do not remove the battery yourself. If you do need to remove the battery for any reason (e.g. long term storage) see “Removing the Battery” on page 6 - 3.

New Battery

Always completely discharge, then fully charge, a new battery (see “Battery FAQ” on page 3 - 14 for instructions on how to do this).

Recharging the Battery with the AC/DC Adapter

The battery pack automatically recharges when the AC/DC adapter is attached and plugged into an electrical outlet. If the computer is powered on, and in use, it will take several hours to fully recharge the battery. When the computer is turned off but plugged into an electrical outlet, battery charge time is less. (Refer to “LED Indicators” on page 1 - 9 for information on the battery charge status, and to “Battery Information” on page 3 - 10 for more information on how to maintain and properly recharge the battery pack.)
Power Management

Proper handling of the Battery Pack

• DO NOT disassemble the battery pack under any circumstances
• DO NOT expose the battery to fire or high temperatures, it may explode
• DO NOT connect the metal terminals (+, -) to each other

Caution
Danger of explosion if battery is incorrectly re-
placed.

Replace only with the same or equivalent type recommended by the manufacturer. Discard used battery according to the manufacturer’s in-
structions.

Damaged Battery Warning
Should you notice any physical defects (e.g. the battery is bent out of shape after being dropped), or any unusual smells emanating from the notebook battery, shut your computer down immediately and contact your service center. If the battery has been dropped we do not recommend using it any further, as even if the computer continues to work with a damaged battery in place, it may cause circuit damage, which may possibly result in fire. It is recommended that you replace your computer battery every two years.
Power Management

Battery FAQ
How do I completely discharge the battery?
Use the computer with battery power until it shuts down due to a low battery. Don’t turn off the computer even if a message indicates the battery is critically low, just let the computer use up all of the battery power and shut down on its own.

1. Save and close all files and applications.
2. Create a power plan for discharging the battery and set all the options to Never.
3. Click Change plan settings (after saving it) and click Change advanced power settings.

Figure 3 - 7
Power Plan Create
4. Scroll down to **Battery** and click + to expand the battery options.

5. Choose the options below (click **Yes** if a warning appears):

- Low battery levels = 0%
- Critical battery Levels = 0%
- Low battery action = Do Nothing
- Critical battery action (On battery) = Shut Down
- Critical battery action (Plugged in) = Do Nothing
Power Management

**How do I fully charge the battery?**
When charging the battery, don’t stop until the LED charging indicator light changes from orange to green.

**How do I maintain the battery?**
Completely discharge and charge the battery at least once every 30 days or after about 20 partial discharges.
Chapter 4: Drivers & Utilities

This chapter deals with installing the drivers and utilities essential to the operation or improvement of some of the computer’s subsystems. The system takes advantage of some newer hardware components for which the latest versions of most available operating systems haven’t built in drivers and utilities. Thus, some of the system components won’t be auto-configured with an appropriate driver or utility during operating system installation. Instead, you need to manually install some system-required drivers and utilities.

RAID & AHCI Setup
Note that setting up a RAID, or AHCI mode, needs to be done prior to installing the Windows OS, and therefore before installing the other drivers listed here (see “Setting Up SATA RAID or AHCI Modes” on page 7 - 60).

What to Install
The Device Drivers & Utilities + User’s Manual disc contains the drivers and utilities necessary for the proper operation of the computer.

Table 4 - 1, on page 4 - 3 lists what you need to install and it is very important that the drivers are installed in the order indicated (see “Driver Installation” on page D - 25 for Windows 7 information).

Module Driver Installation
The procedures for installing drivers for the PC Camera, Wireless LAN, Fingerprint, 3.75G/HSPA, TV Tuner (Consumer Infrared) and RAID modules are provided in “Modules & Options” on page 7 - 1.
Driver Installation

Insert the Device Drivers & Utilities + User’s Manual disc and click Install Drivers/Option Drivers (button).

If you wish to install the drivers manually see overleaf for the driver path information.

1. Check the driver installation order from Table 4 - 1, on page 4 - 3 (the drivers must be installed in this order) which is the same as that listed in the Drivers Installer menu below.
2. Click to select the driver you wish to install, after installing each driver it will become grayed out. If you need to reinstall any driver, click the Unlock button (you should uninstall the driver first).
3. Follow the instructions for each individual driver installation procedure as listed on the following pages.
Table 4 - 1 - Driver Installation

**Manual Driver Installation**
Click *Browse CD* (button) in the *Drivers Installer* application and browse to the executable file in the appropriate driver folder.
Drivers & Utilities

Windows Update
After installing all the drivers make sure you enable Windows Update in order to get all the latest security updates etc. (all updates will include the latest hotfixes from Microsoft). See “Windows Update” on page 4 - 7 for instructions.

Updating/Reinstalling Individual Drivers
If you wish to update/reinstall individual drivers it may be necessary to uninstall the original driver. To do this go to the Control Panel in the Windows OS and double-click the Programs and Features icon (Programs > Uninstall a program). Click to select the driver (if it is not listed see below) and click Uninstall, and then follow the on-screen prompts (it may be necessary to restart the computer). Reinstall the driver as outlined in this chapter.

If the driver is not listed in the Programs and Features menu:

1. Click Start, and click Control Panel (or point to Settings and click Control Panel).
2. Double-click Device Manager (Hardware and Sound > Device Manager).
3. Double-click the device you wish to update/reinstall the driver for (you may need to click “+” to expand the selection).
4. Click Driver (tab) and click the Update Driver or Uninstall button and follow the on-screen prompts.

Windows Vista Service Pack 2
Make sure you install Windows Vista Service Pack 2 (or a Windows Vista version which includes Service Pack 2) before installing any drivers. Go to the Microsoft website for download details, or contact your service center.
User Account Control (Win Vista)
If a User Account Control prompt appears as part of the driver installation procedure, click Continue or Allow, and follow the installation procedure as directed.

Windows Security Message
If you receive a Windows security message as part of the driver installation process, Just click “Install this driver software anyway” or “Install” to continue the installation procedure.

You will receive this message in cases where the driver has been released after the version of Windows you are currently using. All the drivers provided will have already received certification for Windows.

New Hardware Found
If you see the message “New Hardware Found” during the installation procedure (other than when outlined in the driver install procedure), click Cancel to close the window, and follow the installation procedure.

Driver Installation General Guidelines
The driver installation procedure outlined in this Chapter (and in Chapter 7 Options & Modules), are accurate at the time of going to press.

Drivers are always subject to upgrade and revision so the exact procedure for certain drivers may differ slightly. As a general guide follow the default on screen instructions for each driver (e.g. Next > Next > Finish) unless you are an advanced user. In many cases a restart is required to install the driver.
Drivers & Utilities

Driver Installation Procedure
Insert the Device Drivers & Utilities + User’s Manual disc and click Install Drivers (button).

Chipset
1. Click 1.Install Chipset Driver > Yes.
2. Click Next > Yes > Next > Next.
3. Click Finish to restart the computer.

Video
1. Click 2.Install Video Driver > Yes.
2. Click Next > Next.
3. Click Finish to restart the computer.

Modem
1. Click 3.Install Modem Driver > Yes.
2. Click OK.
3. The modem is ready for dial-up configuration.

LAN
1. Click 4.Install LAN Driver > Yes.
2. Click Next > Install.
3. Click Finish.
4. The network settings can now be configured.

Firewire (IEEE 1394)
1. Click 5.FireWire drivers > Yes.
2. Click Install.
3. Click Finish.

CardReader
1. Click 6.Install Cardreader Driver > Yes.
2. Click Install.
3. Click Finish.

TouchPad
1. Click 7.Install Touchpad Driver > Yes.
2. Choose the language you prefer and click OK.
3. Click Next > Finish.
4. Click Restart Now to restart the computer.
Hot Key
1. Click 8. Install Hotkey Utility > Yes.
2. Click Next > Install.
3. Click Finish > Finish to restart the computer.

Audio
1. Click 9. Install Audio Driver > Yes.
2. Click Next.
3. Click Finish to restart the computer.

Note that after installing the audio driver the system will not return to the Drivers Installer screen. To install any of the optional drivers listed overleaf, eject the Device Drivers & Utilities + User’s Manual disc and then reinsert it (or double-click the disc icon in My Computer), and click Option Drivers (button) to access the optional driver menu.

Windows Update
After installing all the drivers make sure you enable Windows Update in order to get all the latest security updates etc. (all updates will include the latest hotfixes from Microsoft).

To enable Windows Update make sure you are connected to the internet:
1. Click Start, and click Control Panel (or point to Settings and click Control Panel).
2. Click Check for updates (Security), or double-click Security Center and click Windows Update.
3. Double-click Check for updates (button).
4. The computer will now check for updates (you need to be connected to the internet).
5. Click Install now (button) to install the updates.
Drivers & Utilities

Optional Drivers
See the pages indicated for the driver installation procedures for any modules included in your purchase option.

Figure 4 - 3 - Drivers Installer - Option Drivers Menu

Bluetooth Module
Note: The operating system is the default setting for Bluetooth control in Windows Vista, and does not require a driver. See “Bluetooth Module” on page 7 - 2 for configuration instructions.

PC Camera Module
See the introduction in “PC Camera Module” on page 7 - 7, and check the installation procedure.

Wireless LAN Module
See the introduction in “Wireless LAN Module” on page 7 - 16, and check the installation procedure.

Fingerprint Reader Module
See the introduction in “Fingerprint Reader Module” on page 7 - 34, and check the installation procedure.

3.75G/HSPA Module (Model A Only)
See the introduction in “3.75G/HSPA Module” on page 7 - 39, and check the installation procedure.
TV Tuner Module (Model B Only)
See the introduction in "TV Tuner Module" on page 7 - 57, and check the installation procedure for the Consumer Infrared (CIR) driver.

RAID and AHCI Configuration
(RAID for Model B Only)
See the configuration instructions in "Setting Up SATA RAID or AHCI Modes" on page 7 - 60.
Chapter 5: BIOS Utilities

Overview

This chapter gives a brief introduction to the computer’s built-in software:

Diagnostics: The POST (Power-On Self Test)

Configuration: The Setup utility

If your computer has never been set up, or you are making important changes to the system (e.g. hard disk setup), then you should review this chapter first and note the original settings found in Setup. Even if you are a beginner, keep a record of the settings you find and any changes you make. This information could be useful if your system ever needs servicing.

There is one general rule: Don’t make any changes unless you are sure of what you are doing. Many of the settings are required by the system, and changing them could cause it to become unstable or worse. If you have any doubts, consult your service representative.

BIOS Screens

Note that the BIOS screens pictured on the following pages are intended for guidance in setting up your system’s BIOS.

BIOS versions are subject to constant change and revision, therefore your computer’s actual screens may appear slightly different from those pictured on the following pages.
The Power-On Self Test (POST)

Each time you turn on the computer, the system takes a few seconds to conduct a POST, including a quick test of the on-board RAM (memory).

As the POST proceeds, the computer will tell you if there is anything wrong. If there is a problem that prevents the system from booting, it will display a system summary and prompt you to run Setup.

If there are no problems, the Setup prompt will disappear and the system will load the operating system. Once that starts, you can’t get into Setup without rebooting.
Failing the POST
Errors can be detected during the POST. There are two categories, “fatal” and “non-fatal”.

Fatal Errors
These stop the boot process and usually indicate there is something seriously wrong with your system. Take the computer to your service representative or authorized service center as soon as possible.

Non-Fatal Errors
This kind of error still allows you to boot. You will get a message identifying the problem (make a note of this message!) followed by the prompt:

- Press <F1> to resume
- <F2> to enter Setup

Press F1 to see if the boot process can continue. It may work, without the correct configuration.

Press F2 to run the Setup program and try to correct the problem. If you still get an error message after you change the setting, or if the “cure” seems even worse, call for help.
The Setup Program

The Phoenix Setup program tells the system how to configure itself and manage basic features and subsystems (e.g. port configuration).

Entering Setup

To enter Setup, turn on the computer and press \textbf{F2} during the \textbf{POST}. The prompt (\textit{Press F2 to Enter Setup}) seen on page 5 - 2 is usually present for a few seconds after you turn on the system. If you get a “Keyboard Error”, (usually because you pressed \textbf{F2} too quickly) just press \textbf{F2} again.

If the computer is already on, reboot using the Ctrl + Alt + Delete combination and then hold down \textbf{F2} when prompted. The \textit{Setup} main menu will appear.
Setup Screens

The following pages contain additional advice on portions of the Setup.

Along the top of the screen is a menu bar with menu headings. When you select a heading, a new screen appears. Scroll through the features listed on each screen to make changes to Setup.

Instructions on how to navigate each screen are in the box along the bottom of the screen. If these tools are confusing, press F1 to call up a General Help screen, and then use the arrow keys to scroll up or down the page.

The Item Specific Help on the right side of each screen explains the highlighted item and has useful messages about its options.

If you see an arrow ► next to an item, press Enter to go to a sub-menu on that subject. The sub-menu screen that appears has a similar layout, but the Enter key may execute a command.
### Main Menu

**System Time & Date (Main Menu)**

The hour setting uses the 24-hour system (i.e., ÆÆ = midnight; 13 = 1 pm). If you can change the date and time settings in your operating system, you will also change these settings. Some applications may also alter data files to reflect these changes.

![Main Menu](image)

**System Time:** [04:54:17]
**System Date:** [09/15/2009]

**SATA Port 1**
**SATA Port 2**
**SATA Port 3**

**System Memory:** 628 MB
**Extended Memory:** 2839 MB

**BIOS Revision:**
**FDC/DC Firmware Revision:**

**VGA Card:**
**VBIOS Revision:**
**VBIOS Build Date:**

<table>
<thead>
<tr>
<th>F1</th>
<th>Help</th>
<th>↓↑</th>
<th>Select Item</th>
<th>→/←</th>
<th>Change Values</th>
<th>F9</th>
<th>Setup Defaults</th>
</tr>
</thead>
<tbody>
<tr>
<td>F80</td>
<td>Exit</td>
<td>←→</td>
<td>Select Menu</td>
<td>Enter</td>
<td>Select ↑/↓ Sub-Menu</td>
<td>F10</td>
<td>Save and Exit</td>
</tr>
</tbody>
</table>

Figure 5 - 1
SATA Port 1/2/3/4/5 (Main Menu)
Pressing Enter opens the sub-menu to show the configuration of an HDD/optical device on the computer’s SATA Port 1/2/3/4/5. Use the Auto (Type:) setting to have the items configured automatically for you.

System/Extended Memory (Main Menu)
This item contains information on the system memory, and is not user configurable. The system will auto detect the amount of memory installed.

BIOS Revision/KBC/EC Firmware Revision (Main Menu)
This item contains information on the current BIOS and firmware versions.

VGA Card/VBIOS Revision/VBIOS Build Date (Main Menu)
This item contains information on the current video card installed, and on the Video BIOS version.
Advanced Menu

**Advanced Chipset Control**

The sub-menu here allows you to enable/disable **Extreme Edition** control, if applicable to your system.
**SATA Mode Selection (Advanced Menu)**
You may enable/disable SATA RAID or AHCI mode for your hard disks, however you should only enable/disable RAID or AHCI BEFORE installing an operating system, and after you have backed up all necessary files and data (see sidebar).

**Legacy USB Support (Advanced Menu)**
Choose “Enabled” if you intend to use USB devices in systems which do not normally support USB functionality (e.g. DOS). The default setting is “Enabled” and does not need to be changed if you intend to use your USB devices in Windows.

**Boot-time Diagnostic Screen (Advanced Menu)**
Use this menu item to enable/disable the Boot-time Diagnostic Screen or Power-On Self Test.

**Legacy OS Boot (Advanced Menu)**
Enable this item to support only system boot from the Legacy OS (e.g Windows Vista). If disabled the system will attempt to boot from the EFI (Extensible Firmware Interface) before the Legacy OS.

**Power On Boot Beep (Advanced Menu)**
Use this menu item to enable/disable the beep as the computer starts up.

**Battery Low Alarm Beep (Advanced Menu)**
Use this menu item to enable/disable the battery low alarm beep.
Security Menu

The changes you make here affect the access to the **Setup** utility itself, and also access to your machine as it boots up after you turn it on. These settings do not affect your machine or network passwords which will be set in your software OS.

---

**Set Supervisor Password (Security Menu)**
You can set a password for access to the **PhoenixBIOS Setup Utility**. This will not affect access to the computer OS, (only the **PhoenixBIOS Setup Utility**).

**Set User Password (Security Menu)**
You can set a password for user mode access to the **PhoenixBIOS Setup Utility**. This will not affect access to the computer OS, (only the **Setup** utility) unless you
choose to set a **Password on Boot** (see below). Many menu items in the Phoenix-BIOS Setup Utility cannot be modified in user mode. You can only set the user password after you have set the supervisor password.

*Password on boot (Security Menu)*
Specify whether or not a password should be entered to boot the computer (**you may only set a password on boot if a supervisor password is enabled**). If “Enabled” is selected, only users who enter a correct password can boot the system (**see the warning in the sidebar**). The default setting is “Disabled”.

**Note:** To clear existing passwords press **Enter** and type the existing password, then press **Enter** for the new password (without typing any password entry) and **Enter** again to confirm the password clearance.

**Password Warning**
If you set a boot password (Password on boot is “Enabled”), **NEVER** forget your password. The consequences of this could be serious. If you cannot remember your boot password you must contact your vendor and you may lose all of the information on your hard disk.
When you turn the computer on it will look for an operating system (e.g. *Windows Vista*) from the devices listed in this menu, and **in this priority order**. If it cannot find the operating system on that device, it will try to load it from the next device in the order specified in the **Boot priority order**. Item specific help on the right is available to help you move devices up and down the order.
Choosing to Discard Changes, or Exit Discarding Changes, will wipe out any changes you have made to the Setup. You can also choose to restore the original Setup defaults that will return the Setup to its original state, and erase any previous changes you have made in a previous session.
Chapter 6: Upgrading The Computer

Overview

This chapter contains information on upgrading the computer. Follow the steps outlined to make the desired upgrades. If you have any trouble or problems you can contact your service representative for further help. Before you begin you will need:

- A small crosshead or Phillips screwdriver
- A small regular slotted (flathead) screwdriver
- An antistatic wrist strap

Before working with the internal components you will need to wear an antistatic wrist strap to ground yourself because static electricity may damage the components.

The chapter includes:

- Removing the Battery
- Upgrading the Hard Disk Drive(s)
- Upgrading the Optical (CD/DVD) Device
- Upgrading the System Memory (RAM)

Please make sure that you review each procedure before you perform it.
Upgrading The Computer

**When Not to Upgrade**

These procedures involve opening the system’s case, adding and sometimes replacing parts.

You should **not** perform any of these upgrades if:

- Your system is still under warranty or a service contract
- You don’t have all the necessary equipment
- You’re not in the correct environment
- You doubt your abilities

Under any of these conditions, contact your service representative to purchase or replace the component(s).

**Power Safety Warning**

Before you undertake any upgrade procedures, make sure that you have turned off the power, and disconnected all peripherals and cables (including telephone lines). It is advisable to also remove your battery in order to prevent accidentally turning the machine on.

**Removal Warning**

When removing any cover(s) and screw(s) for the purposes of device upgrade, remember to replace the cover(s) and screw(s) before turning the computer on.

**Upgrading the Processor**

If you want to upgrade your computer by replacing the existing processor with a faster/new one you will need to contact your customer service representative. We recommend that you do not do this yourself, since if it is done incorrectly you may damage the processor or mainboard.
Removing the Battery

If you are confident in undertaking upgrade procedures yourself, for safety reasons it is best to remove the battery.

1. Turn the computer off, and turn it over.
2. Slide the latch 1 in the direction of the arrow.
3. Slide the latch 2 in the direction of the arrow, and hold it in place.
4. Lift the battery out in the direction of the arrow 3.

Warranty Warning
Please check with your service representative before undertaking any upgrade procedures to find out if this will VOID your warranty.

Figure 6 - 1
Battery Removal
Upgrading the Hard Disk Drive(s)

The hard disk drive can be taken out to accommodate other 2.5" serial (SATA) hard disk drives with a height of 9.5mm (h) (see “Storage” on page C - 3). Follow your operating system’s installation instructions, and install all necessary drivers and utilities (see “Driver Installation” on page 4 - 2), when setting up a new hard disk.

Removing the Hard Disk(s) in the Primary HDD Bay
1. Turn off the computer, and turn it over and remove the battery.
2. Remove screws ① - ② from the hard disk cover.
3. Slide the hard disk assembly in the direction of arrow ③.

New HDD’s are blank. Before you begin make sure:
- You have backed up any data you want to keep from your old HDD.
- You have all the CD-ROMs and FDDs required to install your operating system and programs.
- If you have access to the internet, download the latest application and hardware driver updates for the operating system you plan to install. Copy these to a removable medium.

Figure 6 - 2
Hard Disk Bay Cover Removal
4. Lift the hard disk assembly out of the computer in the direction of arrow 4.
5. Remove the screws 5 - 8 and the cover bracket 9.
6. Reverse the process to install a new hard disk drive (do not forget to replace all the screws and covers).

**Figure 6 - 3**
HDD Assembly Removal

**Hard Disk Screws & Cover**

The hard disks and covers pictured here may appear slightly different from your model design (these designs are subject to change and upgrade without notice). Pay careful attention to the screws and cover bracket orientation.
Removing the Hard Disk in the Secondary HDD Bay (Model B Computers Only)
If you want to configure your hard disks in a RAID configuration then install identical drives in the primary (see page 6 - 4) and secondary hard disk bays as per the instructions here. Follow the instructions in “Setting Up SATA RAID or AHCI Modes” on page 7 - 60 for configuration details. Note a RAID configuration is only supported by Model B computers.

1. Turn off the computer, and turn it over and remove the battery.
2. Locate the component bay cover and remove screws 1 - 11.
3. Carefully remove the cover 12.

**Figure 6 - 4**
Component Bay Cover Screws
4. Slide the hard disk assembly in the direction of the arrow 13.
5. Lift the hard disk 14 out of the compartment.
6. Remove screws 15 - 20 to separate the hard disk from the brackets.
7. Reverse the process to install a new hard disk drive (do not forget to replace all the screws and covers).

RAID Hard Disks

All hard disks in a RAID should be identical (the same size and brand) in order to prevent unexpected system behavior.

Hard Disk Screws & Cover

The hard disks and covers pictured here may appear slightly different from your model design (these designs are subject to change and upgrade without notice). Pay careful attention to the screws and cover bracket orientation.
Upgrading The Computer

Upgrading the Optical (CD/DVD) Device

1. Turn off the computer, and turn it over and remove the battery.
2. Locate the component bay cover and remove screws 1 - 9 (Model A) or 1 - 11 (Model B).
3. Carefully remove the cover 12.

Figure 6 - 6
Component Bay Cover Screws

6 - 8 Upgrading the Optical (CD/DVD) Device
4. Remove the screw at point 13, and use a screwdriver to carefully push out the optical device at point 14.
5. Reverse the process to install the new device.
Upgrading the System Memory (RAM)

The computer has two memory sockets for 204 pin Small Outline Dual In-line (SO-DIMM) DDR III (DDR3) type memory modules (see “Memory” on page C - 2 for details of supported module types).

1. Turn off the computer, and turn it over and remove the battery.
2. Locate the component bay cover and remove screws 1 - 9 (Model A) or 1 - 11 (Model B).

Figure 6 - 8
Component Bay Cover Screws
Upgrading The Computer

3. Carefully remove the cover.
4. The RAM is located at point.

Contact Warning

Be careful not to touch the metal pins on the RAM module’s connecting edge. Even the cleanest hands have oils which can attract particles, and degrade the module’s performance.

**Figure 6 - 9**
Component Bay Cover Removed

Upgrading the System Memory (RAM) 6 - 11
Upgrading The Computer

5. Gently pull the two release latches on the sides of the memory socket in the direction indicated by the arrows (14 & 15) in Figure 6 - 10.
6. The RAM module will 16 pop-up, and you can remove it.
7. Pull the latches to release the second module if necessary.
8. Insert a new module holding it at about a 30° angle and fit the connectors firmly into the memory slot.
9. The module’s pin alignment will allow it to only fit one way. Make sure the module is seated as far into the slot as it will go. DO NOT FORCE the module; it should fit without much pressure.
10. Press the module in and down towards the mainboard until the slot levers click into place to secure the module.

Figure 6 - 10
RAM Module Removal

Single Memory Module Installation

If your computer has a single memory module, then insert the module into the Channel 0 (JDIMM1) socket. In this case this is the lower memory socket (the socket closest to the mainboard).
Chapter 7: Modules & Options

Overview

This chapter contains information on the following modules, which may come with your computer, depending on the configuration purchased. If you are unsure please contact your service representative.

- Bluetooth Module
- PC Camera Module
- Wireless LAN Module
- Fingerprint Reader Module
- 3.75G/HSPA Module
- TV Tuner Module
- Setting Up SATA RAID or AHCI Modes

Important Notice

For important notices related to the modules, please refer to the module-specific sections.

Wireless Device Operation Aboard Aircraft

The use of any portable electronic transmission devices aboard aircraft is usually prohibited. Make sure the module(s) are OFF if you are using the computer aboard aircraft.

Important Notice

If your purchase option includes both Wireless LAN and 3.75G/HSPA modules, then the appropriate antennas will be installed. Note that in order to comply with FCC RF exposure compliance requirements, the antenna must not be co-located or operate in conjunction with any other antenna or transmitter.
Bluetooth Module

The operating system’s Bluetooth Devices control panel is used to configure the Bluetooth settings in Windows Vista, and therefore does not require a driver. Use the **Fn + F12** key combination (see “Function/Hot Key Indicators” on page 1-12) to toggle power to the Bluetooth module. When the Bluetooth module is powered on, the LED will be illuminated and the on-screen indicator will briefly be displayed.

### Bluetooth Data Transfer

Note that the transfer of data between the computer and a Bluetooth enabled device is supported in one direction only (simultaneous data transfer is not supported). Therefore if you are copying a file from your computer to a Bluetooth enabled device, you will not be able to copy a file from the Bluetooth enabled device to your computer until the file transfer process from the computer has been completed.

### Bluetooth Module & Resuming From Sleep Mode

The Bluetooth module’s default state will be off after resuming from the Sleep power-saving state. Use the key combination (**Fn + F12**) to power on the Bluetooth module after the computer resumes from Sleep.
Bluetooth Configuration in Windows Vista

Setup your Bluetooth Device so the Computer Can Find it
1. Turn your Bluetooth device (e.g. PDA, mobile phone etc.) on.
2. Make the device discoverable (to do this check your device documentation).

To Turn the Bluetooth Module On
1. Press the **Fn + F12** key combination to power on the Bluetooth module.
2. A Bluetooth icon will appear in the taskbar (see sidebar).
3. You can then do any of the following to access the **Bluetooth Devices** control panel.
   - **Double-click** the icon to access the **Bluetooth Devices** control panel.
   - **Click Start**, and click **Control Panel** (or point to **Settings** and click **Control Panel**), and then click **Bluetooth Devices** (Hardware and Sound).
   - **Click/Right-click** the icon and choose an option from the menu.

If you cannot see the Bluetooth icon in the taskbar, access the **Bluetooth Devices** control panel. **Click Bluetooth Settings > Options**, and make sure that **Show the Bluetooth icon in the notification area** check box (Connections) has a tick inside it.

Note that you will need to check the LED indicator to see if the module is powered on or not.

Figure 7 - 1
Bluetooth Devices & Click Icon Menu
To Add a Bluetooth Device
1. Access the **Bluetooth Devices** control panel and click **Bluetooth Settings**.
2. Click **Options** (tab), and make sure that **Allow Bluetooth devices to connect to this computer** check box (**Connections**) has a tick inside it, and click **OK**.
3. Click **Add Wireless Device** in the **Bluetooth Devices** control panel.
4. Double-click the device you want to pair with the computer.

5. On first connection the computer will provide you with a pairing code to be entered onto the device.

**Pairing Options**
If a device has been previously connected then the pairing option menu will appear when you attempt subsequent connections. You can choose to have the computer create a pairing code for you, use the device’s existing pairing code or you can pair certain devices without using a code.

**Figure 7 - 2**
Pair with a wireless device
6. Enter the code into your Bluetooth enabled device and follow any on-screen instructions to complete the pairing.

7. Windows will check to see if any drivers are required to complete the pairing.
8. Follow any on-screen instructions on the computer if device drivers are required to be installed.
9. Click Close.

**Pairing Codes**
The example outlined here shows a connection to a mobile device. Other devices e.g. computers, may have a slightly different connection procedure, and may require you to confirm a pairing code is correct on both devices. Follow the on-screen instructions to complete the pairing.
To Change Settings for the Bluetooth Device
1. Access the Bluetooth Devices control panel.
2. Click on the device you want to change and click Properties to:
   • Change the name of the device (click General, type a new name and click OK).
   • Enable/Disable a service (click Services, clear/tick the check box next to the service and click OK).

To Make your Computer Discoverable to Bluetooth Devices
1. Access the Bluetooth Devices control panel.
2. Click Bluetooth Settings > Options, and make sure that Allow Bluetooth devices to find this computer check box (Discovery) has a tick inside it.
3. Make sure that the Alert me when a new Bluetooth device wants to connect check box (Connections) has a tick inside it, if you want to be notified when a Bluetooth device wants to connect.

Figure 7-5
Bluetooth Settings - Options
PC Camera Module

If you have included a PC Camera module in your purchase option, make sure that the PC Camera module is on before installing the driver. Use the Fn + F10 key combination (see “Function/Hot Key Indicators” on page 1 - 12) to toggle power to the PC Camera module. When the PC Camera module is powered on, the on-screen indicator will briefly be displayed. Make sure you install the drivers in the order indicated in Table 4 - 1, on page 4 - 3.

There are a number of different camera modules available with this computer model series. You will have the appropriate application installed for your camera. Make sure you access the application via the WebCam desktop shortcut.

Latest PC Camera Driver Information

Check the Device Drivers & Utilities + User’s Manual disc, and any accompanying insert pages, for the latest updated information on the PC Camera driver, which may override the information provided here.
PC Camera Driver Installation

1. Make sure the module is powered on, then insert the Device Drivers & Utilities + User’s Manual disc into the CD/DVD drive.
2. Click Option Drivers (button).
3. Click 1.PC Camera, Web cam > Yes.
4. Choose the language you prefer and click Next > Next.
5. Click Finish to restart the computer.
6. Run the camera application program from the shortcut on the desktop (if the hardware is turned off use the Fn + F10 key combination to turn it on again).

PC Camera Screen Refresh

If you find that the screen refresh rate is subject to lag or stuttering, then reduce the window size, or adjust the Output Size and/or Color Space Compression.

To reduce Output Size and/or Color Space Compression run the camera application, click Options and select Video Capture Pin. Adjust the settings from the appropriate pull-down menu.
PC Camera Audio Setup
If you wish to capture video & audio with your camera, it is necessary to setup the audio recording options in *Windows*.

1. Click **Start**, and click **Control Panel** (or point to **Settings** and click **Control Panel**).
2. Double-click **Sound** (Hardware and Sound).
3. Click **Recording** (tab).
4. Right-click **Microphone** (Realtek High Definition Audio) and make sure the item is not disabled.
5. Double-click **Microphone** (or select **Properties** from the right-click menu).
6. Click **Levels** (tab), and adjust the **Microphone** and **Microphone Boost** sliders to the level required.
7. Click **OK** and close the control panels.
8. Run the camera application program from the desktop shortcut.
9. Go to the **Devices** menu heading and select **Microphone** (Realtek....) (it should have a tick alongside it).
10. Go to the **Capture** menu heading and select **Capture Audio** (it should have a tick alongside it).
Figure 7 - 6
Audio Setup for PC Camera

Right-click
Camera Application

The WebCam application is a video viewer for general purpose video viewing and testing, and for capturing video files to .avi format.

1. Run the camera application from the desktop shortcut (it is recommended that you set the capture file before the capture process - see “Set Capture File” on page 7 - 12).

2. Go to the Capture menu heading (if you wish to capture audio check “PC Camera Audio Setup” on page 7 - 9) and select Start Capture.

3. Click OK/Yes (the file location will be displayed in the pop-up box) to start capturing the video, and press Esc to stop the capture (you can view the file using the Windows Media Player).

Pre-Allocating File Size/Space

You may pre-allocate the file size (File > Allocate File Size/Space) for the capture file in the camera program (you may need to set a folder location first).

Pre-allocating space on the hard disk can improve the capture quality (particularly of large capture files), by reducing the amount of work the hard disk has to do in finding space for the video data as it is being captured.

See also “Reducing Video File Size” on page 7 - 13.
Set Capture File
Prior to capturing video files you may select the Set Capture File... option in the File menu, and set the file name and location before capture (this will help avoid accidentally overwriting files). Set the name and location then click Open, then set the "Capture file size:" and click OK. You can then start the capture process as on the previous page.

Note the important information in “Reducing Video File Size” on page 7 - 13 in order to save file space, and help prevent system problems.
Reducing Video File Size
Note that capturing high resolution video files requires a substantial amount of disk space for each file. After recording video, check the video file size (right-click the file and select Properties) and the remaining free space on your hard disk (go to My Computer, right-click the hard disk, and select Properties). If necessary you can remove the recorded video file to a removable medium e.g. CD, DVD or USB Flash drive.

Note that the Windows Vista system requires a minimum of 15GB of free space on the C: drive system partition. In order to prevent system problems it is recommended that you save the captured video file to a location other than the C: drive (see “Set Capture File” on page 7 - 12), limit the file size of the captured video (see “Pre-Allocating File Size/Space” on page 7 - 11) or reduce video resolution (see below).

To Reduce Video Resolution Output Size:
1. Run the camera application program from the desktop shortcut.
2. Go to Options and scroll down to select Video Capture Pin....
3. Click the Output Size drop box and select a lower resolution size in order to reduce the captured file size.
4. Click OK.
Eliminating Screen Flicker
If you find that the video screen in the camera program is flickering, you can try to adjust the setting in the **Video Capture Filter** options.

1. Run the camera program from the desktop shortcut.
2. Go to **Options** and scroll down to select **Video Capture Filter**.
3. Click either **50Hz** or **60Hz** under **Frequency** in **Property Page** (tab).

*Figure 7-7 Video Capture Filter*
Zoom
The WebCam program allows you to zoom the camera in and out.

1. Run the camera application from the desktop shortcut.
2. Go to Zoom and select Zoom Out/Zoom In.

Taking Still Pictures
The WebCam program allows you to take still pictures.

1. Run the camera application from the desktop shortcut.
2. Go to Options and select Take Picture.
3. The picture (in JPEG format) will be placed in the Snapshot folder on the desktop.
Wireless LAN Module

If you have included an Intel® Wi-Fi Link 5300 Series or 3rd Party 802.11b/g/n WLAN module in your purchase option, make sure that the Wireless LAN module is on before installing the driver.

Use the Fn + F11 key combination (see “Function/Hot Key Indicators” on page 1-12) to toggle power to the Wireless LAN module. When the WLAN module is powered on, the LED will be illuminated and the on-screen will briefly be displayed. Make sure you install the drivers in the order indicated in Table 4-1, on page 4-3.

The standard driver installation procedure for the Intel® Wi-Fi Link series module is outlined overleaf. If you want to include Intel® My WiFi Technology as part of the installation procedure, DO NOT install the driver as per the instructions overleaf, instead see “Intel® My WiFi Installation & Configuration” on page 7-21.

If you have installed the standard driver (as per the instructions overleaf) and wish to enable Intel® My WiFi Technology at a later point you will need to reinstall the driver (choose Unlock from the Drivers Installer menu). Follow the driver installation procedure and choose Modify from the menu when the option appears, and then follow the remaining installation instructions in “Intel® My WiFi Installation & Configuration” on page 7-21.
Intel® Wi-Fi Link Series Driver Installation
If you see the message “Found New Hardware” click Cancel to close the window.
1. Make sure the module is powered on, then insert the Device Drivers & Utilities + User’s Manual disc into the CD/DVD drive.
2. Click Option Drivers (button).
3. Click 2.Wireless Lan > Yes.
4. Click Next > Next.
5. Click the button to accept the license and click Next.
6. Click Next > Next > Finish.

3rd Party 802.11b/g/n Driver Installation
1. Make sure the module is powered on, then insert the Device Drivers & Utilities + User’s Manual disc into the CD/DVD drive.
2. Click Option Drivers (button).
3. Click 2.Wireless Lan > Yes.
4. Choose the language you prefer and click Next.
5. Click Next > Install.
6. Click Finish.

Note: The operating system is the default setting for Wireless LAN control in Windows Vista (see overleaf).
Connecting to a Wireless Network

Make sure the Wireless LAN module is turned on.

1. **Click** the taskbar wireless icon and then click **Connect to a network** (or right-click the icon and then click **Connect to a network**).

2. In the **Show** list, click to choose **Wireless** from the drop-down menu.

3. A list of currently available networks will appear.
4. Click a network, and then click **Connect**.
5. If you do not see a network you want to connect to, click **Set up a connection or network** (a list of options will appear allowing manual searching, and creating a new network).

6. Move the cursor over the taskbar icon to see the connection status (see below).

---

**Figure 7 - 11**
Connecting

**Figure 7 - 12**
Connection Status
7. To disconnect from the wireless network you can click the taskbar wireless icon, and then select **Connect or disconnect** to access the network menu, and click **Disconnect** (or right-click the icon, and then click **Disconnect from**).

**Security Enabled Networks**

You should try to make sure that any network you are connecting to is a secure network.

Connecting to unsecure networks may allow unauthorized access to your computer, documents, websites and files etc.

**Figure 7 - 13**

Disconnecting
Intel® My WiFi Installation & Configuration

Intel® My WiFi Technology uses your WLAN module to allow you to connect up to eight other WiFi enabled devices (e.g. digital cameras, other computers, cell phones, handheld devices etc.) to your computer (similar to Bluetooth), while still connecting to the Internet through your WiFi wireless connection. Intel® My WiFi Technology offers greater range and speed than other personal area networks, and does not require an access point.

Intel® My WiFi Help

To get help on Intel® My WiFi configuration and settings, access the Intel® My WiFi Utility from the Start menu (Start > Programs/All Programs > Intel PROSet Wireless > Intel My WiFi Technology), or by clicking the taskbar icon. Click the Help icon and select a help topic from the Contents menu.
Intel® Wi-Fi Link Series My WiFi Driver Installation

If you see the message “Found New Hardware” click Cancel to close the window.

1. Make sure the module is powered on, then insert the Device Drivers & Utilities + User’s Manual disc into the CD/DVD drive.
2. Click Option Drivers (button).
3. Click 1. Install Wireless Lan Driver > Yes.
4. Click Next > Next.
5. Click the button to accept the license and click Next > Next.
6. Click Custom (button) and click Next.
7. Click Intel(R) My WiFi Technology (button) and select “This feature will be installed on local hard drive.”

8. Click Next > Finish.

Figure 7 - 14
Intel(R) PRO Set
Intel(R) My WiFi Technology Installation
Intel® My WiFi Configuration
You can configure the My WiFi settings as follows.

1. Access the Intel® My WiFi Utility from the Start menu (Start > Programs/All Programs > Intel PROSet Wireless > Intel My WiFi Technology), or by clicking the taskbar icon.
2. Click Enable (on the first run of the program there will be no connected devices listed).
3. Click **Start**, and click **Control Panel** (or point to **Settings** and click **Control Panel**).
4. Click **Network and Sharing Center** (Network and Internet).
5. Click **Manage Network Connections**.

6. Right-click **Intel My WiFi STA** (Station) in **Network Connections** and select **Properties**.

**Figure 7 - 16**
Network and Sharing Center

**Figure 7 - 17**
Intel My WiFi STA Properties (Network Connections)
7. Click **Sharing (tab)** and select **“Allow other network users to connect through this computer’s Internet connection”**.
8. Select **Intel My WiFi PAN** under **Home Networking Connection**.
9. Click **OK**.

Figure 7 - 18
Intel WiFi STA Properties - Sharing
10. A message will appear to inform you that the LAN adapter will be set to use the IP address 192.168.0.1.

11. Click Yes to enable Internet Connection Sharing.

12. Access the Intel® My WiFi Utility from the Start menu (Start > Programs/All Programs > Intel PROSet Wireless > Intel My WiFi Technology), or by clicking the taskbar icon.

13. Click Profiles.
14. Click **Profiles**, click **Intel Wireless PAN** and click **Edit**.

![Figure 7 - 21](image)

**IP Address Warning**

15. You can change the **Profile Name** and **Network Name** to your personal preferences in **General** (tab).

**Profile and Network Names**

The **Profile Name** is the name as displayed on your computer in the **Network Connections** control panel (see **Figure 7 - 17 on page 7 - 24**).

The **Network Name** (SSID) is the name the devices see when they try to connect to your computer.
16. Click **Security** (tab).
17. Change the **Security Type** to **WEP** and the **Encryption Type** to **64bit**.
18. Enter a password (5 characters long) in the **Passphrase** box.
19. Click **OK**.

*Figure 7 - 23*
Intel® My WiFi
Profile Settings - Security
20. Click **Sharing** (tab).
21. Make sure **Filter Network Traffic** and **DHCP and DNS Server** are **Disabled**.
22. Click **OK**.

*Figure 7 - 24*
Intel® My WiFi Profile Settings - Sharing

Set **Filter Network Traffic & DHCP and DNS Servers** to **Disabled**.
23. Click **Advanced** (tab).
24. Make sure the **Default Channel** is set to **Channel 1, 6 or 11**.
25. Click **OK**.

*Figure 7 - 25
Intel® My WiFi
Profile Settings - Advanced*
26. Double-click **Intel My WiFi PAN** (Personal Area Network) in **Network Connections**.
27. Click **Details** to display the **Network Connection Details**.

---

**Figure 7 - 26**

Intel My WiFi PAN
Network Connection Details
(Network Connections)
28. Access the Intel® My WiFi Utility from the Start menu (Start > Programs/All Programs > Intel PROSet Wireless > Intel My WiFi Technology), or by clicking the taskbar icon.

29. To add a new device follow the instructions in the devices’ user guide for connecting to a WiFi network.

30. Click Add New Device in Intel® My WiFi Utility to confirm the security settings detail.
Windows Mobility Center
The Windows Mobility Center control panel provides an easy point of access for information on battery status, power plans used and wireless device status etc.

To access the Windows Mobility Center:
1. Click Start, and click Control Panel (or point to Settings and click Control Panel).
2. Double-click Windows Mobility Center (Mobile PC).
3. Click the button to Turn wireless off/on, or click the icon to access the network menu.
Modules & Options

Fingerprint Reader Module

The optional fingerprint reader provides a high level of security for your computer. A further level of security and control is provided in the BIOS (see “Security Menu” on page 5-11).

The fingerprint reader allows you to:

- Access or Lock your computer
- Protect sensitive files
- Display and file your favorite web pages
- Fill in frequently used dialogs
- Run your favorite applications

Install the driver as instructed below and configure the reader as outlined on the following pages.

Fingerprint Reader Driver Installation

1. Insert the Device Drivers & Utilities + User's Manual disc and click Option Drivers (button). Click Unlock (button) and then click 3.FingerPrint > Yes.
2. Click Software Installation.
3. Click Next > Next > Next.
4. Click Finish > Yes to restart the computer.

Password Warning

If you set passwords for any of the security modules, NEVER forget your password. The consequences of this could be serious. If you cannot remember your boot password you must contact your vendor and you may lose all of the information on your hard disk.
User Enrollment
1. Click Start > Programs/All Programs > Protector Suite > Control Center, or double click the taskbar icon (click Initialize).
2. On the first run of the program you will be asked to click the Accept button to accept the license.
3. If you have not set a Windows password you will be prompted to do so (note: If you have not set a password Protector Suite cannot secure access to your computer).
4. Click Submit when you have entered password.
5. You will then be prompted to enroll your fingerprints (you can click Tutorial to get help with fingerprint enrollment at any time).

Fingerprint Enrollment
Note that it is strongly recommended that you enroll more than one finger in case of injury etc.

Figure 7 - 29
Fingerprint Enrollment
6. Click the button above any of the fingers to begin the enrollment process for that finger.
7. Swipe the finger until the progress bar reaches 100% to enroll that finger.
8. Repeat the process for all the fingers you wish to enroll (see sidebar), and then click **Save and Continue**.
9. Enter a backup password and click **Apply**.
10. Close the fingerprint status window.

Figure 7 - 30
Fingerprint Status
11. Right-click the taskbar icon and select Start Control Center (and then swipe a finger) to allow you to Edit Fingerprints, register Applications, edit Settings and access the Help menu etc. You can also run the Control Center etc. from the Protector Suite item in the Programs/All Programs menu.

12. Click “Help” in Control Center Home to get more information on any topic.

13. You can also run the Tutorial, or Product Tour video to get more information.


15. If you swipe your finger over the reader at any time you can access the Biomenu to lock the computer, register websites, access the Personal Safe, E-Wallet or Strong Password Generator, open the Control Center and access the Help menu.
Fingerprint Control Center Features

Application Launcher
The Application Launcher allows you to register applications to be launched when assigned to a particular finger. Simply copy the application icon on to one of the registered fingers and ten click OK to close the application window. Once registered the application will launch when you swipe the appropriate finger across the sensor.

Password Bank
The Password Bank stores registrations of user names, passwords and other settings for web sites etc.

Strong Password Generator
Strong Password Generator helps you to create complicated passwords resistant to dictionary attacks from the Internet.

E-Wallet
The E-Wallet provides biometric security for important personal information such as credit card details, account numbers etc.

File Safe
File Safe is an encrypted area assigned on your hard drive that allows you to store files and folders to be protected by fingerprint protection.
**3.75G/HSPA Module**

(Optional for Model A Computers Only)

If you have included an **optional 3.75G/HSPA** (High Speed Packet Access) module (see “Communication” on page C - 4 for specification details) in your purchase option, you will have the appropriate application (**HSPA Modem Interface** or **Mobile Partner**) provided for your module. Follow the instructions **on page 7 - 41** to install the USIM card (supplied by your service provider), and then install the application (see over for further details).

---

**Important Notice - 3.75G/HSPA & Bluetooth/Wireless LAN Modules**

In order to comply with FCC regulations you should NOT operate the 3.75G/HSPA module and the Bluetooth/Wireless LAN modules at the same time as this may disrupt radio frequency, and cause interference. When the 3.75G/HSPA module is powered on, make sure that the Bluetooth/Wireless LAN modules are powered off.

---

3.75G/HSPA Module Options

There are **two optional 3.75G/HSPA modules** available for this series of computer models. Each module is supplied with the appropriate application software.

The module type supplied may depend upon the computer model purchased. Check with your service center for details.

Install the driver from the Drivers Installer menu and check the instructions for the appropriate application on the following pages.
Before installing the application, make sure that the 3.75G/HSPA module is ON (installing the driver with the module off will not allow the software to detect the module hardware correctly). Use the **Fn + key combination** (see “Function/Hot Key Indicators” on page 1 - 12) to toggle power to the 3.75G/HSPA module. When the 3.75G/HSPA module is powered on, the on-screen indicator will briefly be displayed. Make sure you install the drivers in the order indicated in Table 4 - 1, on page 4 - 3. Note that exiting the application does NOT turn off the 3.75G/HSPA module.

- **HSPA Modem Interface** - See “HSPA Modem Interface Installation” on page 7 - 43 for driver installation information and “HSPA Modem Interface” on page 7 - 44 for instructions on using the HSPA Modem Interface.

- **Mobile Partner** - See “Mobile Partner Application Installation” on page 7 - 52 for driver installation information and “Mobile Partner Application” on page 7 - 53 for instructions on using the Mobile Partner application.
USIM Card Installation
1. Turn off the computer, and turn it over and remove the battery (see “Removing the Battery” on page 6 - 3).
2. The SIMLOCK is located in the compartment under the battery.
3. Remove screw 1 from the SIMLOCK cover, and remove the cover.
4. Insert the USIM card as you would into your mobile phone.

Power Safety Warning
Before you undertake any installation procedures, make sure that you have turned off the power, and disconnected all peripherals and cables (including telephone lines). It is advisable to also remove your battery in order to prevent accidentally turning the machine on.

Figure 7 - 32
Battery & SIMLOCK Cover Removal
5. Slide the SIMLOCK towards the hinge (in the direction of the arrow illustrated in Figure 7-33) in order to release the lock and lift it up.
6. Insert the USIM card as illustrated in (Figure 7-34) and close the SIMLOCK.

Figure 7-33
Unlock the SIMLOCK

7. Lock the SIMLOCK by pushing it in the direction of the arrow in Figure 7-34 until it clicks into the lock position.

Figure 7-34
SIMLOCK Lock

8. Replace the cover, screw and battery.

7 - 42 3.75G/HSPA Module
HSPA Modem Interface

With the 3.75G/HSPA module and USIM card (supplied by your service provider) installed you may then install the HSPA Modem Interface. The HSPA Modem Interface allows you to directly access your HSPA internet service from the computer.

HSPA Modem Interface Installation

1. Enable power to the module by pressing the Fn + key combination (the on-screen indicator will indicate the module’s power status). If a Found New Hardware window appears, click Cancel in all windows that appear, and then proceed to install the driver as below.
2. Click Option Drivers (button).
3. Click 4.3.5 Generation Module > Yes.
4. Click Next > Install.
5. Click Finish to restart the computer.
6. Access the HSPA Modem Interface from the Start menu (Start > Programs/All Programs > HSPA modem), or by double-clicking the HSPA modem icon on the desktop.
HSPA Modem Interface
The connection information is stored on the USIM card supplied by the service provider.

1. Power on the **3.75G/HSPA module** using the **Fn + ↓** key combination.
2. Access the **HSPA Modem Interface** from the **Start** menu (**Start > Programs/All Programs > HSPA Modem > HSPA Modem**), or by double-clicking the desktop icon.
3. If a USIM card is not installed then a message will appear to notify you of this (click **OK** to close the message and install the USIM card).
4. If you are required to enter a pin # then a message will appear to prompt you to enter a pin #. (**Note**: to change pin # go to **Settings** and click **OK** in **PIN code**.)
5. Click the **Network connection** button and the **HSPA Modem** interface window will display **Connection Manager**.

---

**Figure 7 - 35**
HSPA Modem Interface Window

**Connection Manager**
The connection information is commonly stored on the USIM card supplied by the service provider. However if your service provider requires details such as **IP Address**, **Username** and **Password** etc. to be entered before connection you can enter them in the **Connection Manager** tab, or save the details in **Profiles**.
6. Click Connect to connect to your service provider.

7. The message “Network is connected” will be displayed when the network connection is successful.

8. You can then access the internet, download e-mail etc. as per any internet connection.
9. While you are connected the upper right corner of the **HSPA Modem** interface will display the upload and download rates, and the taskbar icon will display the connection speed.

10. To disconnect click the **Disconnect** icon (**Connection Manager**).

11. The program will disconnect from the service provider.

12. The module will still be on, and you will need to press the **Fn +** key combination to turn it off.

**Adding a Profile**

1. Access the **HSPA Modem Interface** from the **Start** menu (**Start > Programs/All Programs > HSPA Modem > HSPA Modem**), or by clicking the desktop icon.

2. Click the **Network connection** , and click **Profiles** (tab).
3. Click **Add** (button) and input any **Network Settings** required by your service provider.

4. Click **OK** to save the profile.

5. You can **Edit** or **Delete** profiles from the **Profiles** tab.

6. To use a profile click to select it, and then click **Apply** (button) and the settings will be transferred to **Connection Manager**.
Contacts

1. Access the HSPA Modem Interface from the Start menu (Start > Programs/All Programs > HSPA Modem > HSPA Modem), or by clicking the desktop icon.
2. Click Contacts (button).
3. Click Refresh (button) to download the contacts from the USIM card to the computer.
4. The Contacts will then be displayed.
5. Double-click any contact to edit the information (or right-click and select Edit).
6. You can also Export/Import contacts by clicking the appropriate button.

Figure 7 - 41
Network Settings & Profiles
Messages

1. Access the HSPA Modem Interface from the Start menu (Start > Programs/All Programs > HSPA Modem > HSPA Modem), or by clicking the desktop icon.
2. Click Messages (button).
3. Click Refresh (button) to download the messages from the USIM card to the computer.
4. Click New (button) to create a new message.
5. You can either type the telephone number in the recipient field, or press To (button) to select the contact from the list.

SMS Service

In addition to standard internet services you may also send and receive SMS text messages using the HSPA Modem Interface, if your service supports SMS.
6. Click to select a contact from the list and then click **Add** (button) and the phone number will automatically be added to the recipient field.

7. Type the message information into the message body and click **Send** (button) to send it, or **Save to draft** (button) to save the message.

8. Select any message to **forward** or **delete** it, or to **reply** to it.

**Settings**

1. Access the **HSPA Modem Interface** from the **Start** menu (**Start > Programs/All Programs > HSPA Modem > HSPA Modem**), or by clicking the desktop icon.

2. Click **Settings** (button).

---

*Figure 7 - 43 Settings*
3. Click OK alongside any of the options to configure the settings.
4. The Network can be configured for an Automatic (usually from the USIM card) or Manual connection.
5. The Network Mode can be configured for any appropriate mode required.

6. You can also change your settings for the Pin #, and input your phone number.
7. Exiting the program DOES NOT turn off the 3.75G/HSPA module, and you will need to press the Fn + key combination to turn off the module (pay careful attention to this aboard aircraft - see “Wireless Device Operation Aboard Aircraft” on page 7 - 16).
8. If the module is on and the computer enters a power-saving state, then the power status of the module on resuming from the power-saving state will be as below:

   • If the 3.75G/HSPA module is on and the computer is Shut Down or Restarted; the module will be off when the computer starts up.
   • If the 3.75G/HSPA module is on and the computer enters Sleep or Hibernate; the module will be off when the computer resumes from sleep.
Mobile Partner

With the 3.75G/HSPA module and USIM card (supplied by your service provider) installed you may then install the Mobile Partner application. The Mobile Partner application allows you to directly access your HSPA internet service from the computer.

Mobile Partner Application Installation

1. Enable power to the module by pressing the Fn + key combination (the on-screen indicator will indicate the module’s power status). If a Found New Hardware window appears, click Cancel in all windows that appear, and then proceed to install the driver as below. Insert the Device Drivers & Utilities + User’s Manual disc into the CD/DVD drive.
2. Click Option Drivers (button).
3. Click 4.3.5 Generation Module > Yes.
4. Choose the language you prefer and click OK.
5. Click I Agree (button) to accept the license agreement.
6. Click Next > Install.
7. Click Finish to restart the computer.
8. Access the Mobile Partner application from the Start menu (Start > Programs/All Programs > Mobile Partner), or by double-clicking the Mobile Partner icon on the desktop.
Mobile Partner Application
You will need to contact your service provider to obtain the exact details of how exactly to configure the settings on this page.

Profile Management
1. Power on the 3.75G/HSPA module using the **Fn + Power Key** key combination.
2. Access the Mobile Partner application from the Start menu (Start > Programs/All Programs > Mobile Partner), or by double-clicking the Mobile Partner icon on the desktop.
3. If you have not created a profile, click Tools and select Options, and then click Profile Management.
4. Click New and input the appropriate information for Profile Name, APN and Authentication etc. as supplied by your service provider.
5. Click Save to save the profile.

Mobile Partner Help
To get help on Mobile Partner configuration and settings, click the Help menu and select Online Help or press F1.

Figure 7 - 45
Profile Management
Connecting to the Service Provider

1. Power on the 3.75G/HSPA module using the _Fn + 🍊_ key combination.
2. Access the Mobile Partner application from the Start menu (Start > Programs/All Programs > Mobile Partner), or by double-clicking the Mobile Partner icon on the desktop.
3. The software will run and you can select the Profile Name from the menu.
4. Click Connect to begin the connection process.
5. The Mobile Partner application will then display the connection information.

---

**Figure 7 - 46**
Connect

**Figure 7 - 47**
Network Connection Prompt
6. When the connection is successful you can move the cursor over the network icon in the taskbar to display the connection information.

![Network Icon](image1)

7. You can then access the internet, download e-mail etc. as per any internet connection.

8. While you are connected the indicators in the Mobile Partner window will display uploading and downloading icons and a network icon in the taskbar.

![Mobile Partner Window](image2)

9. To disconnect click the Disconnect icon, or right click the taskbar icon and select Disconnect.

![Disconnect Icon](image3)

10. The program will disconnect from the service provider.
11. The module will still be on, and you will need to press the **Fn + \[Esc\]** key combination to turn it off.

12. If you click the **Mobile Partner** close icon \[X\] a message will be displayed asking you to click **OK** to confirm the program exit and to **terminate the connection**.

13. Exiting the program terminates the connection, but DOES NOT turn off the 3.75G/HSPA module, and you will need to press the **Fn + \[Esc\]** key combination to turn off the module (pay careful attention to this aboard aircraft - see “**Wireless Device Operation Aboard Aircraft**” on page 7 - 52).

14. If the module is on and the computer enters a power-saving state, then the power status of the module on resuming from the power-saving state will be as below:

- If the 3.75G/HSPA module is on and the computer is **Shut Down or Restarted**; the module will be **off** when the computer starts up.
- If the 3.75G/HSPA module is on and the computer enters **Sleep or Hibernate**; the module will be **off** when the computer resumes from sleep.
TV Tuner Module

(Optional for Model B Computers Only)
If your purchase configuration includes the optional Hybrid (Analog & Digital) USB Mini-Card TV Tuner module, you will be supplied with a remote control unit and appropriate antenna and fittings for the module. Software support for the TV Tuner module is provided by Windows Media Center in Windows Vista (Home Premium Edition & Ultimate Edition) and in Windows 7 (not included in Starter or Home Basic versions). In addition a driver is provided on the Device Drivers & Utilities + User’s Manual disc for the remote control supplied with the TV Tuner.

The optional TV Tuner allows you to watch TV, play music CDs, video conference and capture still images and video on your PC.

The Cable (CATV) antenna will only be enabled when a TV Tuner module is installed. Make sure you connect the TV antenna.

![TV Tuner Ports/Jacks]

- Consumer Infra-red Transceiver
- CATV Antenna Jack
Consumer Infrared Driver
1. Insert the *Device Drivers & Utilities + User’s Manual* disc into the CD/DVD drive.
2. Click *Option Drivers* (button).
3. Click *5.Install CIR Driver > Yes*.
4. Choose the language you prefer and click *Next > Next*.
5. Click *Finish* to restart the computer.

Windows Media Center
1. This TV Tuner module is fully supported by *Windows Media Center* in *Windows Vista (Home Premium Edition & Ultimate Edition)*.
2. Run *Windows Media Center* directly from the *Start* menu (*Start > Programs > Windows Media Center*).
3. *Windows Help and Support* provides information on the *Windows Media Center* functions. Click *Start* and select *Help and Support*, and then type “*Media Center*” in the *Search Help* box and click the magnifying glass icon to bring up the results.
Digital TV Broadcast Signal
The antenna is the most crucial factor in receiving a clear digital terrestrial TV broadcast signal. The **passive** antenna provided should provide a clear signal when placed beside a window. If the signal is not clear then you can purchase an **active** antenna (it should also be placed beside a window) to improve the signal. You should also check with any related government website which provides information on digital terrestrial TV coverage for your area. Note that (unlike standard analog TV) if the digital signal is weak then no picture will appear on the TV at all.

TV Recording and Power Plans
If you intend to use the **optional** TV Tuner to record live TV, then go to the **Power Options** control panel and create a power plan (see “Power Plans” on page 3 - 4) to prevent the power saving options from adjusting the computer’s performance level.

Remote Control Unit
The remote control unit allows you to remotely start and send the system into a power saving state, to run **Windows Media Center** and to navigate the **Media Center** menus etc. The remote control unit also gives full control over all TV and video functions.
Setting Up SATA RAID or AHCI Modes

(�RAID Mode is Optional for Model B Computers Only)

**AHCI Mode**
Advanced Host Controller Interface (AHCI) is an interface specification that allows the storage driver to enable advanced serial ATA features such as Native Command Queuing (for maximum hard disk efficiency and performance). AHCI mode can be supported by one, two or three hard disks.

**RAID (Model B Only)**
You may use your hard disks (if you have included more than one hard disk in your purchase option) in combination with Striping (RAID 0) or Mirroring (RAID 1) for either fault tolerance or performance (see *Table 7-1, on page 7-61*). To configure your system in Striping (RAID 0) or Mirroring (RAID 1) modes you will require **two** hard disks installed.

**Intel® Matrix Storage Manager**
Make sure you install the Intel Matrix driver and application if you have set up your hard disk(s) in RAID modes (see *Intel Matrix Driver Installation* on page 7-65).
Prepare the following before setting up your serial ATA hard disks in **RAID** mode (to configure **AHCI** mode you do not need to prepare any extra hard disks but will need to install the Intel Matrix driver):

1. The *Microsoft Windows OS CD*.
2. A *second* (identical) hard disk installed in the secondary HDD bay for **RAID level 0 or 1** (required for RAID but not required for AHCI).

<table>
<thead>
<tr>
<th>RAID Level</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>RAID 0</td>
<td>Identical drives reading and writing data in parallel to <strong>increase performance</strong>. RAID 0 implements a striped disk array and the data is broken into blocks and each block is written to a separate disk drive.</td>
</tr>
<tr>
<td>RAID 1</td>
<td>Identical drives in a mirrored configuration used to <strong>protect data</strong>. Should a drive that is part of a mirrored array fail, the mirrored drive (which contains identical data) will handle all the data. When a new replacement drive is installed, data to the new drive is rebuilt from the mirrored drive to restore fault tolerance.</td>
</tr>
</tbody>
</table>

**Table 7 - 1**

**RAID Levels**

**Array Types**

**A Mirrored Array** (RAID 1) provides full data protection, as data can simply be copied from a healthy disk to a replacement for any failed disk.

**A Striped Array** (RAID 0) is **NOT** fault-tolerant. The failure of one drive will result in the loss of all data in the array. It is designed to increase disk performance by spreading the I/O load across the channels and drives.
**SATA RAID Setup Procedure (BIOS)**

1. Start-up your notebook computer and press <F2> to enter the BIOS.
2. Go to the **Advanced** menu, select "**SATA Mode Selection**" and press Enter (see page 5 - 8).
   - Select “RAID”.
3. Press Esc and go to the **Boot** menu.
4. Set the **CD/DVD-ROM Drive** (make sure the **Microsoft Windows OS CD** is inserted) as the first device in the boot order from the **Boot** menu.
5. Select **Exit Saving Changes** from the **Exit** menu (or press F10 and Enter) and press Enter to exit the BIOS and reboot the computer.
6. For **RAID** mode see the instructions in “**RAID Setup (Intel Matrix)**” on page 7 - 63.

---

**RAID and Ready-Drive Compatibility**

On a system configured in RAID mode, a condition exists where NV Cache commands will not be sent to the Windows ReadyDrive* cache provided by Intel® Turbo Memory.

Microsoft has released a Knowledge Base article and QFE that addresses this issue. [http://support.microsoft.com/kb/954943](http://support.microsoft.com/kb/954943).

Intel recommends that customers who encounter this issue directly contact Microsoft to obtain the QFE.
RAID Setup (Intel Matrix)

1. Press **Ctrl + i** to enter RAID configuration menu.


3. Type the **RAID volume name** and then press Tab or Enter to advance to the next field.

4. Specify (use the up and down arrow keys) the **RAID level** (RAID 0 or RAID 1 see Table 7 - 1, on page 7 - 61) and then press Tab or Enter to advance to the next field.

5. Press Enter and the system will select the physical disks to use.

6. Press Enter and select (if applicable) the Strip Size (best set to default).

7. Press Enter and select the Capacity size (best set to default).

8. Press Enter to select **Create Volume**.

9. Press Enter to create the volume, and confirm the selection by pressing **Y**.

---

**Table 7 - 1, on page 7 - 61**

<table>
<thead>
<tr>
<th>Port</th>
<th>Drive Model</th>
<th>Serial #</th>
<th>Size</th>
<th>Type/Status (Vol ID)</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>FUJITSU MHY2120B</td>
<td>K404T812P22B</td>
<td>111.7GB</td>
<td>Non-RAID Disk</td>
</tr>
<tr>
<td>1</td>
<td>FUJITSU MHY2120B</td>
<td>K404T7C2KJ14</td>
<td>111.7GB</td>
<td>Non-RAID Disk</td>
</tr>
</tbody>
</table>
10. This will now return to the main menu.

**Figure 7 - 53**

RAID Created

11. Select **6.Exit** and press Enter, then press **Y** to exit the RAID configuration menu.
12. As the computer starts up, press a key when you see the message "**Press any key to boot from CD**".
13. Press **Enter** to continue installing the operating system as normal (see your **Windows** documentation if you need help on installing the **Windows** OS).
14. Install the **Windows** drivers from the **Device Drivers & Utilities + User’s Manual** disc as per **Table 4 - 1, on page 4 - 3**.
15. After installing all the necessary system drivers you need to install the Intel Matrix driver (see **“Intel Matrix Driver Installation” on page 7 - 65**).
Intel Matrix Driver Installation

1. Make sure you have installed all the necessary drivers from the Drivers Installer menu (see Figure 4 - 2 on page 4 - 2).
2. Insert the Device Drivers & Utilities + User’s Manual disc into the CD/DVD drive of the operable computer and click Browse CD/DVD.
3. Navigate (Browse...) to D:\Others\ and double-click the iMXMiata_cd file.
4. Click Next > Next > Yes > Next > Next.
5. Click Finish to restart the computer.

Intel® Matrix Storage Manager

The Intel Matrix Storage Console displays status information on your RAID configuration. Run the Intel® Matrix Storage Console from the Intel® Matrix Storage Manager in the Programs/All Programs menu. The Intel® Matrix Storage Manager provides information on the RAID status.

e-SATA Port

Install the Intel Matrix Storage driver to display the safe removal icon for e-SATA devices in the taskbar.

Figure 7 - 54
Intel Matrix Storage Console (Basic & Advanced Views)
If a hard drive member of a RAID volume is reported as “Degraded” or “Failed” it may be possible to recover the volume. If the volume cannot be restored then you will need to recreate the RAID volume and restore the data from a backup. The Help menu (press F1 or select Contents and Index from the Help menu) provides instructions on how to recover or recreate RAID Volumes.

Figure 7 - 55
Intel Matrix Storage Manager Help
RAID Volume Data Verification and Repair

The RAID volume data verification process identifies any inconsistencies or bad data on a RAID 0, RAID 1 or Recovery volume. The table outlines what occurs for each RAID level:

<table>
<thead>
<tr>
<th>RAID Level</th>
<th>Verify</th>
<th>Verify &amp; Repair</th>
</tr>
</thead>
<tbody>
<tr>
<td>RAID 0</td>
<td>Bad blocks are identified.</td>
<td>N/A</td>
</tr>
<tr>
<td>RAID 1</td>
<td>Bad blocks are identified. Data on the mirrored drive is compared to data on the source drive.</td>
<td>Bad blocks are reassigned. If the data on the mirrored drive does not match the data on the source drive, the data on the mirrored drive is overwritten by the data on the source.</td>
</tr>
</tbody>
</table>

See over for details on how to verify and repair RAID volume data.

Replacing and Reverting Recovery and Master Volumes

If a master or recovery drive fails you will need to add a new identical drive and re-build the recovery volume to the drive. You can also revert the master drive to the state of the previous volume update. For details on how to do this see “Intel Matrix Storage Manager Help” on page 7 - 66.
Verifying and Repairing RAID Volume Data

1. Run the Intel® Matrix Storage Console from the Intel® Matrix Storage Manager in the Programs/All Programs menu.
2. Click View > Advanced Mode.
3. Right-click on the RAID volume and select either Verify Volume Data or Verify and Repair Volume Data.
4. The verification or verification and repair process will run and display progress.
5. A dialog box will display the final status of the verification or verification and repair status.
Chapter 8: Troubleshooting

Overview

Should you have any problems with your computer, before consulting your service representative, you may want to try to solve the problem yourself. This chapter lists some common problems and their possible solutions. This can’t anticipate every problem, but you should check here before you panic. If you don’t find the answer in these pages, make sure you have followed the instructions carefully and observed the safety precautions in the preface. If all else fails, talk to your service representative. You should also make a record of what happened and what remedies you tried.

Of course, if something goes wrong, it will happen at the most inconvenient time possible, so you should preview this section just in case. If, after you’ve tried everything, and the system still won’t cooperate, try turning it off for a few minutes and then rebooting. You will lose any unsaved data, but it may start working again. Then call your service representative.
Troubleshooting

Basic Hints and Tips

Many of the following may seem obvious but they are often the solution to a problem when your computer appears not to be working.

- **Power** - Is the computer actually plugged into a working electrical outlet? If plugged into a *power strip*, make sure it is actually working. Check the *LED Power & Communication Indicators* (see “LED Indicators” on page 1 - 9) to see the computer’s power status.

- **Connections** - Check all the *cables* to make sure that there are no *loose connections* anywhere.

- **Power Savings** - Make sure that the system is not in *Hibernate* or *Sleep* mode by pressing the keys configured in your *Power Options* (see “Power-Saving States” on page 3 - 6), the **Fn + F4** key combination, or power button to wake-up the system.

- **Brightness** - Check the brightness of the screen by pressing the **Fn + F8** and **F9** keys to adjust the brightness.

- **Display Choice** - Press **Fn + F7** to make sure the system is not set to “external only” display.

- **Boot Drive** - Make sure there are no *optical media and/or USB storage devices* in any connected drive (this is a common cause of the message “*Invalid system disk - Replace the disk, and then press any key*” / “*Remove disks or other media. Press any key to restart*”).

8 - 2 Basic Hints and Tips
Backup and General Maintenance

- Always **backup** your important data, and keep copies of your OS and programs safe, but close to hand. Don’t forget to note the **serial numbers** if you are storing them out of their original cases, e.g. in a CD wallet.

- Run **maintenance programs** on your hard disk and OS as often as you can. You may schedule these programs to run at times when you are not using your computer. You can use those that are provided free with your OS, or buy the more powerful dedicated programs to do so.

- Write down your passwords and keep them safe (away from your computer). This is especially important if you choose to use a **Supervisor** password for the BIOS (see “Security Menu” on page 5 - 10).

- Keep copies of vital **settings files** such as network, dialup settings, mail settings etc.(even if just brief notes).

**Warranty**

The CPU is not a user serviceable part. Opening this compartment, or accessing the CPU in any way, may violate your warranty.
**Troubleshooting**

**Viruses**

- Install an **Anti-Virus** program and keep the **definitions file** (the file which tells your program which viruses to look for) up to date. New computer viruses are discovered daily, and some of them may seriously harm your computer and cause you to lose data. **Anti-Virus** programs are commercially available and the **definitions file updates** are usually downloadable directly from the internet.

- Be careful when opening e-mail from sources you don’t know. **Viruses** are often triggered from within **e-mail attachments** so take care when opening any attached file. You can configure most **Anti-Virus** programs to check all **e-mail attachments**. **Note:** You should also beware of files from people you know as the virus may have infected an **address book** and been automatically forwarded without the person’s knowledge.

- Keep a “**Bootable CD-ROM/DVD-ROM/USB storage device**” (this CD/DVD/USB device provides basic information which allows you to startup your computer) handy. You may refer to your OS’s documentation for instructions on how to make one, and many **Anti-Virus** programs will also provide such a disk (or at least instructions on how to make one).
Upgrading and Adding New Hardware/Software

- Do not be tempted to make changes to your Windows Registry unless you are very sure of what you are doing, otherwise you will risk severely damaging your system.

- Don’t open your computer or undertake any repair or upgrade work if you are not comfortable with what you are doing.

- Read the documentation. We can assume, since you are reading this that you are looking at the computer’s manual, but what about any new peripheral devices you have just purchased? Many problems are caused by the installation of new hardware and/or software. Always refer to the documentation of any new hardware and/or software, and pay particular attention to files entitled “READ ME” or “READ ME FIRST”.

- When installing a new device always make sure the device is powered on, and in many cases you will need to restart the computer. Always check that all the cables are correctly connected.

- Make sure you have installed the drivers for any new hardware you have installed (latest driver files are usually available to download from vendor’s websites).
Troubleshooting

• Thoroughly check any **recent changes** you made to your system as these changes may affect one or more system components, or software programs. If possible, go back and undo the change you just made and see if the problem still occurs.

• Don’t over complicate things. The less you have to deal with then the easier the source of the problem may be found; **Example** - if your computer has many devices plugged into its ports, and a number of programs running, then it will be difficult to determine the cause of a problem. Try disconnecting all of the devices and restarting the computer with all the peripheral devices unplugged. A process of elimination (adding and removing devices and restarting where necessary) will often find the source of a problem, although this may be time consuming.
### Troubleshooting

## Problems and Possible Solutions

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Cause - Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>You turned on the <strong>power</strong> but it doesn’t work.</td>
<td><strong>Battery missing / incorrectly installed.</strong> Check the battery bay, make sure the battery is present and seated properly (the design of the battery only allows it to go in one way). Make sure there’s nothing interfering with the battery contacts.</td>
</tr>
<tr>
<td>The battery <strong>LED power</strong> indicator, is blinking orange.</td>
<td><strong>Low Battery.</strong> Plug in the DC power source. If the computer doesn’t start up immediately, turn it off then on again.</td>
</tr>
<tr>
<td>You are <strong>losing battery power</strong> too quickly.</td>
<td><strong>The system is using too much power.</strong> If your OS has a <em>Power Options</em> scheme (see “<em>Power Plans</em>” on page 3 - 4) check its settings. You may also be using an ExpressCard/USB device/external device that is drawing a lot of power.</td>
</tr>
</tbody>
</table>
| Actual **battery operating time** is shorter than expected.            | **The battery has not been fully discharged before being recharged.** Make sure the battery is fully discharged and recharge it completely before reusing (see “*Battery Information*” on page 3 - 10).  
**Power Options have been disabled.** Go to the **Control Panel** in **Windows** and re-enable the options.  
A peripheral device/USB device/ExpressCard is consuming a lot of power. Turn off/remove the unused device to save power. |
## Troubleshooting

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Cause - Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The computer feels <strong>too hot</strong>.</td>
<td>Make sure the computer is properly ventilated and the Vent/Fan intakes are not blocked. If this doesn’t cool it down, put the system into <strong>Hibernate</strong> mode or turn it off for an hour. Make sure the computer isn’t sitting on a thermal surface (see “<strong>Overheating</strong> on page 1 - 16”). Make sure you’re using the correct adapter. Make sure that your notebook is completely powered off before putting it into a travel bag (or any such container). Putting a notebook which is powered on in a travel bag may cause the Vent/Fan intakes to be blocked.</td>
</tr>
<tr>
<td><strong>Nothing appears</strong> on screen.</td>
<td><strong>The system is in a power saving mode.</strong> Toggle the sleep/resume key combination, <strong>Fn + F4</strong> (see “<strong>Configuring the Power Buttons</strong>” on page 3 - 8). <strong>The screen controls need to be adjusted.</strong> Toggle the screen control key combinations <strong>Fn + F8/F9</strong>. If you’re connected to an external monitor, make sure it’s plugged in and turned on. You should also check the monitor’s own brightness and contrast controls. <strong>The computer is set for a different display.</strong> Toggle the screen display key combination, <strong>Fn + F7</strong>. If an external monitor is connected, turn it on. <strong>The screen saver is activated.</strong> Press any key or touch the <strong>TouchPad</strong>.</td>
</tr>
<tr>
<td>No image appears on the <strong>external monitor</strong> I have plugged in and powered on.</td>
<td><strong>You haven’t installed the video driver and configured it appropriately from the Control Panel.</strong> See <strong>Appendix B</strong> for instructions on installing and configuring the video driver.</td>
</tr>
</tbody>
</table>
## Troubleshooting

### Possible Cause - Solution

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Cause - Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>You forget the <strong>boot password</strong></td>
<td>If you forget the password, you may have to discharge the battery of the CMOS. Contact your service representative for help.</td>
</tr>
<tr>
<td>The sound cannot be heard or the <strong>volume is very low</strong>.</td>
<td>The volume might be set too low. Check the volume control in the <strong>Volume Control Panel</strong> in the Windows taskbar, or use the key combination <strong>Fn + F5</strong> and <strong>F6</strong> (see <strong>“Function/Hot Key Indicators” on page 1 - 12</strong>) to adjust.</td>
</tr>
<tr>
<td>The CD/DVD <strong>cannot be read</strong>.</td>
<td>The CD/DVD is dirty. Clean it with a CD/DVD cleaner kit.</td>
</tr>
<tr>
<td>The CD/DVD <strong>tray will not open</strong> when there is a disc in the tray.</td>
<td>The CD/DVD is not correctly placed in the tray. Gently try to remove the disc using the eject hole (see <strong>“Loading Discs” on page 2 - 3</strong>).</td>
</tr>
<tr>
<td>The <strong>DVD regional codes</strong> can no longer be changed.</td>
<td>The code has been changed the maximum 5 times. See <strong>“DVD Regional Codes” on page 2 - 5</strong>.</td>
</tr>
<tr>
<td><strong>Unwelcome numbers</strong> appear when typing.</td>
<td>If the <strong>LED</strong> is lit, then Num Lock is turned <strong>ON</strong>. (see <strong>“LED Indicators” on page 1 - 9</strong>).</td>
</tr>
</tbody>
</table>

### Password Warning

If you choose to set a boot password, **NEVER** forget your password. The consequences of this could be serious. If you cannot remember your boot password you must contact your vendor and you may lose all of the information on your hard disk.
### Troubleshooting

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Cause - Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>The system freezes</strong> or the screen goes dark.</td>
<td>The system’s power saving features have timed-out. Use the AC/DC adapter, press the sleep (Fn + F4) key combination, or press the power button if no LEDs are lit.</td>
</tr>
<tr>
<td><strong>The system never goes into a power saving mode.</strong></td>
<td>Power Options features are not enabled. Go to the Windows Power Options menu and enable the features you prefer (see “Power-Saving States” on page 3 - 6). Make sure you have enabled Hibernate mode from the control panel.</td>
</tr>
<tr>
<td><strong>The Wireless LAN/Bluetooth/3.5G modules cannot be detected.</strong></td>
<td>The modules are off. Check the LED indicator and/or function key indicator to see if the WLAN/Bluetooth/3.75G/HSPA module is on or off (see “LED Indicators” on page 1 - 9). If the LED indicator is off, then press the Fn + F11 (WLAN), Fn + F12 (Bluetooth) or Fn + (3.75G) key combination(s) in order to enable the modules (see “Function/Hot Key Indicators” on page 1 - 12).</td>
</tr>
</tbody>
</table>

**Other Keyboards**

If your keyboard is damaged or you just want to make a change, you can use any standard USB keyboard. The system will detect and enable it automatically. However special functions/hot keys unique to the system’s regular keyboard may not work.
## Troubleshooting

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Cause - Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The <strong>PC Camera</strong> module cannot be detected.</td>
<td><em>The module is off.</em> Press the <strong>Fn + F10</strong> key combination in order to enable the module (see “Function/Hot Key Indicators” on page 1 - 12). Run the camera program from the desktop shortcut to view the camera picture.</td>
</tr>
<tr>
<td>The <strong>Wireless LAN/Bluetooth/ PC Camera/3.75G/HSPA</strong> modules cannot be configured.</td>
<td>The driver(s) for the module(s) have not been installed. Make sure you have installed the driver for the appropriate module (see the instructions for the appropriate module in “Modules &amp; Options” on page 7 - 1).</td>
</tr>
<tr>
<td>A file cannot be copied to/from a connected <strong>Bluetooth</strong> device.</td>
<td><em>The transfer of data between the computer and a Bluetooth enabled device is supported in one direction only (simultaneous data transfer is not supported).</em> If you are copying a file from your computer to a Bluetooth enabled device, you will not be able to copy a file from the Bluetooth enabled device to your computer until the file transfer process from the computer has been completed.</td>
</tr>
<tr>
<td>The <strong>Bluetooth</strong> module is off after resuming from Sleep.</td>
<td><em>The Bluetooth module’s default state will be off after resuming from the Sleep power-saving state.</em> Use the key combination (<strong>Fn + F12</strong>) to power on the Bluetooth module after the computer resumes from Sleep.</td>
</tr>
</tbody>
</table>
## Troubleshooting

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Cause - Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The <strong>Hibernate</strong> function has disappeared.</td>
<td>You have a computer with <strong>4GB</strong> of RAM and have installed <strong>Windows Vista Service Pack 1</strong>. This is a known issue if your computer has <strong>4GB</strong> of RAM and is running <strong>Windows Vista Service Pack 1</strong>. To re-enable <strong>Hibernate</strong> mode go to the <strong>Command Prompt</strong> and type the command “<code>powercfg -h on</code>” (make sure you are logged on as an Administrator):</td>
</tr>
</tbody>
</table>

- 1. Click **Start** (menu button).
- 2. Type “`cmd`” in the **Start Search** box.
- 3. Double click the **Command Prompt** when it appears in the menu.
- 4. Type “`powercfg -h on`” in the Command Prompt window.
- 5. Close the Command Prompt window.
- 6. The **Hibernate** function will now be enabled. |
Screen Resolution Error

If you are experiencing either screen resolution reduction, or screen flickering after resuming from Sleep in Windows Vista only then follow the instructions below to fix this problem. This error arises in compliance with Windows Vista policy, which triggers TMM (Transient Multi-Monitor Manager) when the notebook lid (S3) is closed. TMM disconnects the LCD display from the OS and then adds the LCD display back when the lid is opened. This may trigger TMM to restore an old display setting which may result in screen flickering or a screen resolution change. To fix this problem you will need to disable TMM in the OS:

1. Go to the Control Panel in the Windows OS and double-click the Administrative Tools icon (System and Maintenance).
2. Double-click Task Scheduler (Schedule Tasks).

![Figure 8 - 1 - Control Panel System and Maintenance](image)
Troubleshooting

4. Click MobilePC to open the control panel.
5. Right-click TMM and select Disable.

![Figure 8 - 2 - TMM Disable](image)

6. Close all the control panels.

8 - 14 Screen Resolution Error
Appendix A: Interface (Ports & Jacks)

Overview

The following chapter will give a quick description of the interface (ports & jacks) which allow your computer to communicate with external devices, connect to the internet etc.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cable (CATV) Antenna Jack</td>
<td>Use this jack to connect a CATV cable if you have included the optional TV Tuner in your purchase configuration for Model B computers only.</td>
</tr>
<tr>
<td>CATV</td>
<td>The card reader allows you to use some of the latest digital storage cards. Push the card into the slot and it will appear as a removable device. The card reader allows you to use the following digital storage cards:</td>
</tr>
<tr>
<td></td>
<td>MMC (MultiMedia Card)</td>
</tr>
<tr>
<td></td>
<td>SD (Secure Digital)</td>
</tr>
<tr>
<td></td>
<td>MS (Memory Stick)</td>
</tr>
<tr>
<td></td>
<td>MS (Memory Stick Pro)</td>
</tr>
<tr>
<td></td>
<td>RS MMC (requires PC adapter)</td>
</tr>
<tr>
<td></td>
<td>Mini SD (requires PC adapter)</td>
</tr>
<tr>
<td></td>
<td>MS Duo (requires PC adapter)</td>
</tr>
<tr>
<td>Consumer Infrared Transceiver</td>
<td>The consumer infrared transceiver at the front of the computer allows the computer to communicate with the remote control unit supplied with the optional TV Tuner for Model B computers only.</td>
</tr>
</tbody>
</table>
Interface (Ports & Jacks)

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DC-In Jack</td>
<td>Plug the supplied AC/DC adapter into this jack to power your computer.</td>
</tr>
<tr>
<td>DVI-Out Port</td>
<td>The DVI-Out (Digital Visual Interface) Port (at the rear of the computer) allows you to connect an external monitor, or Flat Panel Display, to allow dual video or simultaneous display on the LCD and external monitor/FPD (see “Display Devices” on page B - 5). If you are using an older type of monitor you will need to use a converter to convert the signal from DVI to VGA.</td>
</tr>
<tr>
<td>e-SATA Port</td>
<td>Plug external Serial ATA hard drives into this e-SATA (external Serial Advanced Technology Attachment) port.</td>
</tr>
<tr>
<td>HDMI-Out Port</td>
<td>The HDMI-Out (High-Definition Multimedia Interface) is an audio/video connector interface for transmitting uncompressed digital streams. This allows you to connect an external monitor, TV or Flat Panel Display etc. as a display device by means of a HDMI cable. Note that HDMI carries both audio and video signals (see “HDMI Audio Configuration” on page B - 11).</td>
</tr>
<tr>
<td>Headphone-Out Jack</td>
<td>Headphones or speakers may be connected through this jack. Note: Set your system’s volume to a reduced level before connecting to this jack.</td>
</tr>
<tr>
<td>Line-In Jack</td>
<td>The Line-In jack allows you to play audio sources through the computer's speakers. Note that audio input through Line-in will default to the mute setting. To set up your audio sources to play through the Line-in jack go to the Sound control panel and make sure the Mute box is not ticked.</td>
</tr>
</tbody>
</table>

A - 2 Interface (Ports & Jacks)
## Interface (Ports & Jacks)

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microphone-In Jack</td>
<td>Plug an external microphone in to this jack to record on your computer.</td>
</tr>
<tr>
<td>Mini-IEEE 1394 Port</td>
<td>This allows high-speed connection to various peripheral devices, e.g. external disk drives and digital cameras (see note below).</td>
</tr>
<tr>
<td></td>
<td><strong>IEEE 1394</strong></td>
</tr>
<tr>
<td></td>
<td>The Mini-IEEE 1394 port only supports SELF POWERED IEEE 1394 devices. Make sure you install the Firewire IEEE 1394 driver (see page 4 - 6).</td>
</tr>
<tr>
<td>RJ-11 Phone Jack</td>
<td>This port connects to the built-in modem. You may plug the telephone line directly into this RJ-11 telephone connection.</td>
</tr>
<tr>
<td>RJ-45 LAN Jack</td>
<td>This port supports LAN (Network) functions.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Broadband (e.g. ADSL) modems usually connect to the LAN port.</td>
</tr>
<tr>
<td>Security Lock Slot</td>
<td>To prevent possible theft, a Kensington-type lock can be attached to this slot. Locks can be purchased at any computer store.</td>
</tr>
</tbody>
</table>
## Interface (Ports & Jacks)

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>S/PDIF-Out Jack</td>
<td>This S/PDIF (Sony/Philips Digital Interface Format) Out Jack allows you to connect your DVD-capable PC to a Dolby AC-3 compatible receiver for “5.1” or ‘dts’ surround sound.</td>
</tr>
<tr>
<td>USB 2.0/1.1 Ports</td>
<td>These USB 2.0 compatible ports (USB 2.0 is fully USB 1.1 compliant) are for low-speed peripherals such as keyboards, mice or scanners, and for high-speed peripherals such as external HDDs, digital video cameras or high-speed scanners etc. Devices can be plugged into the computer, and unplugged from the computer, without the need to turn the system off (if the power rating of your USB device is 500mA or above, make sure you use the power supply which comes with the device).</td>
</tr>
</tbody>
</table>
Appendix B: NVIDIA Video Driver Controls

The basic settings for configuring the LCD are outlined in “Video Features” on page 1-20.

NVIDIA Video Driver Installation

Make sure you install the drivers in the order indicated in Table 4-1, on page 4-3.

1. Insert the Device Drivers & Utilities + User’s Manual disc and click Install Drivers (button).
2. Click Install Video Driver > Yes.
3. Click Next > Next.
4. Click Finish to restart the computer.

Resolution Error

If you are experiencing screen resolution problems/screen flickering after resuming from Sleep in Windows Vista see page 8-13.

Video Card Options

Note that card types, specifications and drivers are subject to continual updates and changes. Check with your service center for the latest details on video cards supported.
NVIDIA Video Driver Controls

NVIDIA Control Panel

More advanced video configuration options are provided in the NVIDIA Control Panel tab.

1. Open the Display Settings (see page 1-21) control panel.
2. Click Advanced Settings (button).
3. Click GeForce..... (tab).
4. Click Start the NVIDIA Control Panel to make any video adjustments.

OR

1. Click Start, and click Control Panel (or point to Settings and click Control Panel).
2. Double-click NVIDIA Control Panel (click "Classic View" from the left of the menu if you are in Control Panel Home).

Figure B - 1
NVIDIA GeForce..... Control Panel
The NVIDIA Control Panel provides additional video configuration controls and tools which allow quick access to features such as display configuration, 3D Settings and Help menus etc.

Navigating the Control Panel

Navigate through the control panels in much the same way as you would a web page. Click on the sub-heading tasks in the left menu (and on the highlighted links) for information. Use the buttons on the top left to go back, forward etc.

Figure B - 2
NVIDIA Control Panels
The Help menus provide index and search features, and direct links to the NVIDIA website etc.

Figure B - 3
Help Menus
Display Devices

Note that you can use a DVI cable connected to the DVI-Out port, or an HDMI (High-Definition Multimedia Interface) cable connected to the HDMI-Out port to connect an external display (if you are using an older type of monitor you can use a converter to convert the signal from DVI to VGA). See your display device manual to see which formats are supported.

1. The built-in LCD.
2. An external display connected to the DVI-Out Port.
3. An external display/TV (if the TV supports an HDMI connection) connected to the HDMI-Out Port.

Monitor and TV Tuner

If you are connecting both a monitor/flat panel display to the DVI-Out Port, and a cable/aerial to the optional TV Tuner module, make sure you attach the cable/aerial to the TV Tuner first, then the monitor.

Display Devices

Besides the built-in LCD, you can also use an external monitor/flat panel display as your display device. The display options are:

- The built-in LCD.
- An external display connected to the DVI-Out port.
- An external display connected to the HDMI-Out port.

Note that HDMI supports video and audio signals.

DO NOT use the Fn + F7 key combination to toggle through display options when SLI is enabled.
Attaching Other Displays

Configuring an External Display in Windows Vista
1. Attach your external display to the DVI-Out Port or HDMI-Out port, and turn it on.
2. If a New Display Detected window does not appear in Windows Vista, go to the Windows Mobility Center control panel (Mobile PC > Adjust commonly used mobility settings) and click Connect display.
3. Click on any of the buttons to configure the displays to your preferences, or click Display Settings (in the New Display Detected window) to access the control panel.

Figure B - 4
New Display Detected
Configuring an External Display using the NVIDIA Control Panel
Alternatively you can use the NVIDIA control panel to configure any attached displays.

1. Attach your external display to the DVI-Out Port or HDMI-Out port, and turn it on.
2. Go to NVIDIA Control Panel (see “NVIDIA Control Panel” on page B - 2).
3. Double-click Display (if the sub-menus are not visible), and then click Set up multiple displays.
4. Any attached display will appear under “1.Select the displays you want to use.”

![Figure B - 5 Set Up Multiple Displays](image)
NVIDIA Video Driver Controls

5. Click the tickbox alongside any display you wish to use.
6. Click **Apply > Yes** to save the changes.
7. The default display mode will be in **Extended** mode (i.e. the desktop will be extended on to the external display - see “Display Devices” on page B - 5), and you can use the built-in **NVIDIA controls** ("Enabling Clone Mode" on page B - 9) or **New Display Detected** ("Attaching Other Displays" on page B - 6) window to configure the display.

8. If you prefer to use **Clone** mode see overleaf.

---

**Display Not Shown**

If the attached display does not appear in the “1. Select the displays you want to use.” window, click “My Display is not shown...” and then click the appropriate button to force detection of the missing display.

---

**Figure B - 6**

Select Display to Use

---

**B - 8 Attaching Other Displays**
Enabling Clone Mode
1. Attach your external display to the DVI-Out Port or HDMI-Out port, and turn it on.
2. Go to NVIDIA Control Panel (see “NVIDIA Control Panel” on page B - 2).
3. Double-click Display (if the sub-menus are not visible), and then click Set up multiple displays.
4. Any attached display will appear under “1. Select the displays you want to use.”
5. Click the tickbox alongside any display you wish to use.
6. Click Apply > Yes to save the changes.
7. The default display mode will be in Extended mode, to change to Clone Mode right-click one of the display icons and click “Clone Laptop Display and....” (a tick will appear alongside it) option from the pop-up menu and click Apply.

Figure B - 7
Enable Clone Mode
8. To switch back to **Extended Mode** right-click one of the display icons and click "Clone Laptop Display and..." (to remove the tick) option from the pop-up menu and click **Apply**.

---

**Figure B - 8**

**Switch to Extended Mode**
HDMI Audio Configuration
As HDMI (High-Definition Multimedia Interface) carries both audio and video signals you will need to configure the audio output as per the instructions below. The settings will depend upon the video card you have installed in your purchase option.

Windows Audio Setup for HDMI
1. Click Start, and click Control Panel (or point to Settings and click Control Panel).
2. Click Sound (Hardware and Sound).
3. Click Playback (tab), and click to select Realtek Digital Output.
4. Click Set Default (button).
5. Click OK to close the Sound control panel.
6. You will now be able to hear audio sources when played in Windows Media Player.

Figure B - 9
Sound Playback Options
NVIDIA Video Driver Controls

7. Adjust the HDMI settings from the control panel tabs.
8. Click OK to close the **Sound** control panel.

**Figure B - 10**

HDMI Device Properties
HDMI Notes
- Connect a device with HDMI support to the HDMI-Out port BEFORE attempting to play audio/video sources through the device.

- If you disconnect the HDMI cable the default audio playback device will not revert to speakers until the computer is restarted (if you do not wish to restart the computer then go to the Sound control panel and select Speakers as the default audio playback device).

HDMI Video Configuration
1. Connect an HDMI cable from the HDMI-Out port to your external display.
2. Configure your external display as per the instructions in “Configuring an External Display using the NVIDIA Control Panel” on page B - 7.
3. Set up your external display (TV or LCD) for HDMI input (see your display device manual).
4. You can now play video/audio sources through your external display.

HDMI Audio Support
Note that some NVIDIA video card models DO NOT support High Definition Audio through HDMI. When connecting these video cards to an external display (using an HDMI cable), it is recommended that you use a third party video application (e.g. Power DVD) that provides appropriate audio decoding to play DVDs etc. Alternatively you can output audio through an alternative source to the HDMI connection.

Other Applications
If you are using a third party application to play DVDs etc. you will need to consult the application’s documentation to see the appropriate audio configuration (the application must support digital to analog translation).
Display Modes

Single Display Mode
Only one of your displays is used.

Clone Mode
Clone Mode simply shows an exact copy of the Primary display desktop on the other display(s). This mode will drive multiple displays with the same content.

Dualview Mode
Dualview Mode (or Extended Mode in *Windows Vista* - see overleaf) treats both connected displays as separate devices, and they act as a virtual desktop resulting in a large workspace. When Dualview is enabled, you can drag any icons or windows across to the other display desktop. It is therefore possible to have one program visible in one of the displays, and a different program visible in the other display.

SLI Configuration & Multiple Displays

Note that if SLI configuration is enabled only a Single display may be used as the display device.

DO NOT use the Fn + F7 key combination to toggle through display options when SLI is enabled. SLI supports only a Single display, and attempting to configure dual displays may cause an error. Use the NVIDIA control panel to select the display to be used.
Using New Display Detected to Enable Extended Mode

1. Attach your external display to the DVI-Out Port or HDMI-Out port, and turn it on.
2. If a **New Display Detected** window does not appear in *Windows Vista*, go to the *Windows Mobility Center* control panel (Mobile PC > Adjust commonly used mobility settings) and click **Connect display**.
3. Click to select **Show different parts of my desktop on each display (extended)**.
4. Click **Right** or **Left** under **Extend your desktop**.
5. Click **Apply > OK**.

![Figure B - 11](image)

**New Display Detected** (Extended)
Using Display Settings to Enable Extended Mode
1. Attach your external display to the DVI-Out Port or HDMI-Out port, and turn it on.
2. Click Start, and click Control Panel (or point to Settings and click Control Panel).
3. Click Adjust screen resolution under the Appearance and Personalization menu (or double-click Personalization > Display Settings).
4. Click the monitor icon (e.g. 2), and make sure you have checked “Extend the desktop onto this monitor.” and click Apply.

Click the appropriate monitor icon (e.g. 2) to be able to select the option to extend the desktop on to it.

In this example the Primary monitor 1 is on the left, the secondary display 2 is on the right.

Figure B - 12
Display Settings (Extend the Desktop)
Enabling TV Display

To display desktop images on a TV, connect the TV to your computer by using an HDMI cable/DVI cable from the TV to the HDMI-Out port/DVI-Out port (if supported by your TV).

1. You will need to enable the TV display from the **NVIDIA Control Panel** as per the instructions on page **B - 7**. The TV will appear as a display option ("1. Select the displays you want to use.") when attached to the appropriate port.
2. **Apply** the settings, and then click **Yes** to save the changes.
3. The settings for TV and Video may be adjusted using the sub-menus under **Video & Television**.

---

Detect Displays

To get a full range of display options click "My Display is not shown..."

HDMI Audio Setup

See "HDMI Audio Configuration" on page **B - 11** for instructions on configuring audio for HDMI display devices.

Set up your external display (TV or LCD) for HDMI input (see your display device manual).
Changing the TV Signal or HD Format

1. When the TV is enabled as a display device click the sub-menus under Video & Television.
2. Click “Select the format you would like to use.”.
3. Select the TV signal format you would like to use.
4. Apply the settings, and then click Yes to save the changes.

Figure B - 14
Change the Signal or HD Format
Appendix C: Specifications

Latest Specification Information

The specifications listed in this Appendix are correct at the time of going to press. Certain items (particularly processor types/speeds and CD/DVD device types) may be changed, updated or delayed due to the manufacturer’s release schedule. Check with your service center for details.
### Specifications

<table>
<thead>
<tr>
<th>Processor</th>
<th>Core Logic</th>
<th>Video Adapter</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Intel® Core i7-820QM Processor:</strong> 1.73GHz 45nm (45 Nanometer) Process Technology, 8M L3 Cache &amp; FSB 1333MHz - TDP 45W rPGA988A Package</td>
<td>Intel® PM55 Chipset</td>
<td><strong>For Model A &amp; B Computers:</strong> nVIDIA® GeForce GTX 280M PCIe * 16 Video Card 1GB GDDR3 Video RAM on board Supports Microsoft DirectX® 10 Supports HDCP</td>
</tr>
<tr>
<td><strong>Intel® Core i7-720QM Processor:</strong> 1.6GHz 45nm (45 Nanometer) Process Technology, 6M L3 Cache &amp; FSB 1333MHz - TDP 45W rPGA988A Package</td>
<td></td>
<td><strong>For Model A Only:</strong> nVIDIA® GeForce GTX 260M PCIe * 16 Video Card 1GB GDDR3 Video RAM on board Supports Microsoft DirectX® 10 Supports HDCP</td>
</tr>
<tr>
<td><strong>For Model B Only:</strong> Intel® Core i7-920XM Processor: 2.00GHz 45nm (45 Nanometer) Process Technology, 8M L3 Cache &amp; FSB 1333MHz - TDP 55W rPGA988A Package</td>
<td></td>
<td><strong>BIOS</strong></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Display</th>
<th>Memory</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>For Model A Computers:</strong> 15.6&quot; HD (1366 * 768) / HD+(1600 * 900) / FHD (1920 * 1080) 16:9 Wide Screen LED Panel</td>
<td>Two 64-bit Wide DDRIII (DDR3) Data Channels Two 204 Pin SO-DIMM Sockets Supporting DDRIII (DDR3) 1333MHz Memory Expandable up to 4GB Using 2GB DDRIII Modules</td>
</tr>
<tr>
<td><strong>Model B Computers:</strong> 17.3&quot; HD+(1600 * 900) / FHD (1920 * 1080) 16:9 Wide Screen LED Backlit Panel</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>BIOS</th>
</tr>
</thead>
<tbody>
<tr>
<td>One 32Mb SPI Flash ROM Phoenix™ BIOS</td>
</tr>
</tbody>
</table>
## Specifications

### Storage
- One Changeable 12.7mm(h) Optical Device (CD/DVD) Type Drive (see “Factory Options for All Models” on page C - 5)
  - **For Model A Computers:**
    - Easy Changeable 2.5" 9.5 mm (h) SATA (Serial) HDD
  - **For Model B Computers:**
    - Easy Changeable 2.5" 9.5 mm (h) SATA (Serial) HDD (RAID 0/1 Support)
    - or 2.5" SATA (Serial) Solid State Drive

### Audio
- High Definition Audio Compliant Interface
- 3D Stereo Enhanced Sound System
- S/PDIF Digital Output
- Built-In Microphone
  - **For Model A Computers:**
    - 2 * Built-In Speakers
  - **For Model B Computers:**
    - 5 * Built-In Speakers (Supporting 2 Channel Stereo)

### Keyboard & Pointing Device
- Full Size WinKey Keyboard
- Built-in TouchPad with Multi Gesture Function
- Three Instant Keys (WWW, E-Mail, Silent Mode)

### Interface
- Four USB 2.0 Ports
- One eSATA Port
- One IEEE1394a Port
- One DVI-I Out Port
- One HDMI Out Port
- One Headphone-Out Jack
- One Microphone-In Jack
- One S/PDIF-Out Jack
- One Line-In Jack
- One RJ-11 Jack
- One RJ-45 LAN Jack
- One DC-In Jack
  - **For Model B Computers:**
    - Note: External 5.1CH Audio Output Supported by Headphone, Microphone and Line-In Jacks

### Card Reader
- Embedded 7-in-1 Card Reader (MS/ MS Pro/ SD/ Mini SD/ MMC/ RS MMC/ MS Duo) **Note:** MS Duo/ Mini SD/ RS MMC Cards require a PC adapter

### Slots
- One ExpressCard/34/54 Slot
- **Two Mini-Card Slots (USB/PCIe):**
  - Slot 1 for Half Mini-Card WLAN Module with PCIe Interface (Factory Option)
  - **For Model A Computers:**
    - Slot 2 for UMTS/HSPA 3.75G Module with USB Interface (Factory Option)
  - **For Model B Computers:**
    - Slot 2 for TV Tuner Card with USB Interface (Factory Option)
## Specifications

### Communication
- Built-In 56K Fax Modem V.90 & V.92 Compliant
- Built-In 10/100/1000Mb Base-TX Ethernet LAN
- Intel® WiFi Link Wireless LAN Module 5300 3*3 802.11 a/g/n Half Mini-Card with PCIe Interface *(Factory Option)*
- 3rd Party 802.11b/g/n Half Mini-Card Wireless LAN Module with PCIe Interface *(Factory Option)*
- Bluetooth 2.1 + EDR (Enhanced Data Rate) Module with USB Interface *(Factory Option)*
- 2.0M Pixel USB PC Camera Module with USB Interface *(Factory Option)*

### Communication (cont’d)
- For Model A Computers Only: UMTS/HSPDA-based 3.75G Module with USB Mini-Card Interface *(Factory Option)*
- Quad-band GSM/GPRS (850 MHz, 900 MHz, 1800 MHz, 1900 MHz)
- UMTS WCDMA FDD (2100 MHz)
- Note that UMTS modes CAN NOT be used in North America.

### Power Management
- Supports Wake on LAN
- Supports Wake on USB
- Supports Resume From Modem Ring

### Power
- Full Range AC/DC Adapter
- AC input 100 - 240V, 50 - 60Hz,
- DC Output 20V, 6.0A OR 18.5V, 6.5A
- Removable Polymer Smart Lithium-Ion Battery Pack, 42.18WH

### Security
- Security (Kensington® Type) Lock Slot
- BIOS Password
- Fingerprint Reader Module *(Factory Option)*

### Operating System
- Windows® Vista (with Service Pack 2)
- Windows® 7

### Environmental Spec
- Temperature
  - Operating: 5°C - 35°C
  - Non-Operating: -20°C - 60°C
- Relative Humidity
  - Operating: 20% - 80%
  - Non-Operating: 10% - 90%

### Dimensions & Weight
- **Model A Computers:**
  - 374mm (w) * 263.5mm (d) * 42mm (h)
  - 3.3kg +/- 0.1kg With ODD & Battery
- **Model B Computers:**
  - 412mm (w) * 279mm (d) * 39-48mm (h)
  - 4kg With ODD & Battery

### Factory Options As Per Model
- For Model A Computers Only:
  - UMTS/HSPDA-based 3.75G Module with USB Mini-Card Interface
- For Model B Computers Only:
  - Hybrid TV Tuner Card with USB Interface
Specifications

Factory Options for All Models

<table>
<thead>
<tr>
<th>Option</th>
</tr>
</thead>
<tbody>
<tr>
<td>Super Multi Drive ODD Module</td>
</tr>
<tr>
<td>Blu-Ray ODD Module</td>
</tr>
<tr>
<td>Intel® WiFi Link Wireless LAN Module 5300</td>
</tr>
<tr>
<td>3*3 802.11 a/g/n Half Mini-Card with PCIe Interface</td>
</tr>
<tr>
<td>3rd Party 802.11b/g/n Half Mini-Card Wireless LAN Module with PCIe Interface</td>
</tr>
<tr>
<td>Bluetooth 2.1 + EDR (Enhanced Data Rate) Module</td>
</tr>
<tr>
<td>Fingerprint Reader Module</td>
</tr>
<tr>
<td>2.0M Pixel USB PC Camera Module</td>
</tr>
</tbody>
</table>
Specifications
Appendix D: Windows 7 Information

This Appendix contains information (including control panel information, driver installation etc.) for users of the Windows 7 OS where there are significant differences from Windows Vista, or where is it helpful to have essential information or features repeated. For items not specifically covered here see the remainder of the manual for information.
DVD Regional Codes

## Changing DVD Regional Codes

Go to the Control Panel and double-click Device Manager (System and Security > System), then click the + next to DVD/CD-ROM drives. Double-click on the DVD-ROM device to bring up the Properties dialogue box, and select the DVD Region (tab) to bring up the control panel to allow you to adjust the regional code.

DVD region detection is device dependent, not OS-dependent. You can select your module’s region code 5 times. The fifth selection is permanent. This cannot be altered even if you change your operating system or you use the module in another computer.

<table>
<thead>
<tr>
<th>Region</th>
<th>Geographical Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>USA, Canada</td>
</tr>
<tr>
<td>2</td>
<td>Western Europe, Japan, South Africa, Middle East &amp; Egypt</td>
</tr>
<tr>
<td>3</td>
<td>South-East Asia, Taiwan, South Korea, The Philippines, Indonesia, Hong Kong</td>
</tr>
<tr>
<td>4</td>
<td>South &amp; Central America, Mexico, Australia, New Zealand</td>
</tr>
<tr>
<td>5</td>
<td>N Korea, Russia, Eastern Europe, India &amp; Most of Africa</td>
</tr>
<tr>
<td>6</td>
<td>China</td>
</tr>
</tbody>
</table>

*Table D - 1 - DVD Region Codes*
Windows 7 Start Menu & Control Panel

Most of the control panels, utilities and programs within Windows 7 (and most other Windows versions) are accessed from the Start menu. When you install programs and utilities they will be installed on your hard disk drive, and a shortcut will usually be placed in the Start menu and/or the desktop. Right-click the Start menu icon, and then select Properties if you want to customize the appearance of the Start menu.

In many instances throughout this manual you will see an instruction to open the Control Panel. The Control Panel is accessed from the Start menu, and it allows you to configure the settings for most of the key features in Windows (e.g. power, video, network, audio etc.). Windows 7 provides basic controls for many of the features, however many new controls are added (or existing ones are enhanced) when you install the drivers. To see all controls it may be necessary to toggle off Category View to view the control panel icons.
## Function/Hot Key Indicators

The function keys (F1 - F12 etc.) will act as hot keys when pressed while the Fn key is held down. In addition to the basic function key combinations; visual indicators are available when the hot key utility is installed.

<table>
<thead>
<tr>
<th>Fn Keys</th>
<th>Function</th>
<th>Fn Keys</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fn + ~</td>
<td>Play/Pause (in Audio/Video Programs)</td>
<td>Fn + F5/F6</td>
<td>Volume Decrease/Increase</td>
</tr>
<tr>
<td>Fn + _</td>
<td>3.75G Module Power Toggle*</td>
<td>Fn + F7</td>
<td>Display Toggle</td>
</tr>
<tr>
<td>Fn + F1</td>
<td>Touchpad Toggle</td>
<td>Fn + F8/F9</td>
<td>Brightness Decrease/Increase</td>
</tr>
<tr>
<td>Fn + F2</td>
<td>Turn LCD Backlight Off (Press a key to or use TouchPad to turn on)</td>
<td>Fn + F10</td>
<td>PC Camera Power Toggle</td>
</tr>
<tr>
<td>Fn + F3</td>
<td>Mute Toggle</td>
<td>Fn + F11</td>
<td>WLAN Module Power Toggle</td>
</tr>
<tr>
<td>Fn + F4</td>
<td>Sleep Toggle</td>
<td>Fn + F12</td>
<td>Bluetooth Module Power Toggle</td>
</tr>
</tbody>
</table>

*Silent Mode Toggle

*When enabled, Silent Mode will reduce fan noise and save power consumption. Note this may reduce computer performance.

### Table D - 2 - Function & Hot Key Indicators
Hot Key Buttons & Keyboard

The LED hot key buttons give instant access to the default Internet browser and e-mail program, and allow you to toggle Silent Mode with one quick button press.

<table>
<thead>
<tr>
<th>Hot Key</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>💌</td>
<td>Activate the Default E-Mail Browser (Note that in Windows 7 without Outlook/Outlook Express installed this button has no function. If Outlook/Outlook Express are installed then the button will activate the application)</td>
</tr>
<tr>
<td>⚪️</td>
<td>Activate the Default Internet Program</td>
</tr>
<tr>
<td>🡢</td>
<td>Toggle *Silent Mode (for power saving)</td>
</tr>
</tbody>
</table>

*Table D - 3 - LED Hot Key Buttons*

*When enabled, Silent Mode will reduce fan noise and save power consumption. Note this may reduce computer performance.*

**Other Keyboards**

If your keyboard is damaged or you just want to make a change, you can use any standard USB keyboard. The system will detect and enable it automatically. However, special functions/hot-keys unique to the system’s regular keyboard may not work.

**NumLk & ScrLk**

Hold down the Fn Key and either NumLk or ScrLk to enable number or scroll lock, and check the LED indicator for status.

**Special Characters**

Some software applications allow the number-keys to be used with Alt to produce special characters. These special characters can only be produced by using the numeric keypad. Regular number keys (in the upper row of the keyboard) will not work. Make sure that NumLk is on.
Video Features

You can configure display options from the Display control panel in Windows, and from the NVIDIA Control Panel as long as the appropriate video driver is installed. For more detailed video information see “NVIDIA Video Driver Controls” on page B - 1.

To access Display (Control Panel) and Screen Resolution in Windows:
1. Click Start and click Control Panel.
2. Click Display (icon) - In the Appearances and Personalization category.
3. Click Adjust Screen Resolution/Adjust resolution.
4. Alternatively you can right-click the desktop and select Screen resolution (see right).
5. Use the dropdown to select the screen Resolution 1 (Figure D - 2 on page D - 7).
6. Click Advanced settings 2 (Figure D - 2 on page D - 7) to bring up the Advanced properties tabs.

To access the NVIDIA Control Panel:
1. Click Start, and click Control Panel.
2. Click NVIDIA Control Panel 3 (Figure D - 3 on page D - 8) - In the Appearances and Personalization category.
3. Click Start and click All Programs > NVIDIA Corporation.
4. Click to select NVIDIA Physx Properties 4 (Figure D - 3 on page D - 8) .
5. Click Advanced settings in the Screen Resolution control panel in Windows.
6. Click GeForce....(tab) and click Start the NVIDIA Control Panel 5 (Figure D - 3 on page D - 8).
Screen Resolution
Besides the built-in LCD, you can also use an external VGA monitor (CRT)/external Flat Panel Display as your display device.

Figure D - 2 - Screen Resolution

Video Options
Note that card types, specifications and drivers are subject to continual updates and changes. Check with your service center for the latest details on video cards supported.
Windows 7 Information

NVIDIA Control Panel
Besides the built-in LCD, you can also use an external VGA monitor (CRT)/external Flat Panel Display as your display device.

Figure D - 3 - NVIDIA Control Panel

D - 8 Video Features
Attaching Other Displays

Configuring an External Display in Windows 7
1. Attach your external display to the external monitor port/HDMI-Out port and turn it on.
2. Go to the Screen resolution control panel.
3. Click the Detect button.
4. The computer will then detect any attached displays.

Figure D - 4 - Screen Resolution - Multiple Displays
5. You can configure the displays from the **Multiple Displays** menu.

![Figure D-5: Screen Resolution - Multiple Display Options]

- **Duplicate these displays** - Shows an exact copy of the main display desktop on the other display(s)
- **Extend these displays** - Treats both connected displays as **separate** devices
- **Show desktop only on 1/2** - Only one of your displays is used.

See “**Attaching Other Displays**” on page B-6 for more details on the above modes when using the NVIDIA driver to configure attached displays.

---

**D - 10 Video Features**
The Power Sources

The computer can be powered by either an AC/DC adapter or a battery pack.

AC/DC Adapter
Use only the AC/DC adapter that comes with your computer. The wrong type of AC/DC adapter will damage the computer and its components.

1. Attach the AC/DC adapter to the DC-in jack at the rear of the computer.
2. Plug the AC power cord into an outlet, and then connect the AC power cord to the AC/DC adapter.
3. Raise the lid/LCD to a comfortable viewing angle.
4. Press the power button to turn “On”.

Battery
The battery allows you to use your computer while you are on the road or when an electrical outlet is unavailable. Battery life varies depending on the applications and the configuration you're using. To increase battery life, let the battery discharge completely before recharging (see “How do I completely discharge the battery?” on page D - 23).

We recommend that you do not remove the battery. For more information on the battery, please refer to “Battery Information” on page D - 19.
Turning On the Computer

Now you are ready to begin using your computer. To turn it on simply press the power button on the front panel.

When the computer is on, you can use the power button as a Stand by/Hibernate/Shutdown hot-key button when it is pressed for less than 4 seconds (pressing and holding the power button for longer than this will shut the computer down). Use Power Options in the Windows control panel to configure this feature.

Forced Off

If the system “hangs”, and the Ctrl + Alt + Del key combination doesn’t work, press the power button for 4 seconds, or longer, to force the system to turn itself off.

Power Button as Stand by or Hibernate Button

You can use the OS’s “Power Options” control panel to set the power button to send the system into Stand by or Hibernate mode (see your OS’s documentation, or “Configuring the Power Buttons” on page D - 17 for details).

Shut Down

Note that you should always shut your computer down by choosing the Shut Down command from the Lock Button Menu in Windows 7. This will help prevent hard disk or system problems.
Power Plans

The computer can be configured to conserve power by means of power plans. You can use (or modify) an existing power plan, or create a new one.

The settings may be adjusted to set the display to turn off after a specified time, and to send the computer into Sleep after a period of inactivity.

Click Change plan settings and then click Change advanced power settings to access further configuration options in Advanced Settings.

Resuming Operation

See Table D - 4, on page D - 18 for information on how to resume from a power-saving state.

Password

It is recommended that you enable a password on system resume in order to protect your data.

Figure D - 6
Power Plan Advanced Settings
Each *Windows power plan* will also adjust the processor performance of your machine in order to save power. This is worth bearing in mind if you are experiencing any reduced performance (especially under DC/battery power).

Choose **High performance** (you may need to click *Show additional plans* to view the High performance plan) for maximum performance when the computer is powered from an AC power source. Choose the **Power saver** (bear in mind that this scheme may slow down the overall performance of the computer in order to save power) for maximum power saving when the computer is battery (DC power) powered.
Power-Saving States

You can use power-saving states to stop the computer’s operation and restart where you left off. Sleep is the default power-saving state in Windows 7.

Earlier versions of Windows used Stand By and Hibernate as system power-saving states. Windows 7 combines the features of Stand By and Hibernate into the default Sleep power-saving state.

Sleep

In Sleep all of your work, settings and preferences are saved to memory before the system sleeps. When you are not using your computer for a certain length of time, which you specify in the operating system, it will enter Sleep to save power.

The PC wakes from Sleep within seconds and will return you to where you last left off (what was on your desktop) without reopening the application(s) and file(s) you last used.

If your mobile PC in Sleep is running on battery power the system will use only a minimum amount of power. After an extended period the system will save all the information to the hard disk and shut the computer down before the battery becomes depleted.
Windows 7 Information

Hibernate

Hibernate uses the least amount of power of all the power-saving states and saves all of your information on a part of the hard disk before it turns the system off. If a power failure occurs the system can restore your work from the hard disk; if a power failure occurs when work is saved only to memory, then the work will be lost. Hibernate will also return you to where you last left off within seconds. You should put your mobile PC into Hibernate if you will not use the computer for a period of time, and will not have the chance to charge the battery.

Shut down

You should Shut down the computer if you plan to install new hardware (don’t forget to remove the battery and follow all the safety instructions in Chapter 6), plan to be away from the computer for several days, or you do not need it to wake up and run a scheduled task. Returning to full operation from Shut down takes longer than from Sleep or Hibernate.

Figure D - 8
Lock Button Menu
Configuring the Power Buttons

The power/sleep button (Fn + F4 key combo) and closed lid may be set to send the computer in to a power-saving state. Click **Choose what the power buttons do** on the left menu in **Power Options** to bring up the menu.

---

**Password Protection**

It is recommended that you enable a password on wake up in order to protect your data.

However you can disable this setting from the **Power Options** menu by clicking **Require a password on wakeup** in the left menu, and selecting the options (click **Change settings that are currently unavailable**).

---

*Figure D - 9*

**Power Options Define Power Buttons**
Windows 7 Information

Resuming Operation
You can resume operation from power-saving states by pressing the power button, or in some cases pressing the sleep button (Fn + F4 key combo).

<table>
<thead>
<tr>
<th>Power Status</th>
<th>Icon</th>
<th>Color</th>
<th>To Resume</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power Off</td>
<td>Off</td>
<td></td>
<td>Press the Power Button</td>
</tr>
<tr>
<td>Sleep</td>
<td>Blinking Green</td>
<td></td>
<td>Press the Power Button Press the Sleep Button (Fn + F4 Key Combo)</td>
</tr>
<tr>
<td>Hibernate</td>
<td>Off (battery) Orange (AC/DC adapter)</td>
<td></td>
<td>Press the Power Button</td>
</tr>
<tr>
<td>Display Turned Off</td>
<td>Green</td>
<td></td>
<td>Press a Key or Move the Mouse/Touchpad</td>
</tr>
</tbody>
</table>

Closing the Lid
If you have chosen to send the computer to Sleep when the lid is closed, raising the lid will wake the system up.

Power Button
When the computer is on, you can use the power button as a Sleep/Hibernate/Shutdown hot key button when it is pressed for less than 4 seconds (pressing and holding the power button for longer than this will force the computer to shut down).
Battery Information

Follow these simple guidelines to get the best use out of your battery.

Battery Power

Your computer’s battery power is dependent upon many factors, including the programs you are running, and peripheral devices attached. You can set actions to be taken (e.g. Shut down, Hibernate etc.), and set critical and low battery levels from power plan Change plan settings > Change advanced power settings (see Figure D - 6 on page D - 13).

Click the battery icon in the taskbar to see the current battery level and charge status.

Low Battery Warning

When the battery is critically low, immediately connect the AC/DC adapter to the computer or save your work, otherwise, the unsaved data will be lost when the power is depleted.

Figure D - 10
Battery Icon
(Taskbar) & Battery Advanced Settings
Conserving Battery Power

- Use a **power plan** that conserves power (e.g. **Power saver**), however note that this may have an affect on computer performance.
- Lower the brightness level of the LCD display. The system will decrease LCD brightness slightly to save power when it is not powered by the AC/DC adapter.
- Reduce the amount of time before the display is turned off.
- Close wireless, Bluetooth, modem or communication applications when they are not being used.
- Disconnect/remove any unnecessary external devices e.g. USB devices, ExpressCards etc.

*Figure D - 11  Windows Mobility Center*
Battery Life
Battery life may be shortened through improper maintenance. To optimize the life and improve its performance, fully discharge and recharge the battery at least once every 30 days.

We recommend that you do not remove the battery yourself. If you do need to remove the battery for any reason (e.g. long term storage) see “Removing the Battery” on page D - 23.

New Battery
Always completely discharge, then fully charge, a new battery (see “Battery FAQ” on page D - 23 for instructions on how to do this).

Recharging the Battery with the AC/DC Adapter
The battery pack automatically recharges when the AC/DC adapter is attached and plugged into an electrical outlet. If the computer is powered on, and in use, it will take several hours to fully recharge the battery. When the computer is turned off but plugged into an electrical outlet, battery charge time is less. (Refer to “LED Indicators” on page 1 - 9 for information on the battery charge status, and to “Battery Information” on page D - 19 for more information on how to maintain and properly recharge the battery pack.)
Proper handling of the Battery Pack

- DO NOT disassemble the battery pack under any circumstances
- DO NOT expose the battery to fire or high temperatures, it may explode
- DO NOT connect the metal terminals (+, -) to each other

Caution

Danger of explosion if battery is incorrectly replaced.

Replace only with the same or equivalent type recommended by the manufacturer. Discard used battery according to the manufacturer’s instructions.

Damaged Battery Warning

Should you notice any physical defects (e.g. the battery is bent out of shape after being dropped), or any unusual smells emanating from the notebook battery, shut your computer down immediately and contact your service center. If the battery has been dropped we do not recommend using it any further, as even if the computer continues to work with a damaged battery in place, it may cause circuit damage, which may possibly result in fire. It is recommended that you replace your computer battery every two years.
Battery FAQ

How do I completely discharge the battery?
Use the computer with battery power until it shuts down due to a low battery. Don’t turn off the computer even if a message indicates the battery is critically low, just let the computer use up all of the battery power and shut down on its own.

1. Save and close all files and applications.
2. Create a power plan for discharging the battery and set all the options to Never.
3. Click Change plan settings (after creating it) and click Change plan settings > Change advanced power settings.

![Figure D - 12 - Create Power Plan - Discharge Battery](image)

Figure D - 12 - Create Power Plan - Discharge Battery
Windows 7 Information

4. Scroll down to **Battery** and click + to expand the battery options.
5. Choose the options below (click **Yes** if a warning appears):

![Power Options Advanced Settings - Battery](image)

- Low battery levels = 0%
- Critical battery Levels = 0%
- Low battery action = Do Nothing
- Critical battery action (On battery) = Shut Down
- Critical battery action (Plugged in) = Do Nothing

---

**Battery Charging & Maintenance**

How do I fully charge the battery?
When charging the battery, don’t stop until the LED charging indicator light changes from orange to green.

How do I maintain the battery?
Completely discharge and charge the battery at least once every 30 days or after about 20 partial discharges.
Driver Installation

Insert the Device Drivers & Utilities + User's Manual disc, click Install Drivers/Option Drivers (button) and then click the appropriate driver name from the Drivers Installer menu. Follow the instructions to install the driver. Alternatively click Start, navigate (Browse..) to the executable file and then follow the manual setup instructions.

1. Check the driver installation order from Table D - 5 (the drivers must be installed in this order) which is the same as that listed in the Drivers Installer menu below.
2. Click to select the driver you wish to install, after installing each driver it will become greyed out (if you need to reinstall any driver, click the Unlock button).
3. Follow the instructions for each individual driver installation procedure as listed on the following pages.
### Windows 7 Information

<table>
<thead>
<tr>
<th>Windows 7 Drivers</th>
<th>Page #</th>
<th>Windows 7 Drivers</th>
<th>Page #</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chipset</td>
<td>Page D - 28</td>
<td>PC Camera Module (Win7)</td>
<td>Page D - 36</td>
</tr>
<tr>
<td>Video</td>
<td>Page D - 28</td>
<td>Wireless LAN Module (Win 7)</td>
<td>Page D - 30</td>
</tr>
<tr>
<td>Audio</td>
<td>Page D - 29</td>
<td>Fingerprint Reader Module (Win7)</td>
<td>Page D - 30</td>
</tr>
<tr>
<td>Modem</td>
<td>Page D - 28</td>
<td>3.75G/HSPA Module (Win 7) (Model A Only)</td>
<td>Page D - 52</td>
</tr>
<tr>
<td>LAN</td>
<td>Page D - 28</td>
<td>TV Tuner Module (Model B Only)</td>
<td>Page 7 - 58</td>
</tr>
<tr>
<td><strong>Firewire (IEEE 1394)</strong></td>
<td>Page D - 28</td>
<td>Setting Up SATA RAID or AHCI Modes (RAID for Model B Only)</td>
<td>Page 7 - 60</td>
</tr>
<tr>
<td>CardReader</td>
<td>Page D - 28</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TouchPad</td>
<td>Page D - 28</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Hot Key</td>
<td>Page D - 29</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Audio</td>
<td>Page D - 29</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

*Table D - 5 - Driver Installation*
Updating/Reinstalling Individual Drivers

If you wish to update/reinstall individual drivers it may be necessary to uninstall the original driver. To do this go to the Control Panel in the Windows OS and double-click the Programs and Features item (Programs > Uninstall a program). If you see the individual driver listed (if not see below), uninstall it, following the on screen prompts (it may be necessary to restart the computer). Go to the appropriate section of the manual to complete the update/reinstall procedure for the driver in question.

If the driver is not listed in the Programs and Features item:
1. Click Start and click Control Panel.
2. Double-click System (icon); System (icon) is in System and Security (category).
3. Click Device Manager (in the left menu).
4. Double-click the device you wish to update/reinstall the driver for (you may need to click “+”).
5. Look for the Update Driver button (check the Driver tab) and follow the on screen prompts.

Driver Installation General Guidelines

The driver installation procedure outlined in this Chapter are accurate at the time of going to press.

Drivers are always subject to upgrade and revision so the exact procedure for certain drivers may differ slightly. As a general guide follow the default on screen instructions for each driver (e.g. Next > Next > Finish) unless you are an advanced user. In many cases a restart is required to install the driver.
Windows 7 Information

Driver Installation Procedure
Insert the Device Drivers & Utilities + User’s Manual disc and click Install Drivers (button).

Chipset
1. Click 1.Install Chipset Driver > Yes.
2. Click Next > Yes > Next > Next.
3. Click Finish.

Video
1. Click 2.Install Video Driver > Yes.
2. Click Next > Next.
3. Click Finish to restart the computer.

Modem
1. Click 3.Install Modem Driver > Yes.
2. Click OK.
3. The modem is ready for dial-up configuration.

LAN
1. Click 4.Install LAN Driver > Yes.
2. Click Next > Install.
3. Click Finish.
4. The network settings can now be configured.

Firewire (IEEE 1394)
1. Click 5.FireWire drivers > Yes.
2. Click Install.
3. Click Finish.

CardReader
1. Click 6.Install Cardreader Driver > Yes.
2. Click Install.
3. Click Finish.

TouchPad
1. Click 7.Install Touchpad Driver > Yes.
2. Choose the language you prefer and click OK.
3. Click Next > Finish.
4. Click Restart Now to restart the computer.
Hot Key
1. Click **Install Hotkey Utility > Yes.**
2. Click **Next > Next.**
3. Click **Finish > Finish** to restart the computer.

Audio
1. Click **Install Audio Driver > Yes.**
2. Click **Next.**
3. Click **Finish** to restart the computer.

Note that after installing the audio driver the system will not return to the Drivers Installer screen. To install any of the optional drivers listed overleaf, eject the Device Drivers & Utilities + User’s Manual disc and then reinsert it (or double-click the disc icon in My Computer), and click Option Drivers (button) to access the optional driver menu.

Optional Drivers
See the pages indicated for the driver installation procedures for any modules included in your purchase option. Where Windows 7 information differs from Windows Vista it will be included in this chapter; if Windows 7 information is the same as Windows Vista then refer to Chapter 7 as indicated on the following page.

*Figure D - 1 - Drivers Installer - Option Drivers Menu*
Windows 7 Information

Bluetooth Module (Win 7)
Note: The operating system is the default setting for Bluetooth control in Windows 7, and does not require a driver. See “Bluetooth Module (Win 7)” on page D - 31 for configuration instructions.

PC Camera Module (Win 7)
See “PC Camera Module (Win 7)” on page D - 44 for driver installation and configuration information.

Wireless LAN Module (Win 7)
See the specific Windows 7 driver installation and configuration information in “Wireless LAN Module (Win 7)” on page D - 42.

Fingerprint Reader Module (Win 7)
See the introduction in “Fingerprint Reader Module (Win7)” on page D - 48, and check the installation procedure.

3.75G/HSPA Module (Win 7 - Model A Only)
See the introduction in “3.75G/HSPA Module (Win 7)” on page D - 52, and check the installation procedure.

TV Tuner Module (Model B Only)
See the introduction in “TV Tuner Module” on page 7 - 57, and check the installation procedure for the Consumer Infrared (CIR) driver.

RAID and AHCI Configuration (RAID for Model B Only)
See the configuration instructions in “Setting Up SATA RAID or AHCI Modes” on page 7 - 60. The Intel Matrix driver is required to support hard disk in RAIN or AHCI modes (see “Intel Matrix Driver Installation” on page 7 - 65).
Bluetooth Module (Win 7)

The operating system’s Bluetooth Devices control panel is used to configure the Bluetooth settings in Windows Vista, and therefore does not require a driver. Use the Fn + F12 key combination (see “Function/Hot Key Indicators” on page D - 4) to toggle power to the Bluetooth module. When the Bluetooth module is powered on, the LED will be illuminated and the on-screen indicator will briefly be displayed.

Bluetooth Data Transfer

Note that the transfer of data between the computer and a Bluetooth enabled device is supported in one direction only (simultaneous data transfer is not supported). Therefore if you are copying a file from your computer to a Bluetooth enabled device, you will not be able to copy a file from the Bluetooth enabled device to your computer until the file transfer process from the computer has been completed.

Bluetooth Module & Resuming From Sleep Mode

The Bluetooth module’s default state will be off after resuming from the Sleep power-saving state. Use the key combination (Fn + F12) to power on the Bluetooth module after the computer resumes from Sleep.
Bluetooth Configuration in Windows Vista

Setup your Bluetooth Device so the Computer Can Find it
1. Turn your Bluetooth device (e.g. PDA, mobile phone etc.) on.
2. Make the device discoverable (to do this check your device documentation).

To Turn the Bluetooth Module On
1. Press the \texttt{Fn + F12} key combination to power on the Bluetooth module.
2. A Bluetooth icon will appear in the taskbar.
3. You can then do any of the following to access the Bluetooth Devices control panel.
   - \textbf{Double-click} the taskbar icon to access the Bluetooth Devices control panel.
   - \textbf{Click/Right-click} the taskbar icon and choose an option from the menu.

![Figure D - 2
Bluetooth Devices & Click Icon Menu](image)
To Add a Bluetooth Device
1. Access the **Bluetooth Devices** control panel and click **Add a device**.
2. Double-click the device you want to pair with the computer.

3. On first connection the computer will provide you with a pairing code to be entered onto the device.

**Pairing Options**

If a device has been previously connected then the pairing option menu will appear when you attempt subsequent connections. You can choose to have the computer create a pairing code for you, use the device’s existing pairing code or you can pair certain devices without using a code.

*Figure D - 3*

Add a Device
4. Enter the code into your Bluetooth enabled device and follow any on-screen instructions to complete the pairing.

5. **Windows** will check to see if any drivers are required to complete the pairing.

6. Follow any on-screen instructions on the computer if device drivers are required to be installed.

7. Click **Close**.

---

**Figure D - 4**
Pairing Code Example

**Figure D - 5**
Pairing Complete & Bluetooth Device Enabled

---

**Pairing Codes**

The example outlined here shows a connection to a mobile device. Other devices e.g. computers, may have a slightly different connection procedure, and may require you to confirm a pairing code is correct on both devices. Follow the on-screen instructions to complete the pairing.
To Change Settings for the Bluetooth Device
1. Click the taskbar icon and select **Show Bluetooth Devices**.
2. Right-click on the device you want to change and click **Properties** to:
   - Change the **name** of the device (click **Bluetooth**, type a new name and click **OK**).
   - Enable/Disable a **service** (click **Services**, clear/tick the check box next to the service and click **OK**).

To Make your Computer Discoverable to Bluetooth Devices
1. Click the taskbar icon and select **Open Settings**.
2. Click **Options**, and make sure that **Allow Bluetooth devices to find this computer** check box (**Discovery**) has a tick inside it.
3. Make sure that the **Alert me when a new Bluetooth device wants to connect** check box (**Connections**) has a tick inside it, if you want to be notified when a Bluetooth device wants to connect.

To get help on Bluetooth configuration and settings, select **Help and Support** from the **Start** menu. Type Bluetooth in the **Search Help** box, and select an item from the returned search results to get more information.

![Figure D - 6
Bluetooth Settings - Options](image_url)
PC Camera Module (Win7)

If you have included a PC Camera module in your purchase option, make sure that the PC Camera module is on before installing the driver. Use the Fn + F10 key combination (see “Function/Hot Key Indicators” on page 1-12) to toggle power to the PC Camera module. When the PC Camera module is powered on, the on-screen indicator will briefly be displayed. Make sure you install the drivers in the order indicated in Table D - 5, on page D - 26.

There are a number of different camera modules available with this computer model series. You will have the appropriate application installed for your camera. Make sure you access the application via the WebCam desktop shortcut.

PC Camera Device and TV Module

If you have both an optional PC Camera and an optional TV Tuner module present, you will need to select which device to use with the BisonCap program. Go to the Devices menu in the BisonCap application and select the BisonCam, NB Pro device.
PC Camera Driver Installation
1. Make sure the module is powered on, then insert the Device Drivers & Utilities + User’s Manual disc into the CD/DVD drive.
2. Click Option Drivers (button).
3. Click 1.PC Camera, Web cam > Yes.
4. Choose the language you prefer and click Next > Next.
5. Click Finish to restart the computer.
6. Run the camera application program from the shortcut on the desktop (if the hardware is turned off use the Fn + F10 key combination to turn it on again).

PC Camera Audio Setup
If you wish to capture video & audio with your camera, it is necessary to setup the audio recording options in Windows.
1. Click Start, and click Control Panel (or point to Settings and click Control Panel).
2. Click Sound (Hardware and Sound).
3. Click Recording (tab).
4. Right-click Microphone (Realtek High Definition Audio) and make sure the item is not disabled.
5. Double-click Microphone (or select Properties from the right-click menu).
6. Click Levels (tab), and adjust the Microphone and Microphone Boost sliders to the level required.
7. Click OK and close the control panels.
8. Run the camera application program from the desktop shortcut.
9. Go to the Devices menu heading and select Microphone (Realtek....) (it should have a tick alongside it).
10. Go to the Capture menu heading and select Capture Audio (it should have a tick alongside it).
**Camera Application**

The WebCam application is a video viewer for general purpose video viewing and testing, and for capturing video files to .avi format.

1. Run the camera application from the desktop shortcut (it is recommended that you set the capture file before the capture process - see “Set Capture File” on page D - 39).

2. Go to the Capture menu heading (if you wish to capture audio check “PC Camera Audio Setup” on page D - 37) and select Start Capture.

3. Click OK (the file location will be displayed in the pop-up box) to start capturing the video, and press Esc to stop the capture (you can view the file using the Windows Media Player).

---

**Pre-Allocating File Size/Space**

You may pre-allocate the file size (File > Allocate File Size/Space) for the capture file in the camera program (you may need to set a folder location first).

Pre-allocating space on the hard disk can improve the capture quality (particularly of large capture files), by reducing the amount of work the hard disk has to do in finding space for the video data as it is being captured.

See also “Reducing Video File Size” on page D - 39.
Set Capture File
Prior to capturing video files you may select the Set Capture File... option in the File menu, and set the file name and location before capture (this will help avoid accidentally overwriting files). Set the name and location then click Open, then set the "Capture file size:" and click OK. You can then start the capture process as on the previous page.

Note the important information in reducing video file size below in order to save file space, and help prevent system problems.

Reducing Video File Size
Note that capturing high resolution video files requires a substantial amount of disk space for each file. After recording video, check the video file size (right-click the file and select Properties) and the remaining free space on your hard disk (go to My Computer, right-click the hard disk, and select Properties). If necessary you can remove the recorded video file to a removable medium e.g. CD, DVD or USB Flash drive.

Note that the Windows 7 system requires a minimum of 15GB of free space on the C: drive system partition. In order to prevent system problems it is recommended that you save the captured video file to a location other than the C: drive (see set capture file above), limit the file size of the captured video (see “Pre-Allocation File Size/Space” on page D - 38) or reduce video resolution (see below).

To Reduce Video Resolution Output Size:
1. Run the camera application program from the desktop shortcut.
2. Go to Options and scroll down to select Video Capture Pin....
3. Click the Output Size drop box and select a lower resolution size in order to reduce the captured file size.
4. Click OK.
Eliminating Screen Flicker
If you find that the video screen in the camera program is flickering, you can try to adjust the setting in the **Video Capture Filter** options.

1. Run the camera program from the desktop shortcut.
2. Go to **Options** and scroll down to select **Video Capture Filter**....
3. Click either **50Hz** or **60Hz** under **Frequency** in **Property Page** (tab).

![Figure D - 7 Video Capture Filter](image)
Zoom
The WebCam program allows you to zoom the camera in and out.

1. Run the camera application from the desktop shortcut.
2. Go to Zoom and select Zoom Out/Zoom In.

Taking Still Pictures
The WebCam program allows you to take still pictures.

1. Run the camera application from the desktop shortcut.
2. Go to Options and select Take Picture.
3. The picture (in JPEG format) will be placed in the Snapshot folder on the desktop (see sidebar).
If you have included an Intel® Wi-Fi Link 5300 Series or 3rd Party 802.11b/g/n WLAN module in your purchase option, make sure that the Wireless LAN module is on before installing the driver.

Use the **Fn + F11 key combination** (see “Function/Hot Key Indicators” on page 1-12) to toggle power to the Wireless LAN module. When the WLAN module is powered on, the (_power) LED will be illuminated and the on-screen indicator will briefly be displayed. Make sure you install the drivers in the order indicated in Table 4-1, on page 4-3.
Intel® Wi-Fi Link Series Driver Installation

If you see the message “Found New Hardware” click **Cancel** to close the window.

1. Make sure the module is powered on, then insert the *Device Drivers & Utilities + User’s Manual* disc into the CD/DVD drive.
2. Click **Option Drivers** (button).
3. Click **2.Wireless Lan > Yes**.
4. An on-screen message will appear to show the progress of the WLAN installation.
5. When the message disappears the driver will be installed.

**Note:** The operating system is the default setting for Wireless LAN control in *Windows 7* (see overleaf).

3rd Party 802.11b/g/n Driver Installation

1. Make sure the module is powered on, then insert the *Device Drivers & Utilities + User’s Manual* disc into the CD/DVD drive.
2. Click **Option Drivers** (button).
3. Click **2.Wireless Lan > Yes**.
4. Choose the language you prefer and click **Next**.
5. Click **Next > Install**.
6. Click **Finish**.

**Note:** The operating system is the default setting for Wireless LAN control in *Windows 7* (see overleaf).
Connecting to a Wireless Network

Make sure the Wireless LAN module is turned on.

1. **Click** the taskbar wireless icon , and then double-click an access point to connect to or click to **Open Network and Sharing Center** if you do not see a network you want to connect to in the taskbar menu (a list of options will appear allowing setting changes, and creating a new network).

**Network and Sharing Center**

You can also use the Network and Sharing Center control panel in Windows (Network and Internet) to connect to any available wireless networks.

**Figure D - 9**

Click Taskbar Icon Menu & Network and Sharing Center

---

**D - 44 Wireless LAN Module (Win 7)**
2. You may need to enter a security key for any access point to which you are trying to connect.
3. Click to select a network location (e.g. Home, Work or Public).
4. Click “View or change settings in Network and Sharing Center” to access further options for the connection.

Figure D - 10
Network Location Set
5. Click the taskbar icon to see any currently connected networks.
6. To disconnect from the wireless network you can click the taskbar wireless icon, click the active connection and then click Disconnect (button).

Security Enabled Networks
You should try to make sure that any network you are connecting to is a secure network.
Connecting to unsecure networks may allow unauthorized access to your computer, documents, websites and files etc.

Figure D - 11
Click Taskbar Icon
Menu - Disconnect
Windows Mobility Center

The **Windows Mobility Center** control panel provides an easy point of access for information on battery status, power plans used and wireless device status etc.

To access the Windows Mobility Center:

1. Click **Start**, and click **Control Panel** (or point to **Settings** and click **Control Panel**).
2. Double-click **Windows Mobility Center** (Mobile PC).
3. Click the button to **Turn wireless off/on**, or click the icon to access the network menu.

![Windows Mobility Center](image)
Fingerprint Reader Module (Win7)

The fingerprint reader module provides a high level of security for your computer. Make sure you have administrator’s rights to your computer, and have a Windows password enabled for full security protection.

Before beginning the enrollment process it is recommended that you go through the fingerprint tutorial. To run the tutorial click **Start > Programs/All Programs > Protector Suite QL > Fingerprint Tutorial** after installing the driver.

Fingerprint Reader Driver Installation

1. Insert the **Device Drivers & Utilities + User’s Manual disc** and click **Option Drivers** (button). Click **Unlock** (button) and then click **3.FingerPrint > Yes**.
2. Click **Documentation** to open the folder containing the manual in .pdf format.

To install the Adobe Acrobat Reader software to read the file, insert the **Device Drivers & Utilities + User’s Manual disc** and click **User’s Manual** (button), and click **Install Acrobat Reader** (button).

1. Insert the **Device Drivers & Utilities + User’s Manual disc** into the CD/DVD drive.
2. Click **Option Drivers** (button).
3. Click **3.FingerPrint > Yes**.
4. Click **Software Installation**.
5. Click **Next > Next > Next**.
6. Click **Finish > Yes** to restart the computer.
User Enrollment
1. Click Start > Control Center (Start > All Programs > Protector Suite > Control Center), or double click the taskbar icon.
2. On the first run of the program you will be asked to click the Accept button to accept the license.
3. If you have not set a Windows password you will be prompted to do so (note: If you have not set a password Protector Suite cannot secure access to your computer).
4. Click Submit when you have entered password.
5. You will then be prompted to enroll your fingerprints (you can click Tutorial to get help with fingerprint enrollment at any time).
6. Click the button above any of the fingers to begin the enrollment process for that finger.

7. Swipe the finger until the progress bar reaches **100%** to enroll that finger.

8. Repeat the process for all the fingers you wish to enroll (see sidebar), and then click the close button to close the window.

**Figure D - 14**
Fingerprints Enrolled
9. Click the taskbar icon and select **Start Control Center** (and then swipe a finger) to allow you to **Edit Fingerprints**, register **Applications**, edit **Settings** and access the **Help** menu etc. You can also run the **Control Center** from the **Start** menu or **Protector Suite > Control Center** item in the **All Programs** menu.

10. Click “**Help**” in **Control Center Home** to get more information on any topic.

11. You can also run the **Tutorial**, or **Product Tour** video to get more information.

12. If you swipe your finger over the reader at any time you can access the **Biomenu** to **lock the computer**, register **websites**, access the **Personal Safe**, open the **Control Center** and access the **Help** menu.
3.75G/HSPA Module (Win 7)
(Optional for Model A Computers Only)
If you have included an optional 3.75G/HSPA (High Speed Packet Access) module (see “Communication” on page C - 4 for specification details) in your purchase option, you will have the appropriate application (HSPA Modem Interface or Mobile Partner) provided for your module. Follow the instructions on page D - 54 to install the USIM card (supplied by your service provider), and then install the application (see over for further details).

**Important Notice - 3.75G/HSPA & Bluetooth/Wireless LAN Modules**
In order to comply with FCC regulations you should NOT operate the 3.75G/HSPA module and the Bluetooth/Wireless LAN modules at the same time as this may disrupt radio frequency, and cause interference. When the 3.75G/HSPA module is powered on, make sure that the Bluetooth/Wireless LAN modules are powered off.

---

**3.75G/HSPA Module Options**
There are two optional 3.75G/HSPA modules available for this series of computer models. Each module is supplied with the appropriate application software. The module type supplied may depend upon the computer model purchased. Check with your service center for details. Install the driver from the Drivers Installer menu and check the instructions for the appropriate application on the following pages.
Before installing the application, make sure that the 3.75G/HSPA module is ON (installing the driver with the module off will not allow the software to detect the module hardware correctly). Use the $Fn + \#$ key combination (see “Function/Hot Key Indicators” on page D - 4) to toggle power to the 3.75G/HSPA module. When the 3.75G/HSPA module is powered on, the on-screen indicator will briefly be displayed. Make sure you install the drivers in the order indicated in Table D - 5, on page D - 26. Note that exiting the application does NOT turn off the 3.75G/HSPA module.

- **HSPA Modem Interface** - See “HSPA Modem Interface Installation” on page D - 56 for driver installation information and “HSPA Modem Interface” on page D - 57 for instructions on using the HSPA Modem Interface.

- **Mobile Partner** - See “Mobile Partner Application Installation” on page D - 66 for driver installation information and “Mobile Partner Application” on page D - 67 for instructions on using the Mobile Partner application.
Windows 7 Information

USIM Card Installation
1. Turn off the computer, and turn it over and remove the battery (see “Removing the Battery” on page 6 - 3).
2. The SIMLOCK is located in the compartment under the battery.
3. Remove screw 1 from the SIMLOCK cover, and remove the cover.
4. Insert the USIM card as you would into your mobile phone.

Power Safety Warning
Before you undertake any installation procedures, make sure that you have turned off the power, and disconnected all peripherals and cables (including telephone lines). It is advisable to also remove your battery in order to prevent accidentally turning the machine on.

Figure D - 16
Battery & SIMLOCK Cover Removal
5. Slide the SIMLOCK towards the hinge (in the direction of the arrow illustrated in Figure D - 17) in order to release the lock and lift it up.
6. Insert the USIM card as illustrated in (Figure D - 18) and close the SIMLOCK.

7. Lock the SIMLOCK by pushing it in the direction of the arrow in Figure D - 18 until it clicks into the lock position.

8. Replace the cover, screw and battery.
HSPA Modem Interface
With the 3.75G/HSPA module and USIM card (supplied by your service provider) installed you may then install the HSPA Modem Interface. The HSPA Modem Interface allows you to directly access your HSPA internet service from the computer.

HSPA Modem Interface Installation
1. Enable power to the module by pressing the *Fn + Esc* key combination (the on-screen indicator will indicate the module’s power status). If a *Found New Hardware* window appears, click *Cancel* in all windows that appear, and then proceed to install the driver as below.Insert the Device Drivers & Utilities + User’s Manual disc into the CD/DVD drive.
2. Click Option Drivers (button).
3. Click 4.3.5 Generation Module > Yes.
4. Click Next > Install.
5. Click Finish to restart the computer.
6. Access the HSPA Modem Interface from the Start menu (Start > Programs/All Programs > HSPA modem), or by double-clicking the HSPA modem icon on the desktop.
HSPA Modem Interface
The connection information is stored on the USIM card supplied by the service provider.

1. Power on the 3.75G/HSPA module using the \text{Fn} + \text{key combination.}
2. Access the \text{HSPA Modem Interface} from the \text{Start} menu (\text{Start} > \text{Programs/All Programs} > \text{HSPA Modem} > \text{HSPA Modem}), or by double-clicking the desktop icon.
3. If a USIM card is not installed then a message will appear to notify you of this (click \text{OK} to close the message and install the USIM card).
4. If you are required to enter a pin # then a message will appear to prompt you to enter a pin #. (\text{Note:} to change pin # go to \text{Settings} and click \text{OK} in \text{PIN code}.)
5. Click the \text{Network connection} button and the \text{HSPA Modem} interface window will display \text{Connection Manager}.

\textbf{Connection Manager}
The connection information is commonly stored on the USIM card supplied by the service provider. However if your service provider requires details such as \text{IP Address}, \text{Username} and \text{Password} etc. to be entered before connection you can enter them in the \text{Connection Manager} tab, or save the details in \text{Profiles}. 

\textbf{HSPA Modem Help}
To get help on 3.75G/HSPA module configuration and settings, click the help icon and select \text{Help}. 

\textbf{Figure D - 19}
\text{HSPA Modem Interface Window}
6. Click **Connect** to connect to your service provider.

7. The message "**Network is connected**" will be displayed when the network connection is successful.

8. You can then access the internet, download e-mail etc. as per any internet connection.
9. While you are connected the upper right corner of the **HSPA Modem** interface will display the upload and download rates, and the taskbar icon will display the connection icon 📡.

![Figure D - 22](Image)

10. To disconnect click the **Disconnect** icon (**Connection Manager**).
11. The program will disconnect from the service provider.
12. The module will still be on, and you will need to press the **Fn + ☩** key combination to turn it off.

**Adding a Profile**

1. Access the **HSPA Modem Interface** from the **Start** menu (**Start** > **Programs/All Programs** > **HSPA Modem** > **HSPA Modem**), or by clicking the desktop icon.
2. Click the **Network connection** 💻, and click **Profiles** (tab).

![Figure D - 23](Image)
3. Click **Add** (button) and input any **Network Settings** required by your service provider.
4. Click **OK** to save the profile.

5. You can **Edit** or **Delete** profiles from the **Profiles** tab.
6. To use a profile click to select it, and then click **Apply** (button) and the settings will be transferred to **Connection Manager**.

---

**Figure D - 24**

Network Settings & Profiles
Contacts

1. Access the HSPA Modem Interface from the Start menu (Start > Programs/All Programs > HSPA Modem > HSPA Modem), or by clicking the desktop icon.
2. Click Contacts (button).
3. Click Refresh (button) to download the contacts from the USIM card to the computer.
4. The Contacts will then be displayed.
5. Double-click any contact to edit the information (or right-click and select Edit).
6. You can also Export/Import contacts by clicking the appropriate button.
Windows 7 Information

Messages
1. Access the HSPA Modem Interface from the Start menu (Start > Programs/All Programs > HSPA Modem > HSPA Modem), or by clicking the desktop icon.
2. Click Messages (button).
3. Click Refresh (button) to download the messages from the USIM card to the computer.
4. Click New (button) to create a new message.
5. You can either type the telephone number in the recipient field, or press To (button) to select the contact from the list.

Figure D - 26
Network Settings & Profiles
6. Click to select a contact from the list and then click **Add** (button) and the phone number will automatically be added to the recipient field.

7. Type the message information into the message body and click **Send** (button) to send it, or **Save to draft** (button) to save the message.

8. Select any message to **forward** or **delete** it, or to **reply** to it.
Windows 7 Information

**Settings**

1. Access the **HSPA Modem Interface** from the **Start** menu (*Start > Programs/All Programs > HSPA Modem > HSPA Modem*), or by clicking the desktop icon.
2. Click **Settings** (button).

![Settings](image)

*Figure D - 27 Settings*
3. Click **OK** alongside any of the options to configure the settings.
4. The **Network** can be configured for an **Automatic** (usually from the USIM card) or **Manual** connection.
5. The **Network Mode** can be configured for any appropriate mode required.

![Figure D - 28
Settings - Network/Network Mode](image)

6. You can also change your settings for the Pin #, and input your phone number.
7. Exiting the program DOES NOT turn off the 3.75G/HSPA module, and you will need to press the **Fn + ** key combination to turn off the module (pay careful attention to this aboard aircraft - see “Wireless Device Operation Aboard Aircraft” on page D - 56).
8. If the module is on and the computer enters a power-saving state, then the power status of the module on resuming from the power-saving state will be as below:
   - If the 3.75G/HSPA module is on and the computer is **Shut Down or Restarted**; the module will be **off** when the computer starts up.
   - If the 3.75G/HSPA module is on and the computer enters **Sleep or Hibernate**; the module will be **off** when the computer resumes from sleep.
Windows 7 Information

Mobile Partner
With the 3.75G/HSPA module and USIM card (supplied by your service provider) installed you may then install the Mobile Partner application. The Mobile Partner application allows you to directly access your HSPA internet service from the computer.

Mobile Partner Application Installation
1. Enable power to the module by pressing the Fn + key combination (the on-screen indicator will indicate the module’s power status). If a Found New Hardware window appears, click Cancel in all windows that appear, and then proceed to install the driver as below. Insert the Device Drivers & Utilities + User’s Manual disc into the CD/DVD drive.
2. Click Option Drivers (button).
3. Click 4.3.5 Generation Module > Yes.
4. Choose the language you prefer and click OK.
5. Click Next.
6. Click I Agree (button) to accept the license agreement.
7. Click Next > Install.
8. Click Finish.
9. Access the Mobile Partner application from the Start menu (Start > Programs/All Programs > Mobile Partner), or by double-clicking the Mobile Partner icon on the desktop.

Use the Fn + key combination to toggle power to the 3.75G/HSPA module, and check the indicator to see if the module is powered on or not (see Table 1-6, on page 1-12/Table 1-4, on page 1-8).

Wireless Device Operation Aboard Aircraft
The use of any portable electronic transmission devices aboard aircraft is usually prohibited. Make sure the module(s) are OFF if you are using the computer aboard aircraft.

D - 66 3.75G/HSPA Module (Win 7)
Mobile Partner Application
You will need to contact your service provider to obtain the exact details of how exactly to configure the settings on this page.

Profile Management
1. Power on the 3.75G/HSPA module using the $\text{Fn + key}$ combination.
2. Access the Mobile Partner application from the Start menu (Start > Programs/All Programs > Mobile Partner), or by double-clicking the Mobile Partner icon on the desktop.
3. If you have not created a profile, click Tools and select Options, and then click Profile Management.
4. Click New and input the appropriate information for Profile Name, APN and Authentication etc. as supplied by your service provider.
5. Click Save to save the profile.
Connecting to the Service Provider
1. Power on the 3.75G/HSPA module using the Fn + key combination.
2. Access the Mobile Partner application from the Start menu (Start > Programs/All Programs > Mobile Partner), or by double-clicking the Mobile Partner icon on the desktop.
3. The software will run and you can select the Profile Name from the menu.
4. Click Connect to begin the connection process.

Figure D - 30
Connect

5. The Mobile Partner application will then display the connection information.

Figure D - 31
Network Connection Prompt
6. When the connection is successful you can click the network icon in the taskbar to display the connection information.

7. You can then access the internet, download e-mail etc. as per any internet connection.
8. While you are connected the indicators in the Mobile Partner window will display uploading and downloading icons and a network icon in the taskbar.

Figure D - 32
Connected Taskbar Notification

Figure D - 33
Disconnect
Windows 7 Information

9. To disconnect click the **Disconnect** icon, or right click the taskbar icon, click the connected icon and select **Disconnect**.

10. The program will disconnect from the service provider.
11. The module will still be on, and you will need to press the **Fn + ESC** key combination to turn it off.
12. The module will still be on, and you will need to press the **Fn + [Esc]** key combination to turn it off.

13. If you click the **Mobile Partner** close icon ![close icon] a message will be displayed asking you to click **OK** to confirm the program exit and to **terminate the connection**.

14. Exiting the program terminates the connection, but DOES NOT turn off the 3.75G/HSPA module, and you will need to press the **Fn + [Esc]** key combination to turn off the module (pay careful attention to this aboard aircraft - see “Wireless Device Operation Aboard Aircraft” on page D - 66).

15. If the module is on and the computer enters a power-saving state, then the power status of the module on resuming from the power-saving state will be as below:

   - If the 3.75G/HSPA module is on and the computer is **Shut Down or Restarted**; the module will be **off** when the computer starts up.
   - If the 3.75G/HSPA module is on and the computer enters **Sleep or Hibernate**; the module will be **off** when the computer resumes from sleep.
Windows 7 Information